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USE IN LIFE SUPPORT DEVICES OR SYSTEMS MUST BE EXPRESSLY AUTHORIZED.

STMicroelectronics PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN
LIFE SUPPORT DEVICES OR SYSTEMS WITHOUT THE EXPRESS WRITTEN APPROVAL OF

STMicroelectronics. As used herein:

1. Life support devices or systems are those
which (a) are intended for surgical implant into
the body, or (b) support or sustain life, and whose
failure to perform, when properly used in
accordance with instructions for use provided
with the product, can be reasonably expected to
result in significant injury to the user.

2. A critical component is any component of a life
support device or system whose failure to
perform can reasonably be expected to cause the
failure of the life support device or system, or to
affect its safety or effectiveness.
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Chapter 1 What You Need to Install ST-Realizer I

1 INSTALLING ST-REALIZER I

1.1 What You Need to Install ST-Realizer Il

You must install ST-Realizer Il on a PC that meets the following minimum requirements:

Table 1 Host PC minimum requirements

Minimum requirements

Processor: Intel® Pentium-100 MHz
RAM: 16 Mb

Disk memory: 16 Mb

Monitor: Super-VGA, 17"

Mouse

ST-Realizer Il runs under Microsoft® Windows® 95, 98, 2000 or NT®.

1.2 Installation Procedure
1 Boot your PC under Windows.
2 Put the ST-Realizer CD-ROM in your CD-ROM drive.
The CD-ROM'’s autorun function will open the Setup program automatically.
3 Follow the instructions that appear in the pop-up windows.

The Installation program will ask you to specify the folder into which you wish to install ST-
Realizer. The folder you choose will be the root folder. Either accept the default or enter
a new installation folder.

Installation is now complete.

To launch ST-Realizer, click Start 2Programs »ST-Realizer || >Realizer.

g
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Chapter 2

2 INTRODUCTION AND CONCEPTS

The founding idea behind ST-Realizer was to create an accessible and user-friendly software
package, allowing people at various levels of programming expertise to efficiently design
embedded applications for ST6 and ST7 microcontrollers.

ST-Realizer is an application programming package that allows you to create applications
ready to be loaded into ST6 and ST7 microcontrollers without having any knowledge of
assembler code. To do this, you use symbols that represent programming functions to create
flow diagrams that perform your application functions. While the user is assumed to have a
good understanding of the microcontroller for which he or she wishes to create an application,
care has been taken to create a sufficiently broad spectrum of symbols to cover all of your
application design needs. And should you require a symbol not included in ST-Realizer’s main
library, you can design your own using the Symbol Editor function.

All ST-Realizer applications are destined for one of the ST6 or ST7 family of microcontrollers.
The scope of the application is necessarily limited by the resources available on the target
device—the microcontroller for which the application has been designed.

It is therefore imperative that you fully understand the specifications of the target
microcontroller before you begin to design your application. Datasheets for those ST6 and
ST7 microcontrollers supported by ST-Realizer are supplied on the ST-Realizer CD-ROM. In
addition, datasheets for ST microcontrollers can be easily obtained from the
STMicroelectronics microcontroller web site:

http://mcu.st.com

The remainder of this chapter will describe the basic concepts behind using ST-Realizer, to
help you generate your embedded application programs.

ST-Realizer was developed by ACTUM Solutions expressly for
STMicroelectronics, for use in developing embedded applications for ST6 and
ST7 microcontrollers. In addition to ST-Realizer, ACTUM Solutions provides a
variety of other software products, some of which can be used as a
complement to ST-Realizer to further refine your application. For more
information, please refer to the ACTUM Solutions web site.

d
ﬁCTU/m http://www.actum.com/

g
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ST-Realizer Application Structures

Chapter 2

2.1 ST-Realizer Application Structures

Perhaps the best place to start describing
ST-Realizer is at the final product—the
generated assembler application that ST-
Realizer will produce for you. It is
important to understand how the final
generated code is structured before you
start designing your application, so that
you are aware of how best to optimize
available resources, such as memory.

There are two main parts to each ST-
Realizer assembler application. The first
part is a series of initialization macros
that are embedding automatically and
that make up the Realizer Operating
System (ROS). The ROS sequentially
initializes the microcontroller, it's 1/O’s,
peripherals and memory, in much the
same way that your PC’s BIOS initializes
the PC hardware as soon as you switch
the power on. The second part of the
code is the part that you create using ST-
Realizer—the application program.

The figure at right shows a flow chart of
the overall structure of the generated
assembler code that ST-Realizer
produces.

2.2 Programming using Symbols

ROS

CReset entry point )

Chip Initialization

I/O Initialization

Peripheral
Initialization

Data memory
Initialization

Applicatior<
you create

Keep track of
elapsed time

Read inputs
Calculate data
Write outputs

Updating of
Copies and
State Machines

I

Peripheral IRQs

Interrupt
Subroutines

Main
Loop

With ST-Realizer, you create applications by placing and connecting symbols in a scheme.
Each symbol is, in fact, a graphical representation of an assembler macro, usually including
attributes which you can modify to your specific needs.

The symbols included in the ST-Realizer main library represent a variety of coded entities
such as: mathematical, logical, conversion and power management functions, constants,
tables, subschemes/hierarchical sheets, states, input devices, output devices and sequential,

counted or time-related events.

12/209
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Chapter 2 Inside ST-Realizer Applications

The symbols are made such that you need never write a single line of assembler code to
produce your application—all of the attribute modifications you may need to perform are
accessible through dialog boxes.

2.3 Inside ST-Realizer Applications

An application is built around an ST6 or ST7 microcontroller unit (MCU). The input signal(s)
enter the application from one (or more) of the microcontroller’s pins, ports or peripherals. The
application treats the input signal(s) as you require, and the result is output to one of the
microcontroller’s pins or ports.

The figure below shows a generalized view of an application. The input signal(s) enter the
application via one of the MCU'’s pins, ports or peripherals, and is taken up by the root (or
main) scheme. The root scheme is the core of the application—the main, sequential loop. If
the application requires any interrupts, you must create a subscheme. (Interrupts cannot
occur in the root scheme.) If you simply wish to section off a very complex part of the
application for aesthetic reasons, you may also create subschemes to contain parts of the
main loop. Subschemes are represented in the root scheme by subscheme symbols, of
which more will be said a little later.

Application

Root Scheme

Subscheme
Symbol

Table
Symbol

Subscheme

[]

'»
Output signal
(to MCU pin or
port)

Input signal

(from MCU pin,
port or
peripheral)

Additional inputs from
MCU pins, ports or
peripherals are possible.

g
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Symbols Chapter 2

2.4 Symbols

Using ST-Realizer, you design your application by placing symbols and wiring them together
in schemes.

Each symbol may represent:

« Anoperation, such as converting a physical analog value to a binary value,

« A piece of information related to the behavior of the application, such as a state
transition,

* A system state, or condition,
« An action reflecting a change in the system state or caused by an event such as the
occurrence of a timer interrupt.

Each symbol is associated with an ST6 or ST7 assembler code macro. The wires represent
the flow of data, and are linked to variables and constants. You can modify certain attributes
of symbols and wires, allowing you to customize them for your specific application. For
example, by attaching an attribute of type UINT (unsigned integer) to a wire, you define its
value capacity to that of an unsigned integer (0 to 65536). For more details on attributes see
Appendix A: “Variables and Attributes” on page 167.

2.4.1 State Machine Symbols

Within your root scheme, you may create a state machine, which logically guides the program
between different functional states of your application. Say, for example, you had an
application which performs the following functions:

e Turning a motor on.
» Setting the motor speed.
e Turning the motor off.

In a state machine, you would define a state, using a state symbol, for each functional step
of the application above and, in addition, a state which defines the starting point of the
application—the initial state.

The sequence of state symbols would therefore look like:

Motor OFF (Initial State).

Motor ON.

Setting Speed.

Motor OFF.

The transitions between each of these states are controlled by conditions. Condition

symbols act as switches. When a condition is met, the condition symbol is triggered, and the
program can progress to the next state.

4
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Chapter 2 Schemes

2.5 Schemes

When using ST-Realizer, you design your application in schemes. A scheme is like a plan on
which you place symbols and draw wires. Each application consists of a set of schemes,
including one root scheme and any number of subschemes. Section 6 on page 37 explains
how to build and modify schemes.

2.5.2 The Root Scheme

The root scheme is the starting point of your application program, and corresponds to the
reset vector of the program.

The root scheme is where you create the main loop of your application. All of the large scale,
sequential functions should be kept here. However, if there are any particularly complicated or
cumbersome actions in your main loop, you may wish to put them into a subscheme to save
space in the root scheme and to make the application easier to follow visually.

2.5.3 Subschemes

Applications can include any number of subschemes which contain further symbols and
wires but are displayed in the root scheme as a single symbol.

There are three reasons to create a subscheme:

e To include complex portions of the main loop, thus saving space in the root scheme and
making it easier to reuse processes. In this case, the subscheme is executed as if it were
a part of the main loop (root scheme).

« To include parts of the application that are event-driven. (Events can never be placed in
the root scheme.) Subschemes can be assigned either a single execution condition,
which will apply to the entire subscheme, or alternatively, can include any number of
event symbols. More will be said about execution conditions and events shortly.

« To save functional parts of your application (analogous to subroutines) that you may wish
to reuse in other applications. Subschemes are saved in their own files (. sch files) and
can be easily copied to other ST-Realizer projects and reused. You may also save
customized subschemes symbols to a library, to be accessible by all projects.
(Subscheme symbols are described below).

Designing a subscheme is no different than designing an ordinary scheme, with one
exception: a subscheme has connections to its root scheme via a subscheme symbol. The
subscheme symbols are named sssp_(q, where p indicates the number of inputs you need for
your symbol and q the number of outputs. For example, sss2_1 is a subscheme with two
inputs and one output.

‘y_l 15/209




Events Chapter 2

When you want to use a subscheme, you must therefore first think about its connections: what
inputs does the subscheme need to deliver its output? Once you know this, you can choose
the correct subscheme symbol from the main library. However, subschemes, like the root
scheme, can be modified at any time. Section 6.4 on page 51 describes how to create and
modify subschemes.

2.6 Events

Events are conditional triggers, similar to If..Else statements, that can be applied either to an
entire subscheme, or simply to a sequence of code. Like an If..Else statement, events are
always triggered by an input of some sort. The input may be:

* Aninterrupt, such as a timed or hardware interrupt.
* Aninput value change.

When an event is applied to an entire subscheme, it is called an execution condition—
because it defines the conditions by which the subscheme will be executed.

However, events can also be made to apply to just a sequence of symbols within a
subscheme, using event symbols. These symbols act as switches—if the condition that they
represent is met, the code that follows them can be performed.

There are many types of events, some hardware independent, and others that are hardware
dependent. The full range of events available is detailed in Section 6.4 on page 51.

2.6.4 Execution Conditions

An execution condition can be applied to a subscheme, CReset entry poim)
such that the subscheme is only executed when that |
execution condition is met—such as a timed interrupt,
or upon a subscheme input change. Only one execution
condition can be applied to any given subscheme and ]
when this execution condition is fulfilled, all of the code NE;”;?LESSG
within the subscheme is executed.

Initialization

Subschemes with execution conditions are chiefly used

to contain reasonably complex subroutine functions Execution N

that are conditionally performed in addition to the code Condition

in the main programming loop. A met?

The diagram at right shows a schematic example of Subscheme

how a subscheme with execution conditions is used in Code

an application. | <
Normal Code

Execution

<

4
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Chapter 2 Events

2.6.5 Event Symbols

Event symbols can be included in subschemes to determine when, and which portions of, the
code is executed. Event symbols are always placed in subschemes, because events act as
interrupts, and interrupts may never be placed in the root scheme.

In a certain manner, event symbols act as switches to control when (i.e. under which
conditions) subsequent code is executed.

Event symbols are most usefully used when you wish to include several events that may
control the similar portions of code. However, certain rules apply when placing more than one
event symbol in a single subscheme (refer to Section 6.4.5 on page 55).

The diagram below shows a schematic example of how event symbols can be used to control
how a subscheme is executed.

(Reset entry point)

Initialization Subscheme Code

B —

Normal Code

Ex ion
ecutio Event ]f
event symbols
Event 2/

symbol sequence C

-

______________________

Subscheme
Symbol

Normal Code
Execution

-

In the above example, the subscheme code will be executed as follows:

e If Event 1 is triggered (by the event’s condition being fulfilled):
- Symbol sequence A will be performed with outl = 1.
- Symbol sequence B will be performed with out2 = 0.
- Symbol sequence C will be performed unconditionally—there are no event symbols
connected to this code sequence.
e If Event 2 is triggered:
- Symbol sequence A will be performed with outl = 0.
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How ST-Realizer Keeps Track of Time Chapter 2

- Symbol sequence B will be performed with out2 = 1.
- Symbol sequence C will be performed unconditionally.

e If neither Event 1 nor Event 2 is triggered, no part of the subscheme code will be
performed.

Note: Even though symbol sequence C is not directly connected to a event symbol, by
virtue of it being in a subscheme with that contains events, it will not be
performed unless one of the events is triggered. The golden rule is that you
cannot mix events with root scheme symbols (meaning those symbols that are
performed as part of the main loop or normal code). When you place symbols
in a subscheme which contains one or more events (either in the form of event
symbols or an execution condition), those symbols cannot be considered as
part of the root scheme.

2.7 How ST-Realizer Keeps Track of Time

ST-Realizer Il differs from its predecessors because the final code that it produces will only
contain timer initialization code if there are time-related symbols or events in the application.

However, if your application includes either time-related symbols or events, ST-Realizer will
generate something called a base clock timer tick in the following manner:

« Every ST6 and ST7 microcontroller has a timer, called Timer 1 (ST6) or Timer A (ST7),
which (if there are either time-related symbols or events in the application) is used as the
base clock to measure out units of time called “timer ticks”. You can choose to set the
value of the timer tick—this is described on page 95.

* All time-related symbols and events are based on timer ticks. This means that one timer
tick is the smallest increment of time that can be distinguished.

e Timer ticks may be used to control the processing time of a main loop cycle. The time
required to perform one main loop cycle is called the Processing Cycle Time. By default,
the processing cycle time is variable. However, you can choose to fix the processing cycle
at a specific number of timer ticks—how to do this is described on page 95.

For example, by default the base clock timer tick is set to 0.01 s (10 milliseconds). This means

that every 10 milliseconds the hardware timer (Timer 1 or Timer A) sends an interrupt to the

program which increments a tick variable. Time-related symbols and events use this tick

variable (either directly or indirectly(l)) to evaluate whether their conditions have been
satisfied, and whether their actions should be executed or not.

1 How different types of time-related events use the value of the tick to evaluate their
conditions is detailed in Section 6.4.3 on page 51. Time-related symbols are described in
detail in Section 7.4 on page 80.

4
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Chapter 2 Connecting your Application to the Target Device

The concept of the base clock timer tick is an important one, because it appears every time we
require a time-related symbol or event. In our tutorial example, we demonstrate how to use
both time-related symbols and timed events. We strongly urge you to take the time to
complete the tutorial—it is a very efficient way to get up to speed in ST-Realizer and the time
you spend doing the tutorial will be saved later by having increased your productivity!

2.8 Connecting your Application to the Target Device

All signal inputs to the application are supplied by one or more of the microcontroller’s input
pins, ports or peripheral control registers. Similarly, the application’s final output must also be
sent to an output pin or a port. In general, each ST6 and ST7 microcontroller has a variety of
digital and analog input/output pins, as well as ports for serial or parallel data. The number of
pins and ports, of course, depends on the microcontroller in question.

However, peripheral support can vary largely, depending on the microcontroller to be used.
Any application design, must obviously bear in mind the resources available on the
microcontroller.

To link inputs and outputs between the application and the microcontroller, you must connect
pins, ports or peripheral control registers to input or output symbols in the application’s
schemes.

Note that peripherals must be enabled before they can be used by the application. Once
enabled, each peripheral used must usually be configured to meet the hardware requirements
of your application—hardware setting dialog boxes are designed for this purpose. These
hardware settings are used by the ROS to initialize the microcontroller properly.

2.9 Application Development Steps

Once you have designed your application using ST-Realizer, you analyse and compile it
using ST-Analyser.

ST-Analyser performs the following tasks:

« Analyses your scheme by creating the netlist, creating cross references, analysing and
generating final code. Providing no fatal errors are encountered, ST-Analyser generates a
non-compiled ST6 or ST7 macro-assembler language (. asm) file from the scheme.

* Generates the compiled binary ST6 or ST7 executable file. Depending on whether or not
you included the ROS (see Section 2.3 on page 13 and Section 4.3.4 on page 29), a file
with extension *.hex or *.obj respectively is generated for ST6, or with extension *.s19 or
*.0bj for ST7. A *.hex (or *.s19) file can be directly loaded into an ST MCU while you
must link a *.obj file with another program.

When the analysing process has been successfully completed, a report file is generated. This
report file gives information about the designation of I/O pins, a list of the variables used by
type and the memory space required by the application.

‘y_l 19/209




Application Development Steps

Chapter 2

Once you have compiled your application, you can use ST-Simulator to simulate its behavior,
generate and view input signals, monitor signals that are generated by your application, and
fine-tune it if necessary. You design simulation environments in the same way you design

schemes, except that the design is held in what are called simulation environment files.

To provide you with greater flexibility, you can create or edit your own symbols using ST-
Symbol Editor. You create a symbol by drawing its shape, placing pins that represent the
variables that are input to and output from the process you are defining, then linking it to the

macro it represents.

All the files and definitions that pertain to an application are stored in project files. The

following diagram shows the ST-Realizer application development process.

ST-Sinmulator

Draw the schemes

Conpile the code
and generate the
report

Test and debug

the code

20/209
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microcontroller
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Chapter 3 Project Files

3 CREATING, OPENING AND SAVING PROJECTS

3.1 Project Files

Each application you design is stored in a project. It is recommended that each project have
its own folder. ST-Realizer stores all schemes and subschemes associated with the
application in the project folder.

Once your have created and specified your project folder, ST-Realizer will create a
project.rpf file, that contains project-specific path settings, the project's scheme names,
target hardware information and compiler settings. The project.rpf file is in ASCII text format.

3.2 Creating a New Project
To create a new project:
1 Click Project=>New in the cascading menu.

The Create a New File dialog box opens. If you haven’t done so already, you may create
a new folder for your project by clicking on the new folder icon shown.

Create a new file

Save jr; IEHEGUHQ ﬂ | ﬁl i E|
/ \

\/ Click here to create
a new folder.

Click here to move up |
one folder level.

/

File name: |heatind Save

Type the name of your
new project here.

Save as ype: I Praject files [=1pf] j Cancel

2 Browse to the folder that you'll create your project in, and specify the name of the
project file. An . r pf extension will be applied automatically. Click Save.

4
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3.3 Opening an Existing Project

Note: Only one project may be open at a time.

To open a project:
1 Click Project=>Open. (Files with the . r pf extension are displayed automatically.)

or, ~u
Click File=Open or L=~ . (You must specify the . r pf extension).

The Open a File dialog box opens:

Open a file

Look, in: I {3 Heating

hieating. rpf

File name: I Open
Files of tppe: IF'ru:uieu:t files [*.1pf) j Cancel

2 Browseto the folder containing your project file, and either select it or type its name
(. rpf extension) in the File name field.

3 Click Open.

3.4 Opening Earlier Realizer Version Projects

The Open a file dialog box shown above can be used to open .ini project files from earlier
versions of ST-Realizer. Both.ini projects and .rpf projects are fully compatible.

When opening projects from earlier versions, be aware that these projects still use the target
hardware from these earlier versions. Simply reselect the target hardware (see Chapter 4 on
page 25) once you have opened the earlier version project.

4
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3.5 Closing a Project
To close a project:

Click File=>Close or Project>Close.

3.6 Saving Projects

Once you have defined your project, you should save it so that all of the configuration
information you have updated is kept as a part of the .rpf file.

e If you try to close a modified project, you will be prompted to save it.
e Otherwise, to save a project, under the File menu, select Save.

e If you wish to save your project to another filename (for example, create a back-up copy of
the project), under the File menu, select Save As, and type the name of the file that you
wish to save the project to.

o Tip: If you save your project to a different folder, all of the schemes and subschemes
— — associated with the project will also be saved to the new folder.

o
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4 SPECIFYING THE TARGET HARDWARE DEVICE

4.1 ST6 or ST7 Devices

Once you have created a new project, the next step is to define the ST6 or ST7 device type
that the application will be loaded into. This will attach the hardware configuration of the ST6
or ST7 device (such as pinout and memory capacity) to the scheme that will describe your
application.

This hardware data assures that the application is tailored to the target ST6 or ST7 device.

Note for ST6 users:

ST-Realizer does not support any RAM or ROM paging, except for static pages. Because of
this, the ROM size is limited to 4 kilobytes and the RAM size to 128 bytes.

The Max. ROM and Max. RAM values determine the maximum size of the ST-Realizer
application.

The 1/O pins determine the number of input and output symbols that can be used in the ST-
Realizer application.

The EEPROM values determine how much EEPROM can be used by the symbols from the
MAINPER.LIB symbol library. This symbol library contains symbols that use the EEPROM
space to store their values.

4
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4.2 Choosing a Target Microcontroller

4.2.1 Selecting the Target Microcontroller for a New Project

When you create a new project, just after creating your project.rpf file, you will be prompted to
specify the target hardware for your project.

1 Click the Target Hardware folder in the Select Target Hardware window. A
browsable list of target hardware devices will appear in the window shown below.

[ Select target hardware |

Current; ST72212G2 Two 16-Bit Timerz, 8K ROk, 256 Eutes Rk

E Z5 Target hardware devices
-1 5T 8-BitMCU
=53 5T7 8-Bit MCU
B2 STF2104 168t Timer, 5P

El B STF"221H &/0 Converter, SPI

F-C0 5T7212% Twa 16-Bit Timers, SPI, 501

STY2212G2 Two 16-Bit Timers
\m} ST72213G1 16-Bit Timer, 4k ROK, 256 Bytes Rak

k. ROM, 256 Bytes HAM

l F-C0 5T72252 A/D Converter, Two 16-Bit Timers, 5P, 120
F-C0 5T723 = A/D Converter, Two 16-Bit Timers, 5P, SCI
F-C0 5T7233 A/D Corverter, Two 16-Bit Timers, SPI, 5C1, EEPROM

(] I Cancel

2 Find the target ST microcontroller by clicking the device icons in the list until the

name of the chosen device is displayed. Select the target device by clicking once on

it.
Click OK to confirm.
You may also double-click the line showing the device.

Once you have selected your
target hardware, the Project
Viewer will open, similar to

_ | heating. zch

that shown at right: &3 Libraries

El 53 Target hardware
Lot STT2212G2 Two 16-Bit Timers, 8K ROM, 256 Bytes Rakd
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4.2.2 Changing the Target Microcontroller

Once you have specified a target hardware device for a project, the configuration and a
connection® information for that device is stored in the .rpf file for the project. If you change
the target hardware device of a previously existing project, the new target hardware device
information is also added to the .rpf, without losing the previously specified device information.

To change the target hardware device for an existing project, follow these steps:

1 Open the Project whose target microcontroller you

wish to modify.

2 Click Hardware Select...

Project Viewer.

3 The Select target hardware dialog box will open,
showing the target hardware device previously
target

selected. Simply browse to the new
hardware device desired. Click once to select it.

[ Select target hardware

Current: STY2212G2 Two 16-Bit Timers, 8K ROM, 256 Bytes RaM

on the Project menu, or
double-click the target hardware device in the

Tools Wit

FEroject

Options
ey,

Open...

Close

Hardware select...

Hardware settings...

Analyse F11
Erint

= 25 Target hardware devices

D STE 8-Bit MCU

=55 5T7 8-Bit MCU
D ST7210. 16-Bit Timer, SPI
. -0 5T7212% Two 16-Bit Timers, SPI, 5CI
E| S ST7221% &/D Conwerter, SPI
: '\,ﬁ‘ STV2212G2 Twa 1E6-Bit Timers, BK. ROM, 256 Bytes
: '\*ﬁ STV2213G1 16-Bit Timer, 4K HUM 256 Bytes RAM
- 577225 A/D Converter, Two 16-Bit Timers, SPI, 125
-0 577231 A/D Converter, Twa 16-Bit Timers, SPI, 5CI
-] 577233 A/D Converter, Two 16-Bit Timers, SPI, SCI, EEPROM

R

[ o ]

Cancel

4 Click OK to confirm.

You may also double-click the line showing the microcontroller. Note that the name of the
current microcontroller is displayed on top of the dialog box.

1. Ifyou add a new target hardware device to a pre-existing project, you may have to update the
hardware connections by reconnecting I/O symbols to the appropriate hardware ports and
peripherals. For more information, refer to “Connecting Input/Output Symbols to

Microcontroller Pins, Ports and Peripherals” on page 46.

4
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4.3 Hardware Configuration

4.3.3 Accessing Hardware Settings Dialog Boxes

Follow these steps:

1 Click Hardware Settings. on the Project menu.
The Hardware Settings dialog box for the specified target microcontroller opens.

This dialog box shows a number of tabs that direct you to the following hardware
configuration daughter dialog boxes:

* General tab, for

configuring general hardware options.

* Memory tab, for setting hardware memory options.

A tab corresponding to each of the target microcontroller's on-chip peripherals,
allowing peripheral settings to be customized. For example, the ST72212G2
microcontroller hardware settings dialog box, shown below, has four peripheral setting
tabs corresponding to each of its four on-chip peripherals: Timer A, Timer B, SPI and

Ports.

W 5T7221262 Hardware settings |

Frequency [Hz]

Include files

WV Usze the watchdog
W Generate a complete Realizer Operating System [ROS)

Azzembler optionz |.|i

I 16000000 [T Slow mode enable

|E:"~F'rn:|gram FileshS T-Realizerlibhst?221 2inc:C:\Progr = |

] Cancel

2 Click the appropriate tab.

Note:

28/209

There are two circumstances in which you may want to modify the settings in
these windows: (a) when you build a new scheme, and (b) when you want to re-
compile an existing scheme in order to customize how the program will operate
when loaded into the microcontroller. In the first case you specify new settings,
(or keep default settings); in the second case, you modify existing settings.
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4.3.4 General Hardware Configuration

This is the first tab in the dialog box.

Note: Option bytes are not supported.

From the General tab, you can specify:

1 The oscillator frequency of the microcontroller.

Note: This frequency is the external frequency. The ST7 uses a internal frequency
which is half the external frequency (Fj, = Fgx/2).

2 Whether or not the Watchdog function is enabled.

The Watchdog function is a peripheral included on each ST6 and ST7 microcontroller.
Enabling the Watchdog initializes it and instructs ST-Realizer to refresh the Watchdog
regularly. For more information on the Watchdog function, please refer to your
microcontroller’'s datasheet.

3 Whether or not you want the ROS to be disabled.

The Realizer Operating System (ROS) is made up of macros or pieces of code that
perform background tasks that must be added to an ST-Realizer application for it to be
complete and ready to load into an ST device. In a certain sense, the ROS is similar the
BIOS of your PC—ROS macros encompass such operations as chip initialization, 1/0
initialization, timer initialization and data memory initialization, that are essential to the
running of your application.

Note: Refer to Chapter 2, “Introduction and Concepts” on page 11, for an overview of
the running of an ST-Realizer program.

Alternatively, you can disable the inclusion of the standard ROS macros, and generate
your own code to perform the ROS tasks instead. The tasks which you must provide
macros for are described below.

To disable the ROS:

* Click the Complete ROS check box. ROS is disabled when the check box is
empty (unchecked).

* Click OK.

If you disable the ROS, you must use an external program to perform the following
functions:

» Call the following subroutines that are created by ST-Realizer:
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PortiInit, which initializes the I/O ports according to the ST-Realizer application.
Ramlnit, which initializes the RAM allocated by the ST-Realizer application.
Reallnit, which initializes the ST-Realizer application.

RealMain, which executes the ST-Realizer application.

The Portlnit, RamInit and Reallnit must be executed once and the RealMain
subroutine must be executed continuously.

Perform all the interrupt management.

Fill in the input variables that are used by ST-Realizer application and copy the output
variables of the ST-Realizer application to the data registers of the 1/0O ports.

The input variables are:

Apxd

where x is the port name A, B or C, and d is the pin number 0. . 7. This is a set of
variables generated as the result of the A/D conversion. These variables are already
allocated with the size of one byte.

RTI CK

This is the one-byte timer tick variable. This must be filled with the number of ticks
during the last execution of the RealMain subroutine.

The output variables are of the form:

BUDRX

where x is the port name A, B or C and each variable is one byte in length. Their
contents must be copied to the data registers of the appropriate port.

4 Include files for user-defined macros.

If the scheme you are analysing and compiling includes a symbol that you created
yourself, you must include the macro or macros linked to the symbol before analysing the
scheme. For details on how to create your own symbols see “Creating Your Own Symbol”
on page 129.

To

include the macros linked to user-defined symbols:

In the Include files field, enter the name and full path to the macro files linked to your
symbols. To include more than one macro file, separate each path and file name with
a semi-colon (;).

Click OK.

5 Assembler options.

Normally, you will not need to alter the default assembler options.
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4.3.5 Memory Configuration

The second Hardware Settings dialog box tab is entitled Memory. In this tab, shown below,
you can configure the target microcontroller’'s memory configuration options, such as:

e The start and end of ROM (corresponding to the beginning of your application code).
e The start and end of RAM (corresponding to the beginning of your application variables).

e The start and end of EEPROM (if this memory type is included in your target
microcontroller).

To set or update one

of these parameters: |
1 Type anew General T tdemony T Tirmer & T Tirmer B T SPI T Partz ]

value or

overtype its RaM ROM

current value. Begin [ 0x0081 [Gx0173
2 Click OK. End [ 00173 [ CFFOF

To reset the values
to standard device
settings, click Reset.

Rezet (] Cancel

Notes: 1. The default values found in these fields do not correspond to those reported
in the microcontroller’'s datasheet because ST-Realizer reserves a portion of the
available RAM memory for its own use. For example, for ST7 devices, ST-
Realizer uses 12 bytes of RAM memory.

2. If the values in these fields are changed, there will be an impact on the
application’s variables and on the generation of the code.
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4.3.6 Enabling Peripherals

Each peripheral belonging to the target microcontroller has an associated tab in the Hardware
settings window. If you wish to use one or more of the peripherals in your application, you
must enable the peripheral, which allows it to be initialized and configured. To do this:

1 Click the appropriate tab to open the dialog box that describes the peripheral to be
configured.

The peripherals available vary depending on the target microcontroller device.
2 Check the Enable box at the top of the peripheral’s dialog box.

The peripheral is now enabled and may be configured (using the rest of the options in the
dialog box) as you wish.

For details on the peripherals available, and their configuration options, refer to the
Microcontroller data book. See also Chapter 7, “The Main Symbol Library” on page 67.

4
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5 CREATING, OPENING, SAVING SCHEMES

5.1 Schemes

Once you have created or opened the project on which you want to work, you must create or
open a scheme. A scheme is the sheet on which you design your application. When you have
finished working on a scheme, remember to save your work.

You can export schemes in the Windows metafile ((WMF) format, so that you can import them
into drawing or word processing packages.

This section describes how to create a new scheme, open an existing scheme, and save your
work.

5.2 Creating a New Scheme

When you create a new project, an empty root scheme is created by default, taking the same
name as the project. For example, if you created a new project called “Heating.rpf”, the root
scheme called heating.sch will be created by default.

:Tﬂ Project: heating

Lofre] heating. sch

25 Libraries -
El 5 Target hardware A default root scheme is

Ll §TT221262 automatically created by  |gap4
ST-Realizer for each new
project.

L Tip: If you wish to change the root scheme, right-click on the scheme in the
— — schematics folder, and select Change root schematic. You will then
be prompted to select (by browsing) the new scheme which will
become the new root scheme for the project.

oW

5.2.1 Opening the Root Scheme

The root (or “main”) scheme is the sheet on which you design the main part of your
application and is created by ST-Realizer when you create a new project.

To open the root scheme:

 In the Project Viewer (shown above), double-click the root scheme (for example,
heat i ng. sch, as shown above) located under the Schematics folder.
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A new blank worksheet opens where you can draw the root scheme of the application:

¥ 5T Realizer (Beta] - heating \ [ =] x|
FEile Edit Search Yiew Project Options Tools ‘window Help

L bl e L L e f 8 O Tt e QA Q] e

[ C:\Program Files\ST-Realizer\Examples\Heating\heating sch (Root)

1| i 37

(13200000 [5TB285C 4K ROM. 128 bytes Rt

5.2.2 Creating Subschemes and other Schemes

1 Click E

You may also click the File 2New >Scheme.
The Create a New File dialog box opens.

2 Browse to your project folder and specify the name of the scheme file (. sch
extension).

3 Click Save.
A new, blank scheme opens.

|, Tip: A new subscheme will not appear under the Schematics list in the Project
(o )= Viewer until it has been connected to the project and the project has been
Analysed. To connect a subscheme to a project, there must be a symbol in
somewhere in the root scheme or in another subscheme which is connected to
the new subscheme (refer to “Connecting a subscheme to a symbol in the root
scheme” on page 58). If the new scheme is not a subscheme, it can only be
connected to the project if it is declared as the root scheme.

Rl
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5.3 Opening a Scheme

1 Click L&

You may also click File=>Open.

The Open a File dialog box opens.
2 Enter the path of your project, and specify the scheme name (. sch extension).
3 Click Open.

|, Tip: To open a scheme you've used recently, click its name at the bottom of the File
— — menu.

Qi

5.4 Saving Schemes

To save the scheme that is currently active, click u .

To save all the schemes that are open, click Save all in the File menu.
To save a scheme under a new name,:
1 Click Save as in the File menu.

2 Specify the new name of the scheme file (. sch extension).

3 Click Save.

Note: You can also set up ST-Realizer to save your work automatically at a specified
interval. See “Automatically Saving Your Work and Setting Screen Preference.”
on page 158 for further details.

o Tip: Subschemes will not be appear in the Project Viewer until you have performed

— — an Analyse of the project. A saved .sch scheme file will be placed in the root
directory of the project, but you will have to open it manually if does not appear
in the Project Viewer.

o
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6 BUILDING SCHEMES

6.1 Schemes and their Components

A scheme is a collection of symbols connected to one another via lines named “wires”. Each
symbol has input and output pins that allow them to be wired to other symbols. The symbols,
pins and wires in a scheme can be assigned attributes to precisely define their configuration
and behavior.

Schemes are at the heart of ST-Realizer. By designing schemes, you are in fact creating your
application code.

In each application you create, you must have aroot (or “main”) scheme. This is the scheme
which contains the main body of your application—the core of the program which controls the
sequential running of the application.

In addition to the root scheme, most applications also include subschemes that represent
specific processing in your application. Subschemes usually contain those actions which must
be performed in addition (and sometimes conditionally) to the actions in the root scheme. In
particular, subschemes may be connected to events, such as timer interrupts, periodic events,
hardware (external) input changes and peripheral operation. Subschemes can also be used to
mask more complex operations, so that they do not “clutter” the root scheme.

6.2 Symbols

Symbols are the basic building blocks used to create an application with ST-Realizer. In
essence, each symbol is a graphical representation of a portion of assembler code, usually
representing a function or a short subroutine. Symbols can represent many coded entities
such as: mathematical, logical, conversion and power management functions, constants,
tables, subschemes/hierarchical sheets, states, input devices, output devices and sequential,
counted or time-related events. The main symbol library in ST-Realizer (see Chapter 7 on
page 67) encompasses all of the main functions required in assembler code, and should you
need a very specialized symbol for your application, there is a symbol editor function that
allows you to modify an existing symbol, or create an entirely new symbol, and save it to the
library.

Most symbols in ST-Realizer's main library have attributes which you must specify. These
attributes allow you to specify many parameters, such as:

» Giving the symbol an application-specific name in order to identify it elsewhere in the
scheme.

« Assigning the input or output data type.

« Specifying a time period in a time-related symbol.

4
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The above list is by no means exhaustive. The modifiable attributes depend on the type of
symbol. In Chapter 7 on page 67, you will find a complete list of all of the symbols in the ST-
Realizer main library, complete with the modifiable attribute values available for each one.

Earlier, we mentioned that each symbol is in fact a graphical representation of a portion of
assembler code called a macro. Later, in Chapter 10 on page 129, we will take a closer look
at customizing symbols using the Symbol Editor, and at the assembler macros that define
each symbol.

The remainder of this chapter will concentrate on how to manipulate symbols and their
attributes, and how to wire together symbols to create an application scheme.

Note: With ST-Realizer, object naming is case-sensitive. In addition, spaces are
interpreted as characters. Ensure that all object names are used consistently,
otherwise, errors will result when you compile the application.

6.2.1 Placing and Controlling Symbols

Placing a symbol in Symbols can be placed in a scheme in two

. b air. lib [=]
the SCheme WayS' [ Input and output =
1 Insert a new symbol (one that does not 5l Sequential
. ) [# Logic

already exist in the open scheme) by = Time related

choosing it from the main library: & Mathematical

. . [+l Counter

I CIICk r’ﬂ . [+ Conversion

Table
Power management

The main.lib (and mainper.lib if it [ Constant

exists for the target microcontroller) #State machine

dialog box(es) open. The symbols | ferarchicalsheet 7
are, by default, ordered by functional

category (Hierarchical View).
However, you can view the library of symbols alphabetically by
right-clicking in the library dialog box and selecting Alphabetical
View.

You may also open any library via the File-*Open menu
sequence, by specifying the appropriate <fil enane>. i b file.
ST-Realizer has with a number of symbol libraries in the
<root _folder>\Lib directory, including a some that are
microcontroller-specific.

-

4
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s Tip:

o\

o

Selecting a Symbol,
Wire or Group of

Objects

(572

The most commonly-used symbols are grouped in two libraries:

main.lib, for symbols that use values to be stored in RAM, and mainper.lib, for
symbols that use values to be stored in permanent, non-volatile storage.
When you build a scheme, you use a set of symbols that are copied from these
libraries. The list of the symbols actually selected constitutes the local library
attached to the scheme.

Note that when you copy a scheme, you also copy the attached local library.

ii Double-click the name of the symbol you wish to place or select
the symbol by clicking once on it, right-click the mouse without
moving it from the library dialog box, and select Place

iii A square box will appear next to the cursor, indicating the size
and position of the symbol you have chosen. Move the cursor to
where you want to place the symbol, then click once.

2 Make a copy of a symbol that already exists in the open scheme
(symbol from the local library):

ﬂ heating. zch

i Click =iF . T Y |

E addz ............................ Hd Flace |
A dialog box (having the name of the | Coriion Info|
open scheme in the title) opens. It |constw Delete
contains a list of all the symbols used | o" [pefe|
in that scheme. :rwf Refresh

ii  Select the symbol you want to place. r'nn:n
Click Place. ggﬂ
You may also double-click the name  |autputiatch
in the list. sss1_1

state

i Drag and drop the ghost box |statein |
associated with the symbol down to  1&atnt

the new location of the symbol.

You can obtain information about the symbol by clicking Info, prior to
placing it.

The local library attached to a scheme can be saved for further use. For
example, to enrich the set of symbols available for another scheme.

To do this, click the Save as option in the File menu, and specify a .lib file type,
keeping the original name of the scheme.

As with any drawing package, before you can modify an object or a
group of objects you must first select them.

To select items, you must be in selection mode (the cursor is in the form
of an arrow). This is the default mode. However, if you need to activate
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selection mode:

* Click % .

An object is selected when it is outlined by a red box. You may select
one or more objects as follows:
» Select one object by clicking it.
Take care not to click a symbol attribute as this will open the dialog
box for the attribute.

» Select a group of objects by dragging a box around them.
Put the cursor at one corner of the area you wish to select. Keeping
the left mouse button pressed, move the cursor diagonally across
the area you want to select until the whole area is outlined by a red
box.

When you release the mouse, you will see that each individual
object found in the area you outlined has been selected.

e Select multiple objects by pressing SHIFT while
simultaneously clicking each object one by one.
Each item you select is surrounded by a red box, indicating that it
is selected.

* To select all segments of a connected wire, double-click one
segment of the wire.

Copying a Symbol  You can copy a symbol in two ways:..

1 Right-click the symbol to be copied. A popup
menu will open. Select Copy shape.

Botate k
birrar

Drag and drop the ghost box of the symbol Loy slvape
where you want to place it. You will be Attributes.
prompted to specify new attribute values for e
the symbol. Edit
N/ Tip: The choices shown on the popup menu can vary depending on the type of
— — symbol. For example, for Constant type symbols, a Value option is also
L displayed, or for symbols connected to microcontroller output pins, such as
) digout, a Connect option will be shown.
2 Select the symbol to be copied.
Click " nf |-
i
Drag and drop the ghost box of the symbol where you want to place
it. Note that attribute values are also copied.
To copy a symbol to the clipboard, click .
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Copying a Group of
Symbols

Pasting an Object
from the Clipboard

Moving a Symbol or
Group of Objects

Deleting a Symbol
or Group of
Symbols

Changing a
Symbol’s Attributes

4

You may copy either a group of symbols or a scheme (portion or
entirety). Note that you will also copy all other objects in the group, such
as wires.

1 Select the group of symbols to be copied.

2 Click ] in the toolbar.
it

3 Place the ghost box where you wish to place the copied objects.
To copy a group of symbols to the clipboard, select

the group then click with the right mouse button. EDII'J{
. . Duplizate
The pop-up menu shown at right will appear. Select
C Botate
opy. )
To copy the selection to the scheme page choose e
Duplicate.

Click , then drag and drop the ghost box down to the new
location of

the symbol.

To move a symbol or a group of objects:
» Select the symbol or group of objects.

e Place the cursor on the selected group and drag and drop the
ghost box with the four-headed arrow pointer to the new
location of the symbol.

Note that the wire connections attached to a symbol are moved with the
symbol.

Select the symbol or the group of symbols. Click ﬁ or press the
Del key.

Note that you delete also all other objects in the group, such as wires.
To delete a symbol and place it in the clipboard, select the symbol and

click .
4

Symbols can have a variety of attributes that

depend on the symbol type. When you place a B'_:'tate '
symbol on a scheme from the symbol library, you Mirrar
are prompted to specify these attributes. Copy shape
However, they can be changed at any point. Aftributes. .
To do this: Cannect...

* Right-click the symbol. Edit...

A popup menu opens.
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«Click Attributes.
I ——— | The Select an Attribute dialog
box opens.
LHDE =limf || | sDouble click the line of the
WalueT op=255 .
W alusE attor=l attribute you want to change.
An Edit the Value dialog box
opens.
B Edit the value
HakE
IM_I,lname
k. Cancel ' I Cancel |
The field label in this dialog box (NAME, in the example) depends on
the value to be changed for the specified attribute.
* Enter the new value, then click OK.
N Tip: To change the value of the Constant symbols r?D - or 70 [, you
— — may also click the Value entry in the popup menu that is specific to this type of
L symbol. The same Edit the value dialog box opens.
Changing the You may also change the manner in which an 5
Symbol Attribute  attribute is displayed on a symbol: Botate
Preference Settings  « Right-click the attribute field in the Tag..
symbol of interest. Yalue..
A popup menu opens. Paint of Effect
Eropeties. .

» Select Properties...

4
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Mirroring a Symbol
or Group of
Symbols

Rotating a Symbol
or Group of
Symbols

(572

The following dialog box opens:

B Change properties E |

Colar B e Tag

Size I 2.0 m.m. IEDmment "I

Alignment Walue

Harizontal I Left = I Pump5peedCantral =

Wertical Center _
I i ? r

Direction I Mamal = I

Yizibility

[ Tag W “alue

e Change the preference settings to the desired values.
Select the appropriate Alignment and Direction settings in the
corresponding drop-down lists.
To change the color of the text, click Edit and select the new color
from the displayed palette.
To have tag name and value displayed on the scheme check the
appropriate box.

* Click OK to confirm the changes you have made in the
preference settings.

Select the symbol(s), then click

THE -

You may also use the Mirror option in the popup menu associated with
the symbol (right-click the symbol).

To mirror a group of symbols, select the group then

Euml'f t click with the right mouse button.

Lphcate . .

- A po menu displays. Choose Mirror.
Rotate  » popup play

Mirrar

Select the symbol(s) you wish to rotate, then click (:) .

The selected symbol will be rotated by 90° counterclockwise.
You may also use the Rotate option in the popup menu associated with
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Viewing Symbol
Information

the symbol (clicking the symbol with the right mouse button).

To rotate a group of symbols, select the group then
Lopy click with the right mouse button.

Duplic ate A popup menu displays. Choose Rotate.
Botate  »

Mirrar

Select the symbol about which you want to view information.

Click i

An information box opens.
When you have finished viewing the symbol information, click OK.

6.2.2 Wiring Symbols Together and Connecting Application Inputs/Outputs

Almost all symbols have at least one input and one output pin to which you connect wires (the
only exceptions are some subscheme symbols). Wiring two symbols together creates the data
flow between them. By default, the input pin(s) are to the left of the symbol and the output

pin(s) to the right.

This section describes how to wire symbols together, control the attributes of wires and how to
connect external application inputs and outputs to the appropriate target microcontroller ports

or peripherals.

Drawing Wires
between Symbols

o

44/209

To wire two symbols together:

» Select wiring mode by clicking
The cursor changes to a crosshair, indicating that it is in wiring
mode.
* Place the cursor on the pin of the first symbol, where you want
the wire to start.
The crosshair snaps onto the pin when it comes into snapping
distance. An x indicates the point to which the crosshair is snapped.
e Click when the crosshair is snapped to the pin of the first
symbol, where you wish the wire to start.
ST-Realizer will now draw a wire that follows the cursor.

If you want to define your own wire corners, click twice where you want each
corner to be.

* Move the cursor to the pin of the second symbol, where you
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Symbols

Using Automatic
Wiring:

Copying a Wire

Pasting a Wire from
the Clipboard

Moving a Wire

Deleting a Wire

Mirroring a Wire

(572

wish the wire to end.

* Click when the crosshair is snapped onto the appropriate
point.
The two places where you clicked are now connected by a wire.
* Right-click the mouse or press the ESC key or click % ‘ to
finish wiring.
The two symbols are now connected by a wire.

You may also let ST-Realizer draw wires for you.
Automatic wiring simplifies the task of wiring symbols together by:

- Automatically choosing the shortest path between the two symbols
to be connected (Auto wiring), and creating corners where required.

- Automatically rerouting wires when a symbol is moved (Auto
rerouting).

Both these options are enabled by default.
For details see “Wire Drawing Options” on page 165

Select the wire to be copied.

Click 5 ‘

Drag and drop the ghost box of the wire where you want to place it.
Note that attribute values are also copied.

To copy a wire to the clipboard, click .

Click , then drag and drop the ghost box down to the new
location of the wire.

Select the wire, click once on it, and drag and drop the ghost box with
the four-headed arrow pointer down to the new location of the wire.

Select the wire or the group of wires. Click ﬁ or press the Del key.

Note that you delete also all other objects in the group, such as
symbols.

To delete a wire and place it in the clipboard, select the symbol and

click = % .

Select the wire, then click I}{F .
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Rotating a Wire

Changing a Wire’s
Attributes

Connecting Input/
Output Symbols to
Microcontroller
Pins, Ports and
Peripherals

Note:
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Select the wire, then click O )

The selected wire is rotated by 90° counterclockwise.

Click the wire with the right mouse button.

Type..
A popup menu opens: e
Click the name of the attribute you want to change. Lag'el
An Edit the Value dialog box opens: I

Enter the new value, then click
= Edit the value OK.

LABEL
|Mj,llal:ueI

k. I Cancel

Application input and output symbols must be connected to the ST6 or
ST7 microcontroller input and output pins, ports or peripheral control
registers in order for the application to function.

Application Input and Output symbols are:

adc: A digin:
N =
ame D name
[Type | comment
digout: input:
— Iil name UBYTE
comment

camment

inputlatch: Name output:
_ILEJTBYTE . comment
Comment

outputlatch: Mame event
event__nameé

Comment

comment
eventenable

E NAMEZ)
Comment

4
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To connect these symbols to a target
microcontroller port or peripheral:
* Right-click or double-click the I1/0
symbol.
This popup menu opens: Adtributes.
* Click Connect.
The 1/0 Hardware Connections window for
the target microcontroller opens. The
resources available in this window vary
depending on the target microcontroller.

» Select the appropriate device pin.

i ST72212G2 1/0 Hardware connections |

Connect resource to UBYTE Setpoint r

Botate J
birrar
Copy shape

Caonnect...

Edit...

Axailable rezources; Connected rezources;

P, Input

FE. Input

PLC. Input

PC.0, 8 bit analog input

PC.1. 8 bit analog input

PC.2, 8 bit analog input ¥ |
PC.3. 8 bit analog input

PC.4, 8 bit analog input
PC.5, 8 bit analog input

Properties (] Cancel |

* Click the right arrow or double click the selected device pin
name. Click OK.

|, Tips: To have connections for the device sorted in pin order, check the Sort by

— resource box.
If the peripheral register or bit that you wish to connect does not appear in the
list at the left side of the window, click on the Properties button. This will open
the Hardware settings dialog box, and allow you to enable the peripheral that
you desire to use. When you return to the Hardware connections dialog box,
the registers or bits of the peripheral you just enabled should now be included
in the list.

o\
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6.3 Working in Schemes

This section describes general functions and utilities available when you are working in a
scheme, such as:

* How to use the viewing options.

* Viewing hidden attributes.

e How to print schemes.

 How to add a title or comment to a scheme.

Using the Zoom-In  Click , then click the blank area in the scheme worksheet.
View
You may also click the Zoom in entry in the View cascading menu you
obtain by clicking the blank area in the scheme worksheet.

Note: Zooming in magnifies the view by 200%.

Zooming in on a Click ‘ then select the area of the scheme you want to zoom in on.
Selected Area

Using the Zoom- Click , then click the blank area in the scheme worksheet.
Out

You may also click the Zoom out entry in the View cascading menu
you obtain by clicking the blank area in the scheme worksheet.

Note: Zooming out reduces the magnification by 50%.

Using the Full Click .

Screen View

You may also click the Full view entry in the View cascading menu you
obtain by right-clicking any blank area in the scheme worksheet.

Redefining the View Click || then click where you want the new centre to be on the
Center of your scheme.
Scheme

You may also click the Pan entry in the View cascading menu you
obtain by clicking the blank area in the scheme worksheet.

4
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Printing the
Currently Active
Scheme

o

Printing all Project

Schemes

Viewing Hidden
Attributes

4

Click the File-Print sequence in the main menu bar. Continue the
normal printing dialog and click OK when ready.

e Set Up the Printer
On the File menu, click Printer setup.

The standard Windows Print Setup dialog box opens. Refer to your
Windows documentation for further information.

Click OK when you have finished setting up your printer.
* Choose a Printer Font

On the File menu, click Printer setup, next click Properties and the
Font tab.

For best results, use the True-Type fonts that come standard with the your
Windows environment.

Click Project and select Printin the
drop-down menu:

[Mpll=l=@ Cptions  Tools Wi

Continue the normal printing dialog New..
and click OK when ready. Open...
Close

Hardware select...
Hardware settings...

Analyse F11

When the shapes and pins that make up a symbol are created,
attributes can be assigned to them to define additional characteristics.
These attributes are

not visible by default New b |

when you design an :

application, since they b Zoom in

only refer to parts of Leave Zoom out

the symbol itself. ST- _Cunnec:t Eull wiew
Realizer enables you = RBefresh view

to view hidden Propetties...

attributes: Pan

Click the Invisible Irvisible attributes

attributes entry in the
View cascading menu
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you obtain by clicking the blank area in the scheme worksheet.

When the Invisible attributes option is selected, all attributes are
visible.

Placing aTitleinthe 1 Right-click any blank area in the scheme.
Scheme A popup menu appears.
2 Select the New/Attribute options.
The Create attribute dialog box opens.

[ Create attribute E3 |

Cilor - Editl Tag
Size m .. T =

Aligrment Yalue
Harizantal I Center j LI
Yertical I Center ™ I

Diirection I Mamal = I

Visibilty & _>|_I
¥ Tag v Walue
Cancel |

3 Specify the following options:
e TAG =TXT
* Enter the title text in the Value edit box.

* Under Visibility, there are two options. If you wish only the title
textthat you typed to appear, select Value only. If you wish the
attribute tag to appear as well (in this case “TXT =title text”),
select both Tag and Value.

4 You may specify color, size or alignment values for the title.

5 Place the heading by dragging it where you want and click OK.

4
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6.4 Subschemes, Execution Conditions and Events

Subschemes are exactly what their name implies—additional schemes that are subservient to
the root scheme. Their appearance is similar to the root scheme, in that they also contain
symbols and wires. However, subschemes exist apart from the root scheme, and are only
executed when called upon via a subscheme symbol in the root scheme.

As previously discussed, there are three reasons to create a subscheme:

e To include complex portions of the main loop, thus saving space in the root scheme and
making it easier to reuse processes. In this case, the subscheme is executed as if it were
a part of the main loop.

e To include parts of the application that are event-driven. (Events can never be placed in
the root scheme.) Subschemes can be assigned either a single execution condition,
which will apply to the entire subscheme, or alternatively, can include any number of event
symbols. More will be said about execution conditions and events shortly.

e To save functional parts of your application (analogous to subroutines) that you may wish
to reuse in other applications. Subschemes are saved in their own files (. sch files) and
can be easily copied to other ST-Realizer projects and reused. You may also save
customized subschemes symbols to a library, to be accessible by all projects.
(Subscheme symbols are described below).

Designing a subscheme is no different than designing an ordinary scheme, with one
exception—a subscheme has connections to its root scheme via a subscheme symbol. The
subscheme symbols are named sssp_(q, where p indicates the number of inputs you need for
your symbol and q the number of outputs. For example, sss2_1 is a subscheme with two
inputs and one output.

When you want to use a subscheme, you must therefore first think about its connections: what
inputs does the subscheme need to deliver its output. Once you know this, you can choose the
correct subscheme symbol from the main library.

Subschemes not linked to events (either by definition of execution conditions or the inclusion
of event symbols) are basically annexes to the root scheme, and therefore, the same rules
that apply to root schemes must apply to them.

However, those subschemes to which execution conditions are attached, or in which event
symbols are embedded, are special cases, and the rest of this section is dedicated to
describing how to configure subschemes with execution conditions or event symbols.

6.4.3 Description of ST-Realizer Events

Events are a general concept (described in Section 2.6 on page 16), and allow for the
conditional execution of code within an application. As outlined above, if an event is applied to
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an entire subscheme, it is called an execution condition; if it is applied to only a portion of code
within a subscheme, the event takes the form of an event symbol.

The following paragraphs give a list of the principle types of events—those that are hardware-
independent, meaning that they are available on all microcontrollers—and those that are
hardware-dependent, meaning that they make use of peripherals that are only available on
certain microcontrollers.

Events that are independent of the target hardware device:
e« Upon subscheme input change

CReset entry point)

Code contained in a subscheme is executed each
time one of the input signals coming from the

parent scheme has changed. This is similar to an Initialization
If..Else switch in standard programming
_E
algorithms.
9 Normal Code
The diagram at right shows a schematic flow Execution

diagram of an application with a subscheme
having this type of event (either as an execution
condition or an event symbol).

Subscheme
input(s)
changed??

Y

Subscheme
Code

I

Normal Code
Execution

L <

4

52/209




Chapter 6 Subschemes, Execution Conditions and Events

* Periodic Events
A periodic event, or execution condition,
acts at the level of the main loop. Inclusion
of a periodic event causes a counter based
on the number of base clock timer ticks
elapsed in previous main loop cycles to -

CReset entry point)

Initialization

measure a certain period of time. Normal Code
Execution

(Therefore, the period specified must always
be a whole number multiple of the timer rF— — — - — — — 4
tick’s value).

|
Once the period of time specified has A|
elapsed, the subscheme or periodic code | Elapsed?
part will be executed and the periodic |
|
|
|

counter will be reset.

Optimized part (Periodic Optimization)

A periodic event or execution condition is Periodic
Code Part/

analogous to an If..Else statement, where

. ) o Subscheme
the If condition is whether a specified L —— |
number of ticks have been counted at the ‘™ NormalCode 1
beginning of each main loop cycle. Execution
For example, at the beginning of each main ¢ | TIMER
loop cycle, the number of timer ticks elapsed IRQ

during the previous main loop cycle is
written to a variable called “rtick"®. In other
words, during the execution of main loop
cycle n, the value of rtick is equal to the
number of ticks elapsed in main loop cycle
n-1. Because periodic events and execution conditions add together rtick values to count
elapsed time, they are relatively imprecise timing methods and should not be used when
the application requires a very precisely timed event to take place.

Update timer
datastructures

For example, imagine that the you wish to define an event period equal to 5 timer ticks.
Say that during the first main loop cycle, the number of timer ticks elapsed is equal to 2.
The value of rtick for the duration of the second main loop cycle will therefore be equal to
2. However, during the second main loop cycle, because of other events or interrupts, the
execution time is longer, and 4 timer ticks elapse. The value of rtick will be 4 for the

1. A more detailed look at how the variable “rtick” is related to the timer tick is provided on
page 95.
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duration of the 3rd main loop cycle, so that when the periodic event is evaluated, it adds
together the values of rtick that it has received for all completed main loop cycles, and
arrives at a total of 2 + 4 = 6 timer ticks. Evaluation of elapsed time in periodic events is
always performed using an “equal to or greater than” condition. Therefore, the event will
take place during the 3rd main loop cycle. However, there will be an imprecision of at
least 1 timer tick in this particular case, because the specified period was 5 timer ticks and
the actual elapsed time was 6 timer ticks at the beginning of the 3rd main loop cycle.

e Timed interrupts -
CReset entry pomt)

Timed interrupts are a very precise method
of timing an event, because a timed interrupt
is executed independently of the main loop Initialization
of the application, and measures time

directly from the base clock timer tick. >

Normal Code
While periodic events count the cumulative Execution

value of elapsed timer ticks at the beginning |

of each main loop cycle, timed interrupts - TIMER
count each elapsed timer tick as it occurs.
This means that as soon as a specified

amount of time (i.e. a specified number of Update timer
datastructures

IRQ

timer ticks) has elapsed, the interrupt is
immediately executed.

In other words, a timed interrupt is triggered
directly from the hardware clock (for
example, Timer 1 or Timer A) measuring out
the timer ticks, rather from the evaluation of
main loop variables (such as rtick) which
count the number of timer ticks elapsed in Timed Interrupt
the previous main loop cycle. code part

Time
Elapsed?

Therefore, no matter what the main loop is -
doing, when the specified time has elapsed,
the main loop is interrupted and the timed
interrupt code or subscheme is performed
immediately.

(Return from Interrupt)

4
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Event that are hardware-dependent are:
* Peripheral interrupts

These are interrupts that occur when a specified peripheral has signalled the application
in some way.

An example would be an SCI peripheral, which uses an RS232 protocol transmission. If
you specify an SCI interrupt, the interrupt would occur (independent of the main loop)
when the end of the transmission has occurred.

6.4.4 Execution Conditions

Execution conditions can be applied to subschemes, such that the subscheme is only
executed when certain conditions are met—such as a timed interrupt, or upon a subscheme
input change.

Subschemes with execution conditions allow you to perform tasks in addition to the main loop,
if the execution condition is met. In this way, subschemes with execution conditions are
analogous to subroutine operations.

While a root scheme runs in a constant loop from the time the application starts to when it
stops, subschemes are only performed when specified by the execution conditions.

There are a variety of execution conditions that one can assign to a subscheme, and these
can vary depending on the target microcontroller for which the application is designed, and
furthermore, upon which of the microcontroller’s peripheral have been enabled for use by the
application.

6.4.5 Event Symbols

Event symbols are analogous to execution conditions, but while execution conditions apply to
an entire subscheme, an event symbol is placed within a scheme, and acts to trigger only
certain portions of the subscheme. When the conditions necessary to trigger an event symbol
are met, the event symbol outputs a binary value of “1”. When the event symbol’s conditions
are not met (i.e. the event is not triggered), the event symbol outputs a binary value of “0".
However, if none of the event symbols in a subscheme are triggered, the subscheme is
effectively invisible to the rest of the program and no code within it is executed.

Event symbols are assigned in much the same way as execution conditions—all of the same
options are available. However, because more than one event symbol can be included in a
single subscheme, they can be used as a means of imposing a range of conditions on the
same, or similar sequences of code. Because of this functionality, event symbols were
conceived more as a means of controlling hardware-dependent interrupts, than as an all-
purpose condition trigger.
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CReset entry point)

Initialization Subscheme Code

Normal Code

Execution
Event 1/

event symbols

Subscheme
Symbol

symbol sequence C

-

______________________

Normal Code
Execution

<

If we revisit the flow chart shown in Section 2.6.5, we can see how different event symbols can
be incorporated in the same subscheme, and how they influence how (and under which
conditions) the code in the subscheme is executed.

In this schematic example, we have placed a subscheme symbol in the midst of our normal
code loop (i.e. the root scheme) that references a subscheme containing two event symbols.

If neither of the conditions defined by the event symbols are met, the subscheme is ignored.
However, if either or both of the events are triggered (meaning that their conditions are met),
then the code in the subscheme executed in the following manner:

e If Event 1 is triggered (by the event’s condition being met):

- Symbol sequence A will be performed with output signal equal to “1” (out = 1). In other
words, the symbol sequentially following the Event 1 symbol will have the binary value
“1” as its input signal, and the rest of code sequence A will be executed in accordance.

- Symbol sequence B will be performed with output signal equal to “0” (out2 = 0). In other
words, the symbol sequentially following the Event 2 symbol will have the binary value
“0” as its input signal, and the rest of code sequence B will be executed in accordance.

- Symbol sequence C will be performed unconditionally (there are no event symbols
connected to this code sequence).

4
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« If Event 2 is triggered:
- Symbol sequence A will be performed with outl = 0.
- Symbol sequence B will be performed with out2 = 1.
- Symbol sequence C will be performed unconditionally.

e If neither Event 1 nor Event 2 is triggered, no part of the subscheme code will be
performed.

6.4.6 Compatibilities Between Types of Events and Certain Symbols

There are certain rules concerning which types of events can be placed together in the same
subscheme, because some types of events have priority over others, and furthermore, some
types of events are incompatible when placed together in the same subscheme.

Event types that may be placed together in the same subscheme:
* Any number of peripheral interrupts. When these interrupts occur simultaneously, the
program will give priority to the peripheral in accordance with the IRQ settings.

* A timed interrupt and any number of peripheral interrupts. Once again, execution priority
is given in accordance to IRQ settings.

» Periodic events and upon subscheme input change events may be placed together in the
same subscheme. Execution priority has less importance, because neither of these
events are independent of the main loop (i.e. each event is triggered by a value that is
augmented incrementally with the base clock timer tick). If both events occur
simultaneously, the event symbol closest to the upper left-hand corner of the subscheme
will be treated first.

Event types that may never be placed together in the same subscheme:
* More than one timed interrupt.

* A periodic event and a timed interrupt.

« A periodic event and a peripheral interrupt.

* An “upon subscheme input change” event and a timed interrupt.

* An “upon subscheme input change” event and a peripheral interrupt.

Note: If any of the above event types are placed separate event symbols in the same
subscheme, an error message will result when you run ST-Analyser.

Compatibilities between Events and Time-Related Symbols

« Periodic events and time-related symbols are completely compatible, because they both
count elapsed time in an identical manner.
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6.4.7 Subscheme Operations

In the remainder of this section, we will describe how to create a subscheme and assign
execution conditions to it.

Creating a
Subscheme

Connecting a
subschemeto a
symbol in the root
scheme

58/209

You can create your subscheme just a you would create a new scheme
(refer to Section 5.2.2 on page 34). Once you have opened the new

scheme window, design your subscheme with these guidelines in

mind:

- Place the symbols that represent the function the subscheme is

supposed to execute.

- Place as many portin and portout symbols as necessary. These
symbols are used to establish the links (in and out) between the root

scheme and the embedded subscheme.

- Make sure that the names for the portin and portout symbols are
the same in the root scheme and in the subscheme.

- Input ports are normally to the left, and output ports to the right, of the

symbol.

- Choose a name for your scheme and save it. A .sch file is created

with the name you specified.

Once your subscheme has been
drawn:

* Open the root scheme.
* Click ' =df .
i

The Main.lib list dialog box opens.

Select the sss-type symbol you
want to place. You will select the
sssp_g symbol that has p portin
symbols and g portout symbols in
the future subscheme.

—Ini ",
= 114
—nz -

* Click Place.

Input and output
Sequential

Logic

Time related

M athematical
Counter
Conversion

Table

Power management
Constant

State machine
Hierarchical sheet
Title

*When prompted to enter the “SCHEME”

attribute, type the name of the subscheme

(without the .sch extension).
The subscheme is now inserted in the root scheme: double-clicking
the symbol in the root scheme causes the subscheme to open.

- Thesssp_q symbol will be placed in the root scheme.
For example, the sss2_1 symbol is shown at left
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L Tip:

J—

L/

o\

Opening a
Subscheme

Assigning an
Execution
Condition to a
Subscheme

4

You may always add subscheme symbols to the root scheme even before you
have created the subschemes themselves. For example, you could place the
subscheme symbol, name it (using the same name you intend to give the
subscheme file). Then, to create the subscheme, all you need to do is double-
click the subscheme symbol. A warning message will display:

Wamg |

@ The file C:hrealv3iHeatinghzzname. sch dogs not existsl

Do pou want bo create i

Click Yes. A new scheme window will be opened and you can begin drawing
your subscheme.

To open a subscheme whilst in the root scheme:
e Double-click its symbol in the scheme.
To open a subscheme from the Project Viewer:

* Click on the name of the subscheme under the Schematics
folder.

To assign an execution condition to a subscheme, you must be in the
subscheme.

* In any blank area of the subscheme,

right-click the mouse to bring up the New 4
following popup menu: e b
» Select Execution conditions.
The Execution conditions dialog box for Leave
the current target microcontroller opens Evecution condtions
(ST72212G2 in the example shown below). Prapeites..
It shows the list of events that can occur

during the main loop execution and cause a
specific action to be performed, namely the execution of the code
generated by the subscheme.

This list depends on the target microcontroller and also which
peripherals on the microcontroller have been enabled. For this
reason, it is important to enable all of the peripherals that your
application needs to function (see “Connecting Input/Output
Symbols to Microcontroller Pins, Ports and Peripherals” on page 46)
before you define the execution conditions in any subschemes.
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Placing and
Configuring an
Event Symbol in a
Subscheme

60/209

[ ST72212G2 Execution conditions
Conditional execution of Filker.zch ™ Sart by conditions
Available conditions: Applied conditions:

Upon zub scheme input change
Periodic

TirerB Capture 1 interrupt
TimerB Compare 1 interrupt
TirerB Capture 2 interrupt
TimerB Compare £ interrupt
TirnerB Overflow interrupt

=1

Fropertiez | ok | Cancel |

In the example, the microcontroller ST72212G2 has had one of its
peripherals, Timer B, enabled. The resulting choice of execution
conditions are:

- Each time there is a subscheme input change.

- Periodically, by specifying a fixed time between each consecutive
execution.

- According to a timed interrupt.

- According either one of five Timer B interrupts (these are only
available because the Timer B peripheral has been enabled).

By placing an Event symbol in the subscheme, the execution of the
entire subscheme, or part of it, can be triggered by an event determined
by a specific symbol within the subscheme.
* Place the event symbol in the appropriate location in the
subscheme.
* You will be prompted to provide values for the attributes
Comment and Name.
The Name attribute will identify the event in the subscheme. In the
example shown below, the value of the Name attribute is
“My_Event”.
* Wire the event symbol to the rest of the subscheme diagram.
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* Right-click the symbol area.

A popup menu opens: Eatate ¢
» Select Connect. dirrar
The Events dialog box for the current Copy shape

target microcontroller opens (ST72212G2 in
the example).

It shows the list of events that can occur
during the main loop execution and cause a
specific action to be performed, namely the
execution of the code in the subscheme that follows the event
symbol.

This list depends on the target device.

B 5T72212G2 Events | x|

Connect event to by _Ewvent ™ Sort by event

Adtributes...

Edit...

Avwailable events: Connected events:

IJpon sub scheme input change Filker.zch = Timed interrupt 0.01 Sec.
Periodic by Ewvent = Upan sub scheme input cha
Timed interrupt

TimerB Capture 1 interupt
TimerB Compare 1 interupt
TimerB Capture 2 interupt
TimerB Compare 2 interupt
TimerE Ovwerflow intermpt

a | H

Froperties | ] 4 Cancel |

In the example (ST72212G2), the event “Upon subscheme input
change” has been associated with the event “My_Event”.

Configuring a Select Upon subscheme input change in the left window pane and
Subscheme Input click the right arrow (or double-click the line).
Change Event Click OK.
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Configuring a
Periodic Event

Note:

o

Configuring a
Timed Interrupt
Event

a0

Configuring an NMI
Interrupt Event
(ST6 devices only)

Configuring an
Input Interrupt
Event

62/209

Select Periodic in the left window pane and click the right arrow (or
double-click the line).

A new dialog box opens, for you to

specify the frequency of the code
execution (for example, specify

0.01 s if you want the code to be Time:

executed once every one-hundredth .01

of a second). Click OK.

Click OK in the events dialog box. ok_|_Cancel |

Remember that the time specified in a periodic event should be a multiple of the
base clock timer tick value. To change the value of a timer tick, refer to page 95.

Don't use periodic events for time-sensitive subschemes where high precision
is required. Because the execution of the code is not interrupt-driven, in some
instances the precision of the timing may be unacceptable. Periodic events are
best used to measure long periods of time where precision is less important.

Select Timed Interrupt in the left

window pane and click the right
arrow (or double-click the line).

A new dialog box opens, for you to
specify the time interval between two
consecutive timer interrupts.

Click OK. oK. I Eancell

Click OK in the events dialog box.

Tirme:
001

Timed interrupts are a very precise means of timing events and can be applied
to short delays.

The execution of the code generated by the subscheme is triggered by
the occurrence of a non-maskable software interrupt.

Select NMI Interrupt in the left window pane and click the right arrow
(or double-click the line).

Click OK.
The code generated by the subscheme is executed when an interrupt

occurs on an input line.
Select the appropriate input Interrupt in the left window pane and click
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Configuring a Timer
Overflow Event

Configuring Other

Peripheral-

Dependent Events

Disconnecting a
Subschemefromits

Execution
Conditions

Returning to the
Root Scheme from

a Subscheme:

4

the right arrow (or double-click the line).
Click OK.

The code generated by the subscheme is executed when a timer
overflow occurs.

Select the appropriate line in the left window pane and click the right
arrow (or double-click the line).

Click OK.

The code generated by the subscheme is executed upon the
occurrence of an event interrupt specific to the peripheral (for example,
end of SPI data transfer, ARTimer Compare interrupt, etc.). Note that
the peripheral must be enabled (refer to Section 4.3.6 on page 32)
before these specific interrupts will appear in the Execution Conditions
or Events dialog boxes.

Select the appropriate line in the left window pane and click the right
arrow (or double-click the line).

Click OK.

If you wish to remove the execution conditions from a subscheme,
perform the following:

* In any blank area of the subscheme,
right-click the mouse to bring up the New
following popup menu:

» Select Execution Conditions.
The Execution conditions dialog box for Leave
the current target microcontroller opens. Execution conditions
It shows, at the right side of the window, a ,
list of the applied conditions that have __ Propeties..
been attached to the subscheme.
Note that more than one condition can have been specified.

* Select the event to be removed.
¢ Click the left arrow.

L ¥

* Click OK.
Click the subscheme area out of any symbol R
with the right mouse button. =
A popup menu opens: M= »

2 awe

Leawe
Select Leave. C

onnect

Froperties...
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6.5 Table Symbols

There are two types of data tables that you can include in your scheme as a way of converting
or treating data: lookup tables and index tables. Both of these table symbols are found in the
main library, under the “Table” functional category.

Lookup tables convert input values to output values by matching their values in the table. If the
input value is not found in the table, a default output value is assigned. An example of a lookup

table is:

Input value Output value
def 0
10 82
15 128
30 67
35 48

According to the above table, when the input value is 10, the table symbol will output the value
82. When the input value is not equal to either 10, 15, 30 or 35, the output value will be equal
to 0.

Index tables are single column tables of output values only, however, each consecutive value
has a different indice. For example, the first value in the table would correspond to the default
value, the second value would have indice = “0”, the third to indice “1”, etc. This allows values
to be output sequentially, such as would be the case if you had a loop where at each iteration,

the output value changes. An example of an index table is:

Output value
0
45
96
132
145

According to the above example, if the input value was “2”, the index table symbol would
output “132".

Tables can store values in the Binary, Decimal, Hexadecimal and Octal formats.

The first line in a table defines the default output value (def ). This is the value that is output if
the input value is out of the range defined by the table.
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Once you have placed a table, you can either import data from an ASCII text file or enter the
data directly into the table. The following diagram shows the format of ASCII files—note that

commas are used to separate table entries:

ASCII File Contents: Table Values

aah inpLt outpLk

10h ,14h def =

20h ,30h 0 10 14

40h ,100h 1 20 a0
2 40 100

ST-Realizer stores table data in ASCII text files that have the extension . TAB.

Inserting a Table The Index and Lookup table symbols are named

Symbol indextable and lookuptable and are stored in the LODKUP
main library under the Table functional category. —| Q“]‘ |
ST
table
Changing tabledata Double-click inside the table symbol.
format The Table editor dialog box opens.
Select the format you want to use from the drop-down list in the Radix
combo box.
Click OK.

Editing table data  Double-click inside the table symbol.

The Table editor dialog box opens. (The figure below shows the
lookup table used as an example on the previous page.)

B Table editor

inpLat output |
def 1]
a 1a az
1 15 128
2 30 EY
3 35 45

Impart... | K I Cancel
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Importing files Into
tables

Note:

66/209

Double-click the cell whose value you want to change.

To insert a new row, click where you want to insert the row then press
the Insert key on your keyboard. For more rows, press Insert again.

Click OK.

Note that the Table editor dialog box shows an area for the graphical
representation of the table. X-axis is the input (or index) axis, Y-axis is
the output axis. The smallest Y value is on the bottom border, the
highest Y value is on the top border, the first value is on the left border,
the last value is on the right border.

Double-click just next to the table.
The Table editor dialog box opens.
Click the Import button.

The Import file dialog box opens.

In the Directories box, double-click the folder holding the file you want
to import.

The ASCII file you wish to import must be in the format shown on the previous
page—i.e. table entries must be separated by commas.

In the list below the File name: field, double-click the file you want to
import.
Click OK.
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7 THE MAIN SYMBOL LIBRARY

This chapter contains a listing of the symbols available in the main library (main.lib). Some of
them may be also included in the “persistent” (non volatile) library (mainper.lib) (these are
mentioned in the corresponding explanation column, where applicable).

The main symbol library is divided into the following functional categories: Input and output,
Sequential, Logic, Time related, Mathematical, Counter, Conversion, Table, Power
management, Constant, State machine, Hierarchical sheet and Title.

Each of these functional categories, and the symbols they contain are explained in the
following sections.

7.1 Input and Output Symbols

These symbols provide input and output links between the application you create and the
target microcontroller’s pins, ports and peripherals. It is important to remember to connect
each of the symbols from this category to resources on the target hardware device. Refer to
“Connecting Input/Output Symbols to Microcontroller Pins, Ports and Peripherals” on page 46
for instructions on how to do this.

Symbol Symbol Name Description

Analog-to-Digital Converter Symbol. The NAME
- attribute is used for connecting this symbol to a hardware

A port. For this, double-click the symbol. The TYPE attribute

AR DI adc is used to define the variable type (UBYTE, SBYTE, UINT,
UBYTE SINT, LONG, or WORD). The COMMENT attribute is used
Comment in the report file.

Digital Input Symbol. The NAME attribute is used for
connecting this symbol to a hardware port. For this,

name | — —— digin double-click the symbol. The COMMENT attribute is used
in the report file.
comrment Type = BIT

Digital Output Symbol. The NAME attribute is used for
connecting this symbol to a hardware port. For this,

— E:?'_—| name digout double-click the symbol. The COMMENT attribute is used
in the report file.
comment Type = BIT

4
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Symbol

Symbol Name

Description

Event Symbol. Can be used only in a subscheme to
cause the symbols that follow it in the subscheme code
flow to be executed when the associated event occurs.

event__name§ L event
Output type = EVENT
comment
Event With Enable Symbol. Can be used only in
subschemes to connect an event to the scheme it is in,
e MAMEf— thus causing an event-driven execution of the scheme.
Comment E type = Boolean. When TRUE it enables the execution of

eventenable

the event-driven subscheme.
OutDigital representation of the event (type = Event).

CountEvent name, the user is prompted for the symbolic
name (Count). The connection is made to a micro
controller event/interrupt and is invisible.

Remarks:None

Input Symbol. The NAME attribute is used for connecting
this symbol to a hardware port. For this, double-click the

EJEBT’—?'E input symbol. The TYPE attribute is used to define the variable
type (BIT, UBYTE, SBYTE, UINT, SINT or LONG). The
cormment COMMENT attribute is used in the report file.
Inputlatch Symbol. The input value (name) is loaded
when the enable input (En) is TRUE. You are prompted for
Mame the symbolic name and the type of input. The TYPE
—En — ) attribute is used to define the variable type (BIT, UBYTE,
UBYTE inputlatch SBYTE, UINT, SINT or LONG). The COMMENT attribute
comment is used in the report file.
En type = boolean
In type = Any type (BIT..LONG)
Output Symbol. The NAME attribute is used for
connecting this symbol to a hardware port. For this,
] outbut double-click the symbol. The TYPE attribute is used to
narme } P define the variable type (BIT, UBYTE, SBYTE, UINT, SINT
comment or LONG). The COMMENT attribute is used in the report
file.
68/209 1S77
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Symbol Symbol Name Description
Outputlatch Symbol. The output value (Name) is
transferred to the hardware port when the enable input
— name (En) is TRUE. You are prompted for the symbolic name
—En and the type of the physical output. The TYPE attribute is
comiment outputlatch used to define the variable type (BIT, UBYTE, SBYTE,

UINT, SINT or LONG). The COMMENT attribute is used in
the report file.

En type = boolean
Out type = Any type (BIT..LONG)

7.2 Sequential Symbols

Sequential symbols allow you to sequence inputs and outputs. They are a means of
sequencing signals in the main loop of the application, without introducing an interrupt.

Symbol

Symbol Name

Description

llllll '_.EI! EI T2

microdelf

Micro Delay Fixed Symbol. Delays the main loop for a
fixed time. This symbol is meant for short and time-critical
operations, and does not use the base clock timer tick,
thereby leaving Timer 1 (ST6) or Timer A (ST7) free for
other uses.

En type = Boolean. When En is true (= 1) the fixed delay
will become active.

Out type = Boolean. The output is a copy of the En input.
This output is used for linking the sequential symbols.
ValueTime = The time, entered in microseconds, of the
fixed delay/wait.

Note: When the fixed delay is started, all normal execution
process are halted. Only the interrupts are still active. The
watchdog, if applicable, is not reloaded.

g

69/209




Sequential Symbols

Chapter 7

Symbol Symbol Name

Description

—En Out— microdelv

ST | [ dse

Micro Delay Variable Symbol. Delays the complete
process for a user defined time. This symbol is meant for
short and time-critical operations.

En type = Boolean. When true the fixed delay will become
active.

Time type = Word. Defines the time to wait. The Time
input, together with the TimeBase, will determine the time
to wait.

Out type = Boolean. A copy of the En input. This output is
used for linking the sequential symbols.

TimeBase = The timebase, entered in microseconds. This
time base is used a the timebase for the Time input.
Note: When the variable delay is started, all normal

execution process are halted. Only the interrupts are still
active. The watchdog, if applicable, is not reloaded.

MHame —
—En | Ot inputsequence

TFE
Comment

Sequential Input Symbol. Converts, if enabled, a physical
input to a binary value. This symbol is meant for time critical
operations.

Name = Physical input. The user is prompted for the
symbolic name (In) and the input type. The connection is
made to a physical micro controller pin or register and is
invisible.

En type = Boolean. When true the physical input is read.
Out type = Boolean. A copy of the En input. This output is
used for linking the sequential symbols.

Note: When the input sequence is enabled, the physical
input is read immediately. .

—HAME outputsequence
—En O Cut—
Comment

Sequential Output Symbol. Converts, if enabled, a binary
value to a physical output. This symbol is meant for time
critical operations.

Name = Physical output (type = All). The user is prompted
for the symbolic name (Ol). The connection is made to a
physical micro controller pin and is invisible.

En type = Boolean. When true the physical output is
written.

Out type = Boolean. A copy of the En input. This output is
used for linking the sequential symbols.

Note: When the output sequence is enabled, the physical
output is written immediately.
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Symbol

Symbol Name

Description

—hral HAME

—En W Out—

Comment

waitsequence

Sequential Wait Symbol. Reads a physical input and
waits until it equals a pre-defined value. This symbol is
meant for short and time critical operations.

Name = Physical input (type = All). The user is prompted
for the symbolic name (In). The input type equals the Val
input type. The connection is made to a physical micro
controller pin or register and is invisible.

Val = The comparison value.

En type = Boolean. When true the physical input is
continuously read until the physical value equals the Val
input.

Out type = Boolean. A copy of the En input. This output is
used for linking sequential symbols.

Note: When the wait sequence is started, all normal
execution process are halted. The physical input is read
continuously until it equals the Val input. Only the interrupts
are still active. The watchdog is re-loaded.

7.3 Logic Symbols

Logic symbols perform logical functions essential to most programs. With these functions, you
can control a program’s path, and depending on whether the logical condition is satisfied or
not, divert the application into different subschemes or subdiagrams.

Symbol Symbol Name Description

Two-value binary AND function symbol with type
inheritance.

—a Z=AANDB
A type = Any type (BIT..LONG

& sl and? yp y type ( )

B type = Any type (BIT..LONG)

— B Z type = The largest A or B type
Note: ANDing a BIT-type value and a WORD-type value is
not allowed.
Three-value binary AND function symbol, only
applicable to BIT-type values.

—a Z=A AND B AND C

and3
&}
—C

4
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Symbol Symbol Name Description

Four-value binary AND function symbol, only applicable
to BIT-type values.

—A Z=A AND B AND C AND D

_E'&z - and4

—C

— b
Six-value binary AND function symbol, only applicable
to BIT-type values.

—* Z=A AND B AND C AND D AND E AND F

—B

_':&E - and6

—D
Eight-value binary AND function symbol, only applicable
to BIT-type values.

—] Z=A AND B AND C AND D AND E AND F AND G AND H

—D&E - ands

—E

—F

—G

—H
Change Detection Symbol. An output pulse is generated
when the input value changes.

change

IN type = Any type (BIT..LONG)
OUT type = BIT

72/209
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Symbol

Symbol Name

Description

dff
pdff

D Element Symbol. D flip-flop symbol with multiple-type
data input. D input is clocked in on a rising edge on the C
input.

D input type = Any type (BIT..LONG)

C input type = BIT

Q, Q output types = same as D

When in the persistent (non volatile) library this symbol
(named pdff) shows an “M” in its design.

r
()
P

dff-clr

D Element with Clear Symbol. D flip-flop symbol with
multiple-type data and clear input. D input is clocked in on
arising edge on the C input. The D flip-flop is cleared when
Clr is high.

D input type = Any type (BIT..LONG)
C input type = BIT
Q, Q output types = same as D

dlatch

D Latch Symbol with multiple-type data input. D input is
clocked in when C input is high.

D input type = Any type (BIT..LONG)
C input type = BIT
Q, Q output types = same as D

Xor

Two-value binary Exclusive OR function symbol with
type inheritance.

Z=AXORB

A type = Any type (BIT..LONG)
B type = Any type (BIT..LONG)
Z type = The largest A or B type

Note: XORing a BIT-type value and a WORD-type value is
not allowed.

init

Initial Loop Symbol. Output TRUE only during the first
pulse after reset.

Out type = BIT

4
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Symbol Symbol Name Description
Multi-type binary Inverter Symbol.
Z=NOTA
inv A type = Any type (BIT..LONG
— 4 1 = yp y type ( )
Z type = A type
Jk Flip-flop Symbol. Values are:
adk 3 K Q Q
—= |k 0 X X Q1 Q1
= ! 0 0 Q1 Q1
— -
X . ! 1 0 1 0
jkff ! 0 1 0 1
! 1 1 t oggl e
Where:
I = rising edge
X = don't care
Q 1 = previous value
One-loop Delay Symbol. The output is the previous value
of the current input.
-1 loopdel In type = Any type (BIT..LONG)
—=s L .
Out type = In type
One-selection Input Multiplexer Symbol. If the 0/1
selection input value is 0, Out takes the input 0 value.
—a Otherwise Out takes input 1 value.
1 =BIT
— 0/1 type
_n mux1 0, 1 type = Any type (BIT..LONG)
Out type = The largest 0 or 1 type
Out—
—1
741209 I<72
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Symbol Symbol Name Description
Two-selection Input Multiplexer Symbol. Values taken
by Out are shown in the following table:
] D} 0 Sel bit 0 Sel bit 1 out
—1d 3 0 0 I nput 0 val ue
1 [ 1 0 Input 1 value
0 mux2 0 1 I nput 2 val ue
T 1 1 I nput 3 val ue
— 1T Out—
1 Sel 0/1 type = BIT
0, 1, 2, 3 type = Any type (BIT..LONG)
—3 Out type = The largest 0, 1, 2, or 3 type
Two-value binary NOT AND function symbol with type
inheritance.
— A Z =NOT(A AND B)
e 42 A type = Any type (BIT..LONG)
nan
z B type = Any type (BIT..LONG)
] B Z type = The largest A or B type
Note: NANDing a BIT-type value and a WORD-type value
is not allowed.
Three-value binary NOT AND function symbol, only
applicable to BIT-type values.
— ."E'x Z=NOT (A AND B AND C)
] B&Z [ nand3
Four-value binary NOT AND function symbol, only
applicable to BIT-type values.
_-'E"- Z= NOT(A AND B AND C AND D)
| [
B&Z nand4
—C
—D

4
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Symbol Symbol Name Description
Six-value binary NOT AND function symbol, only
A applicable to BIT-type values.
Z=NOT(A AND B AND C AND D AND E AND F)
—E
— [
C&Z nand6
—D
—
Eight-value binary NOT AND function symbol, only
_In applicable to BIT-type values.
Z=NOT(A AND B AND C AND D AND E AND F AND G
—E AND H)
—
— [,
D&Z nand8
—E
—F
— =
—H
Two-value binary NOT OR function symbol with type
inheritance.
— A Z = NOT(A OR B)
A type = Any type (BIT..LONG
» 7k Coro ype = Any type ( )
B type = Any type (BIT..LONG)
—E Z type = The largest A or B type
Note: NORing a BIT-type value and a WORD-type value is
not allowed.
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Symbol Symbol Name Description
Three-value binary NOT OR function symbol, only
applicable to BIT-type values.
— A Z=NOT (A OR B OR C)
—E }}1Z -, nor3
—C
Four-value binary NOT OR function symbol, only
A applicable to BIT-type values.
o Z=NOT(A OR B OR C OR D)
— -,
}}1‘2 nor4
—C
—D
Six-value binary NOT OR function symbol, only
applicable to BIT-type values.
—A Z=NOT(AORBORC OR D OR E OR F)
—B
| [,
C })12 noroé
—D
—E
—F

g
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Symbol

Symbol Name

Description

Eight-value binary NOT OR function symbol, only
applicable to BIT-type values.

Z=NOT(AORBORC

ORDOREORFORGORH)

A,
B
-
| e
D }}‘12 nor8
—E
—F
— =
—H
Two-value binary OR function symbol with type
inheritance.
—A Z=AORB
)}1 7 or2 A type = Any type (BIT..LONG)
B type = Any type (BIT..LONG)
—B Z type = The largest A or B type
Note: ORing a BIT-type value and a WORD-type value is
not allowed.
Three-value binary OR function symbol, only applicable
to BIT-type values.
— A Z=AORBORC
5 })1 7l or3
—C
Four-value binary OR function symbol, only applicable
A to BIT-type values.
o Z=AORBORCORD
T B }}1Z [ or4
—D
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Symbol Name

Description

oré

Six-value binary OR function symbol, only applicable to
BIT-type values.

Z=AORBORCORDOREORF

T o T Mmoo W=
A
N

or8

Eight-value binary OR function symbol, only applicable
to BIT-type values.

Z=AORBORCORDOREORFORGORH

edge

Rising Edge Detector Symbol. A rising edge on input
causes an output pulse to be generated.

In type = BIT
Out type = BIT

srff
psrff

Set/reset Flip-flop Symbol.

A high level on S causes output Q to be set to 1 (Q = 0)
A high level on R causes output Q to be setto 0 (Q = 1)
All types = BIT

When in the persistent (non volatile) library this symbol
(named psrff) shows an “M” in its design

4
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7.4 Time Related Symbols

Time related symbols perform functions where the concept of time is required. This range from
requiring a delay period, or a timed operation, to providing an oscillating signal. These
symbols can be used in the main loop and will run off of the default microcontroller timer. They

do not interrupt the main loop.

Time-related symbols use the timer tick to evaluate whether their conditions in exactly the
same way that periodic events do—refer to page 53 for a description of how periodic events

evaluate time.

Symbol Symbol Name

Description

I THT O}

Delay Fixed Symbol. An ON or OFF input bit is delayed a
specified fixed time. The TIME attribute format is:

dd: hh: mm ss. xxx

delf where:
dd is the number of days, hh is the number of hours, nmis
the number of minutes, ss is the number of seconds and
XXX is a fraction of a second.
I and O types = BIT
Delay Fixed Off Symbol. An OFF input bit is delayed a
specified fixed time. The TIME value format is:
—+10 T 0 dd: hh: mm ss. xxx
delfoff where: _ _
dd is the number of days, hh is the number of hours, nmis
the number of minutes, ss is the number of seconds and
XXX is a fraction of a second.
I and O types = BIT
Delay Fixed On Symbol. An ON input bit is delayed a
specified fixed time. The TIME value format is:
] |T’_m o= dd: hh: mm ss. xxx
where:
delfon

dd is the number of days, hh is the number of hours, nmis
the number of minutes, ss is the number of seconds and
XXX is a fraction of a second.

I and O types = BIT

—=| T——T O delv

— Time

Delay Variable Symbol. An ON or OFF input bit is delayed
a variable time. The Time input defines the number of clock
ticks for the delay (default= 10 ms).

Time type = WORD

I and O types = BIT
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Symbol

Symbol Name

Description

| 0——T O

Delay Variable Off Symbol. An OFF input bit is delayed a
variable time. The Time input defines the number of clock

n B delvoff ticks for the delay (default= 10 ms).
A Time Time type = WORD
I and O types = BIT
Delay Variable On Symbol. An ON input bit is delayed a
variable time. The Time input defines the number of clock
L T|—| 0 ok delvon ticks for the delay (default= 10 ms).
_ Time type = WORD
L fime I and O types = BIT
Fixed Time Oscillator Symbol. The TIME attribute format
name is:
dd: hh: mm ss. xxx
time O where:
comment oscf dd is the number of days, hh is the number of hours, nmis
the number of minutes, ss is the number of seconds and
xxX is a fraction of a second.
Note that the frequency in Hz is = 1/(2*TIME)
O type = BIT
Variable Time Oscillator Symbol. The Time input defines
name the number of clock ticks (default= 10 ms).
oscv Note that the frequency in Hz is = 1/(2*TIME)
— Time O— TIME type = WORD
comment O type =BIT
Fixed Timer Symbol. Arising edge on the input pin causes
Name a pulse to be generated. The TIME attribute format is:
—1_ 1 | o+ dd: hh: mm ss. xxx
(;rclmﬁ?nent timf where:

dd is the number of days, hh is the number of hours, nmis
the number of minutes, ss is the number of seconds and
XXX is a fraction of a second.

I, O type = BIT

4
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Symbol Symbol Name Description
Variable Timer Symbol. A rising edge on the input pin
name causes a pulse to be generated. The Time input defines the
) number of clock ticks for the pulse (default= 10 ms).
—= 1 /T © timv .
] Time type = WORD

—lime I, O type = BIT

comment

7.5 Mathematical Symbols

These symbols perform mathematical functions such as adding, subtracting, multiplying,
dividing, integrating and differentiating, so that you may treat and transform your application’s

signals.

Symbol

Symbol Name

Description

+’f)—
ey
“\-\_r-"/

add2

Two-value Add Symbol with type inheritance.
OUT =IN1+IN2

IN1 type = WORD

IN 2 type = WORD

OUT type = The largest IN1 or IN2 type

(8 +B)2 —

average

Average Symbol. Takes average of IN1 and IN2.
OUT = (IN1 + IN2)/2

IN1 type = WORD

IN 2 type = WORD

OUT type = The largest IN1 or IN2 type

—=In

DIFF out-

differential

Differential Symbol. Takes derivative of input (In) with
respect to time. K is a constant input value.

Oout(t)= 2/3*(In(t)-In(t-dt))/dt+1/3*Out(t-dt)
K=2/(3*dt)
Type = depends on input type

div

Divider Symbol.

Q=A/B

R = A%B

A, B type = WORD

Q, Rtype = The largest A or B type
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Mathematical Symbols

Symbol Symbol Name Description
Integral Function Symbol.
i Out(t) = Out(t-dt) + In(t)*dt
i K= 1/dt
INT Ot - integral .
Type = depends on input type
— K
Fixed Limiter Symbol. Output value is not larger than the
Val top value, and not smaller than the bottom value.
a op imi | type = WORD
=l | O—— 'm O type = | type
ValueBottom
Variable Limiter Symbol. Output value is not larger than
T the top value, and not smaller than the bottom value.
b TOP type = WORD
—n () — limv BOTTOM type = WORD
In type = WORD
— Bottom O type = In type
Multiplier Symbol.
Z=A*B
— A A, B type = WORD
¥ mul Z type = The largest A or B type
— B
Fixed Scaler Symbol. G = Gain. O = Offset.
Output = Input*Gain + Offset
(52 _
. B scalert I type = WORD
—l FG+0 Output value type = | type
05

4
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Symbol Symbol Name Description
Variable Scaler Symbol. G = Gain. O = Offset.
| Output = Input*Gain + Offset

| type = WORD

—5 [Fe+O- scalerv Output value type = | type

— 0
Two-value Subtractor Symbol with type inheritance.
OUT =1IN1 - IN2
IN1 type = WORD

sub2

IN 2 type = WORD
OUT type = The largest IN1 or IN2 type

7.6 Counter Symbols

Counter symbols let you count the iterations of either a fixed or variable signal.

Symbol Symbol Name Description
Counter symbol with fixed initial value.
A rising edge on the Up input pin causes the counter to be
n incremented by one.
A rising edge on the Dn input pin causes the counter to be
—=Lp decremented by one.
_Lon vl ,Sb\e?lt%hol.evel on the Clr input pin causes the counter to be
countf . . .
— Cr ZFeropF A rising edge on the Pr input pin causes the counter to be
pcountf loaded with the specified value (via the value dialog box).
—pFr [l When the counter output value Val reaches 0 the Zero
TIMT output value = 1.
= Up, Dn, Clr, Pr and Zero types = BIT
Val type = WORD
When in the persistent (non volatile) library this symbol
(named pcountf) shows an “M” in its design
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Symbol Symbol Name Description
Counter symbol with variable initial value.
A rising edge on the Up input pin causes the counter to be
.y incremented by one.
H A rising edge on the Dn input pin causes the counter to be
—=0n Yl decremented by one.
— CIr  Fero A high level on the ClIr input pin causes the counter to be
setto 0.
_} Flr countv L. . .
A rising edge on the Pr input pin causes the counter to be
— Pyal pcountv loaded with the Pval input value.
SINT When the counter output value Val reaches 0 the Zero
output value = 1.

Up, Dn, CIr, Pr and Zero types = BIT
Val and Pval types = WORD

When in the persistent (non volatile) library this symbol
(named pcountv) shows an “M” in its design

7.7 Conversion Symbols

Conversions symbols allow you to convert between different data types within the application.

Symbol

Symbol Name

Description

— EO
— E1
— B2
— B3 W
—E4
—E&
—E&
— E¥
PLIBTTE

bpack

8-bit to 1-byte Packer Symbol. Enables you to construct
a byte out of eight bits.

BO to B7 type = BIT
W type = WORD

g
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Symbol Symbol Name Description
1-byte to 8-bit Unpacker Symbol. Enables you to unpack
a byte into eight (or less) bits.
B W type = WORD
e BO to B7 type = BIT
B2 —
—w B3l— bunpack
B4 —
BS —
BE —
BY —
Multi-purpose Comparator Symbol.
if B>A, the B>A output takes bit value =1
_a Bt if B=A=C, the B=A=C output takes bit value =1
comp if B<C, the B<C output takes bit value =1
—F R A, B, C types = WORD
— B=C—
output types = BIT
Type conversion symbol that enables you convert a BIT
type to a WORD type or a WORD type to a BIT type.
— 28T — convert IN type = BIT..LONG
OUT type = BIT..LONG
Shift register symbol.
narme If Clr = 1, the shift register is cleared
Ao If D/U = 0, the shift direction is down
If D/U = 1, the shift direction is up
-| bU Cr A rising edge on Cin causes the In input value to be loaded
—=in Ot — shift into the shift register.
in pshift A ri;ing edge on Shift triggers the shift operation in the shift
register.
—=Shift The C output is the last bit shifted out (carry).
SINT Clr, D/U, Cin, Shift, C type = BIT
comment In, Out type = Any type (BIT..LONG)
When in the persistent (non volatile) library this symbol
(named pshift) shows an “M” in its design
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Symbol Symbol Name Description
Word Merge Symbol. Symbol used to build a word out of
a high byte and a low byte.
—H All types = WORD
wmerge
—L
LIMNT
Word Pack Symbol. Symbol used to pack sixteen bits into
one word.
— Bl
—E1
—E2
—E2
— B
—E3
— BE
—{e7 W wpack
— B
— B3
— B0
— E11
— E12
— B2
— Ela
— E15
LIHT
Word Split Symbol. Symbol used to split an input word
into a high byte and a low byte.
| IEYTE All types = WORD
wsplit
— W
_EYTE

4
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Symbol Symbol Name Description

Word Unpack Symbol. Symbol used to unpack a word into
sixteen bits.

wunpack

EZESERFEREE

Ell—
El2—
E1d—
Ela—
Ela—

7.8 Table Symbols

Table symbols allow input values to be converted to output values according to a table of
correspondence which you either input directly, or import from an ASCII file.

Note: Take care to choose the data input type (I type) carefully as some types use
more of the microcontroller's available RAM than others.

Symbol Symbol Name Description

Index table Symbol. The input value is used as an index

INDEX in the table. The table is stored as an ASCII file defined by
the TABLE attribute. Each table begins with a default value
— | Qi _ that is used when the input value is out of range. To create
indextable or change a table, double-click the symbol.
SINT
| type = WORD
table

Q(l) type = Any type (BIT..LONG)
See also: pitable (persistent index table)

Lookup Table Symbol. The input value is the search
argument to find the output value. The table is stored as an

LOOKUR ASCII file defined by the TABLE attribute. Each table
— Q(I] - lookuptable pegins with a default value that is used when the input_ value
is out of range. To create or change a table, double-click the
SINT symbol.
tahle | type = WORD
Q(l) type = Any type (BIT..LONG)
88/209 V<72




Chapter 7 Power Management
Symbol Symbol Name Description
Ramtable Symbol. Converts the input to a non-linear
output value, found within the table. The inputis used as an
—[Dats index to address the constant value from the table. You can
ramtable change the table by clocking in the Data input at the
—In Ot - (volatile RAM) position pointed to by the In input.
Data, In type = WORD
—= Clock BlockSizelnUnits = size of the table.
SINT
Index table symbol for a table stored in persistent (non
volatile) memory. The input value is used as an index in the
-|Data M pitable table. You can change the table by clocking in the Data
i L . h " . . _
In Ot (persistent library |[r)1ptut allt tt e pcis:;t\l/cglRp[c))mted to by the In input
—= Clock only) aa, Inype =
ST Q(l) type = Any type (BIT..LONG)

See also: indextable

7.9 Power Management

Power management symbols allow you to control the power consumption of the
microcontroller by changing between normal, slow, stopped and wait modes.

Symbol Symbol Name Description
slow Slow mode symbol. Sets the microcontroller clock
frequency lower. Refer to your target microcontroller’s
datasheet for information on controlling its clock frequency
settings.
stop Stop mode symbol. Sets the microcontroller to standby.

Requires a reset or external interrupt to wake up the
microcontroller.
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Symbol Symbol Name Description

wait Wait mode symbol. Sets the microcontroller to sleep
mode. The microcontroller can be woken up by any

interrupt.
! A

7.10 Constant Symbols

Constant symbols are useful when you need to compare a signal value to a fixed value.

Symbol Symbol Name Description

Constant bit symbol. Values 0 and 1 are allowed.
OUT type = BIT

r?D | constb

Constant word symbol. The value can be specified in the
range -2147483648 to 2147483647.

M | constw Values can be in decimal, binary, hexidecimal or octal
types. The value is a decimal value by default.

OUT type = WORD (determined by the value specified)

7.11 State Machine Symbols

State machine symbols are used to create state machines for the application. State machine
symbols define and control the progression of, the various states of your application.

Symbol Symbol Name Description

Initial state symbol in a state machine. Every state
machine must have one and only one stateinit symbol.
This symbol can only be connected to condition or state
symbols.

When in the persistent (non volatile) library this symbol
(named pstateinit) shows an “M” in its design .

stateinit
- pstateinit

4
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State Machine Symbols

Symbol

Symbol Name

Description

state

State symbol used within a state machine. Can be used in
conjunction with a stateout symbol within a scheme. See
also stateout. The state symbol can only be connected to
condition, state or stateinit symbols within a state
machine.

condition

Condition function symbol for state machines.This
symbol can only be connected to state or stateinit symbols
in state machines.The NAME attribute is used to make a
connection with a statein symbol in schemes. See also
state.

statein

State input symbol. This symbol connects a BIT variable
to a condition symbol within a state machine. The
connection is performed by assigning the condition and
statein symbols the same name.

In type = BIT

stateout

State output symbol. This symbol extracts a state from a
state machine and converts it to a BIT variable. The
connection is performed by assigning the state and
stateout symbols the same name. See also state.

Out type = BIT

g
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7.12 Hierarchical Sheet Symbols

Hierarchical sheet symbols are used to represents subschemes and their inputs and outputs.

Symbol Symbol Name

Description

Iabeb>— portin

Portin Symbol. This symbol is used to connect the
subscheme symbol pins from the parent scheme with the
subscheme nets. The LABEL attribute is used to make the
connection between the subscheme symbol pin and this
symbol.

% label portout

Portout Symbol. This symbol is used to connect the
subscheme symbol pins from the parent scheme with the
subscheme nets. The LABEL attribute is used to make the
connection between the subscheme symbol pin and this
symbol.

—nz SSSX_Y

filename

Subscheme symbol, with x input pins and y output pins.
The symbol column shows an example of a subscheme
with 2 input pins and 1 output pin. The SCHEME attribute
defines the filename of the subscheme. portin and portout
symbols are used to make the connection between the
actual subscheme and the pins of the subscheme symbol.
Several types of subscheme symbols are available in the
main library:

sss0_1,sss1 0,sssl 1,sssl 2,sss2 1,sss2 2.

7.13 Title Symbols

The title symbol is used to enter information about the scheme you are working on, for

archiving purposes.

Symbol Symbol Name Description

Title block used for archiving
v 000 [oater - a7 Eulrdefﬁst. There are rt\umerlous
ciedt 7 T— ields tha yom_J can en_ er values
ey —— . for to record information about

pany: % title ;
Address: 7 the scheme, the circumstances
City: ? of its creation and the project.
Country; 7
Initial Date: - [Page: 1 [of: -
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8 ANALYSING AND GENERATING YOUR APPLICATION

8.1 Overview

ST-Analyser is a built-in tool that analyses your application for errors and converts it into either
ST6 or ST7 code, depending on the target microcontroller. If any errors are encountered
during the analysis and code generation, online information is provided to help you locate the
error and take corrective action.

When you execute the analysis and compile, ST-Analyser analyses the current project by
creating the netlist and cross references, then analysing and generating the final code. During
this process, all project schemes are checked for connections between symbols, 1/0O
assignments and variable types, before generating the source code. Providing no fatal errors
are encountered, ST-Realizer generates a non-compiled ST macro-assembler language
(.asm) file from the scheme.

ST-Analyser then generates the binary ST code. This process runs the STMicroelectronics
assembler. Depending on whether or not you included the ROS (see Section 2.3 on page 13
and Section 4.3.4 on page 29), a file with extension *.hex or *.obj respectively is generated for
ST6, or with extension *.s19 or *.0bj for ST7. A *.hex (or *.s19) file can be directly loaded into
an ST MCU while you must link a *.obj file with another program.

When the analysis process has been successfully completed, a report file is generated. This
report file gives information about the designation of I/O pins, a list of the variables used by
type and the memory space required by the application.

If any messages are generated during the analysis and compile, you can view them and trace
them back to their origin.

ST-Realizer includes hardware-specific characteristics, which you must configure prior to
analyzing and compiling your code. They cover general hardware, memory, and peripheral
information. See Section 4.3 on page 28 for further details.

8.2 Changing the Compile Options

Before you analyse and compile schemes using ST-Realizer, you can set the following
compilation options:

* Whether or not you want to generate source code.

* Whether or not you want to invoke the assembler.

* Whether or not you want to generate final hex code.

* Whether or not you want to include project data (this can be useful for version control).

« Whether or not you want to generate code that uses a constant sampling time (you must
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choose this option if your scheme includes the mathematical symbols: integral and
differential). If you choose this option, the duration of the main loop is constant.

 The frequency of the base clock (tick) for the timer symbols. By default this is 0.01
seconds (10 milliseconds).

To generate, in a single run, executable code that can be embedded in an ST device, you
must use the default settings.

Each ST device needs its own assembler and target compiler to create the final executable
file. These elements are standard components of the ST-Realizer system.

To view or set the compile options:
1 Onthe main menu, click Options, then Project...

The Analyse options dialog box opens, with tabs for you to

Options Kl R .
select daughter dialog boxes.

Eroject..

Environment...

2 The Code Generation dialog box is the first of the tabs.

If you deselect the
Generate source code

tions
r Timing T Code optimization ]

option, the Invoke

assembler and Generate [ Generate sourcs code
final hex code OptionS will ¥ Irwvake assembler
also be deselected as ¥ Generate final hex code

these are suboptions of the
code generation process.
They control, respectively,
the generation of your
application in ST6 or ST7
assembler code (the
creation of the . asmfile), 0K | Coneel |
and the creation a binary
(hex) version of the code (a
. hex, . obj or.s19 file, depending on the microcontroller as described on page 93).

¥ Include project data in source code

4
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o Tip: Note that you must generate the assembler version before you can produce the

— binary (hex) code. The first three options must be selected in order to produce
the binary (hex) code you need to load your application into your microcontroller
using a programming tool.

L/

o\

The final option in the Code generation dialog box is to include project data in the source
code. If this option is enabled, the Analyse report will record how many times Analyse has
been performed, which is useful in keeping track of different project versions.

Once you have selected the options you wish, click OK.

3 The second tab opens the Timing dialog box.

B Analyze options E3 |

Code generation TTII‘I‘IIHQ Code optimization ]

Realizer uses timer ticks for timing.
Generate a timer tick after ||:|_|:||:|'| ZELC.

To ensure that the proceszing time of a project iz always the zame
uze a fiked proceszing cycle time.

[T Fived processing cycle time

One proceszsing crcle must be finighed in | 1 timer ticks

Ok, | Cancel |

Every ST6 or ST7 microcontroller has a timer, called Timer 1 (ST6) or Timer A (ST7),
which (if there are either time-related symbols or events in the application) is used as the
base clock to measure out units of time called “timer ticks”. Timer ticks are the smallest
increment of time that a timer can count. In this dialog box, you may choose the value for
the “timer tick” or base clock unit used in the application.

The minimum value that you can enter for the timer tick depends on the target hardware
device. The table below summarizes the minimum and maximum values for the timer tick

4
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for each family of microcontroller.

ST6 (8 MHz crystal) ST7 (16 MHz crystal)
Minimum
Timer Tick 100 ps 75 us
Maximum 48 000 pis 60 000 s
Timer Tick H H

Timer ticks may also be used to count the number of main loop cycles. The time it takes to
perform a main loop cycle is called the Processing Cycle Time. By default, the
processing cycle time is variable, with the shortest (fastest) possible processing cycle
time being 1 timer tick. However, in this dialog box, you can choose to fix the processing
cycle at a specific number of timer ticks of your choosing, by selecting Fixed processing
cycle time, and then specifying the number of timer ticks that you wish to correspond to a
single processing cycle.

Note: Timer ticks (and the code needed to generate them) are ONLY created if you
use either time-related symbols, or events that require a timer, in your
application. Otherwise, the processing cycle time will be variable.

If your application uses any symbols or events that require the measurement of time (the
timer symbol, for example) the default timer (Timer 1 or Timer A) will be used to measure
that time using timer ticks. In addition, all time-related symbols or events (such as a
periodic event) that are based on the timer tick, can also be controlled using the default
timer. However, if you require a further timer that will NOT be based on the timer tick (as
is the case, for example, when you wish to generate a pulse width modulated (PWM)
signal), you will have to enable one of the peripheral timers on the microcontroller (if it
exists—make certain that the microcontroller you have chosen can provide all of the
peripherals you require).

To give an example of how the timer tick is used, imagine that you decide that you set the
value of the timer tick at 0.01 seconds. When you start running your application, the
default timer (Timer 1 or Timer A) will count out the number of ticks (each tick being equal
to 0.01 s).

At the beginning of the second main loop cycle, the total number of timer ticks that have
elapsed during the first main loop cycle is recorded (i.e. the number of elapsed timer ticks
is written to a variable called “rtick”).

4
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This recorded value is used to evaluate all time-related symbols and most (but not all(}))
time-related events during the running of the second main loop cycle. Simultaneously, the
timer resets and begins counting the number of ticks that elapse during the running of the
second main loop cycle. At the beginning of the third main loop cycle, the number of timer
ticks that have elapsed during the running of the second main loop cycle is recorded, and
this recorded value is used during the execution of the third main loop cycle.

If you choose to fix the processing cycle time, the number of timer ticks elapsed during
each main loop cycle remains constant.

o Tip: Please note that there is one golden rule when it comes to timers—the quantity

— of time that you are measuring (either using a timer symbol or a periodic event)
must be substantially greater than one tick. Because these time-related
functions are based on the timer tick, they cannot measure times less than the
value of one tick. Furthermore, the closer the value of the measured time period
is to the value of one tick, the more inaccurate the timer function will be (refer to
“Periodic Events” on page 53 for details on why this is).

o

Once you have entered the Timer options you wish, click OK.
The last tab opens the Optimisations dialog box.

The options in this dialog box are not currently available in this version of ST-Realizer II.
However they are implemented in Realizer Gold which can be obtained from Actum
Solutions.

8.3 Executing the Analysis and Compile

When you execute the analysis and compile, ST-Realizer performs the following tasks:

Creates a netlist of all the schemes in the project.

Creates the cross references between all schemes in the project.
Analyses the logical functionality of the schemes for consistency.
Generates the ST code.

Transfers the ST code to the assembler for the chosen target hardware. This assembler
generates the final executable code that is transferred into the target ST.

Scans the map file and generates a report file.

You may execute the ST-Analyser from any of the project windows.

1. Some time-related events use the timer tick differently to evaluate elapsed time more
precisely. For more information, refer to “Timed interrupts” on page 54.
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e In the Project menu, simply click Analyse. The ST
Analyser Status window will open and you will see
the Analyse function checking your application step-
by-step.

Close
5T Analyser Status |

Hardware select...

s][=lel Cpotions  Tools  Wir

MEw .

Open...

Status: Mo errors. Hardware gettings...
Creating Metlist QK Frint

Creating Crozs Reference aF.

Analyzing 0k

Generating Final Code ] 4

Esecuting Target Compiler ]

Creating R eport File 0k

« When the analyse process has finished successfully (with no errors), click OK at the
bottom of the ST Analyser Status window.

* A new window will appear on your screen, entitled Analyser messages. It will simply
report the date and time and that “no errors” were found.

8.4 What to Do if there are Errors Found during Analyse

1 Iferrors are found, the ST Analyser Status window will show a “fail” message and give the
number of errors found. Click OK.

2 A descriptive list of the errors will be shown in the Analyser messages window which then
opens at the bottom of the scheme window. You can view each error by either double-

clicking on its message in the window, or by clicking the previous message G‘- or next

4
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e
message Lo icons on the toolbar. The area of the scheme where the error occurs will

appear in the scheme window.

"_Ti Analyser messages

Error (509]: A state input Start iz not connected to a net. Aninput pin must always be connected to a net.
Warhing [2]: Mot all symbolz are analysed, total symbolz: 44 analysed symbols: 40
tessage : ST Analyser [Beta) results of Mon Apr 12 13:33:40 1933 : 1 'Waming and 2 emors.

3 Correct the errors and re-compile the application by clicking on Analyse under the Project
menu.

8.5 Viewing and Tracing Generated Messages

The information in the Analyser messages window is saved after you run ST-Analyser and
can be displayed at any time:

m Yiew Project  Options  Tools
1 Click , Praoject

Eepart

or:

Select Analyser messages in the View menu: Fiefesh view Bligfar
| Fwreitle attbutes

The Analyser messages window for the last analysis opens.

2 Double-click any displayed message to view its origin.

8.5.1 Viewing the Analyse and Compile Report

Once you have analysed your scheme and compiled your [iew Project Options Tools
program code, you can view the report generated by ST-Realizer | Project

during the analysis and compilation process. This report provides
you with useful information such as the input and output Analyser messages
connections you made, and gives an overview of how much
memory is used by the application.

Refresh view Chrl+F
Invigible attributes

To see the report, on the View menu, click Report. An example of
an application report is shown on the following pages.

99/209

4




Viewing and Tracing Generated Messages Chapter 8

ST72212@& Realizing Unit (V4.00) (c) 1990-98 Actum Sol utions

Report file of project C \ProgramFil es\ST-Realizer\Exanpl es\ Heati ng\ heati ng. r pf
Scheme Version : 1.00

Report timestanp : Wed Apr 14 13:14:40 1999

Anal yze results : No errors

C.\ Program Fi | es\ ST-Real i zer\ Exanpl es\ Heat i ng\ heati ng. sch
Scheme: C:.\Program Fil es\ ST-Real i zer\ Exanpl es\ Heating\Filter. sch
Event: Tinmed interrupt 0.01 Sec.

ST72212& (DI L28) connection overview.

Pin Name Alternative nane Type |/0O Descri ption
1: RESET (BIT Input ), Active | ow
2 OsCin ( ), Gscillator In
3 OSCout ( ), Gscillator Qut
4. PB.7 SS (BIT Input ), Not connect ed
5: PB.6  SCK (BIT Input ), Not connect ed
6: PB.5 M SO (BIT Input ), Not connect ed
7 PB. 4  MOSI (BIT Input ), Not connect ed
8 PB.3  OCMP2_A (BIT Input ), Not connect ed
9 PB.2 | CAP2_A (BIT Input ), Not connect ed
10 PB.1 OCWP1_A (BIT Input ), Not connect ed
11 PB.0 Heatingl sON (BIT CQutput), Push- pul I out put
12 PC.5 Tenperature (UBYTE I nput ), 8 bit anal og i nput
13 PC. 4  Setpoint (UBYTE I nput ), 8 bit anal og i nput
14 PC.3 | CAP2_B (BIT Input ), Used by the application
15 PC.2  CLKOUT (BIT Input ), Not connect ed
16 PC.1 OCwW1_B (BIT Input ), Used by the application
17 PC.0 ICAP1_B (BIT Input ), Used by the application
18 PA. 7 (BIT Input ), Not connected
19 PA. 6 (BIT Input ), Not connected
20 PA. 5 (BIT Input ), Not connected
21 PA. 4 (BIT Input ), Not connected
22 PA. 3 (BIT Input ), Not connected
23 PA. 2 (BIT Input ), Not connected
24 PA. 1 (BIT Input ), Not connected
25: PA. O (BIT Input ), Not connect ed
26: TEST ( ), Test node pin
27: Vss ( ), Ground
28: vdd ( ), Power Supply
Har dwar e connecti ons:
Synmbol i ¢ nane H W naneDescri ption | Conment
HeatinglsON PB.O Push-pul | output | Pilot LED ON
Set poi nt PC.4 8 bit anal og i nput | Termperature in 1/10 degrees Cel sius
I

Tenperature PC. 5 8 bit anal og i nput Tenmperature (in 1/10 degrees Cel sius
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Regi st er connecti ons:

Symbol i ¢ nane H W naneDescri ption | Comment
ARCP TBOCLLRTi nmer B out put conpare 1 |ow re| PunpSpeedControl

Li st of all used peripherals:
TI MERB settings:

Prescal er value = 1/2

Qut put level 1 = Low

Qut put level 2 = High

Captl transition = Ri sing

Capt2 transition Fal I'i ng

Qut put Conpare 1 = Enabl ed

Qut put Conpare 2 Di sabl ed

Forced Qut put Conpare 1 = Disabl ed
Forced Qut put Conpare 2 = Disabl ed
Initialise conpare register 1 = 000H

Initialise conpare register 2 = 100H
PWM = Enabl ed
One Pul se Mbde = Disabl ed

Vari abl e overvi ew

Total used bits ;13
Total used events

Total used unsigned bytes

Total used signed bytes 0
Total used unsigned integers : 18
Total used signed integers : 3
Total used | ongs 0

Menory overvi ew.

Total used RAM : 63 byte (0080H, 0081H >00BEH)
Total used ROM : 892 byte (EOOOH >E37BH) of FFDFH
Note: Note that if you add up the RAM memory used in the variable overview and

compare it with the value shown in the memory overview, there is a disparity.
This is because the Total RAM includes memory for internal variables used by
ST-Realizer.
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8.6 Printing Reports

To print a report:

1 Display thereport.

2 Select File>Print in the main menu bar.

3 Continue the normal printing dialog and click OK when ready.
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9 SIMULATING YOUR APPLICATION

Once you have designed and analysed your application, you can use ST-Simulator to
simulate its behavior, generate and view input signals, monitor signals that are generated by
your application, and fine-tune it if necessary. The principal tasks involved in simulating an
application are:

» Creating a simulation environment file, which defines the environment in which you'll
simulate your application.

e Adding adjusters to your simulation environment file, which enable you to view and control
the value of the input signals to your application.

« Adding probes to your simulation environment file, which enable you to view the signals
that are generated by your application.

¢ Running the simulation.

You can also record the values generated by adjusters and read by probes while a simulation
is being run. ST-Realizer records this information in Log files. This information can be useful
for viewing the exact adjuster and probe values at any given time during the simulation.

This section explains how to perform these tasks.

9.1 Working with Simulation Environment Files

Each project you want to simulate must have its own simulation environment (. sef) file
before it can be simulated. A simulation environment file contains copies of the project
schemes with adjusters and probes added where required. You can save and reuse
simulation environment files as you can do with any other type of file.

9.1.1 Creating a New . sef File

The first step in simulating your application is to create an associated simulation file.
Simulation files are based on schemes, and are created by ST-Simulator.

To create a new simulation environment file:
1 If you arein ST-Realizer, make sure that the project you wish to simulate is open.

2 Click Simulator on the ST-Realizer Tools
menu. Al Aindow  Help

Sirmulator

Symbol Editor Cirl+F11

ST-Simulator will open in a separate window.

g
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3

In ST-Simulator, select the

File menu and click New. =
Open... Cirl+0C

Simulation emviranment. ..

Temt...

In the cascading menu that Elmce
appears, select Simulation Sl Giiflns
environment. SEyVE 85,

Sl

=it (=
Frinter setup...

Exit Alt+F4

The Create a file dialog
box opens, letting you

specify the name of your | 2avein | 3 Heating

Cresteanentie @K
HelslEE

new simulation Main. sef
environment (. sef) file.

File name:

Save as hype: I Erwironments [* zef]

Save I
j Cancel |

Type the name of the .sef file, (heating.sef, for example).

A pin level drawing of the target microcontroller appears
(such as shown at right). Note that where the pins have
been connected to application input/output functions, the
pin names have been replaced by the function names.

If you double-click on the pin level drawing, you will
open a copy of your root scheme diagram as another
window. You can also open subschemes by double-
clicking on the subscheme symbols.

You can use both the pin level drawing and the scheme
diagrams to help you run the simulation—both views are
useful in evaluating whether your application is running as
you wish.

To see all views at once, under the Window menu,
select Tile.
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Chapter 9 Working with Simulation Environment Files

You've now created a new simulation environment file for your application. Don’t forget to save
your work (see Section 9.1.3 below).

9.1.2 Opening an Existing . sef File

1 If you are already running ST-Realizer, open the IRl indow  Help
Simulator Window by clicking on Simulator on the (g — -
ST-Realizer Tools menu.

Sirmulator

Symbol Editor Cirl+F11

2 Once you are in ST-Simulator, select the File menu
and click Open.

The Open simulation environment dialog box opens:

Laak. in: I {3 Heating j ﬁl

hieating. zef

Main. zef

File narme: [| Open
Filez of type: IEnvirnnments [®.2ef] j Caricel

3 In the list, double-click the name of the . sef file (for example main.sef), then click
Open.

All of the simulation views contained in the . sef file will open (for example, the pin-level
drawing of the target microcontroller, and/or the project schemes). You are free to run or
modify the simulation at will.

9.1.3 Saving an .SEF File

You should save the modifications you made on a . sef file at regular intervals and, of course,
once you have finished all your work on the file. You may also make a duplicate of an existing
. sef file, under a different filename, if you wish to have several different simulation versions.

To save an . sef file:
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¢« On the File menu, click Save.

To make a duplicate of an existing . sef file:
1 Onthe File menu, click Save as.
The Save file as dialog box opens.
2 Browseto the folder in which you want to create the duplicate file.

3 Typethe new file name in the File name field, then click OK.

Note: You may save your file as a .WMF (Windows Meta File)-type file. This will
enable you to export the drawing to any word processing or publishing project
file that accepts this format.

9.2 Setting, Adjusting and Viewing Input Values

When you simulate an application, you can set, adjust and view the values input to the
application. This enables you to experiment with and fine-tune your application.

To be able to set, adjust and view input values and types, you connect adjusters to the
appropriate pins and wires in the pin-level and scheme views of your application. ST-Realizer
lets you set four types of adjusters:

« Numeric Adjusters, which display and let you adjust variable values numerically, in
binary, decimal, hexadecimal or octal format

e Sine Wave Adjusters, which generate and let you define analog sine wave signals. They
let you adjust the wave depth and frequency.

e« Square Wave Adjusters, which generate and let you define analog square wave signals.
They let you adjust the wave depth, frequency, and duty cycle. The duty cycle is the
percentage of the period in which the signal is at its top value.

« Time Table Adjusters, which let you adjust the value of a variable at specified time
intervals.

The following paragraphs describe how to attach adjusters to pins and wires, and how to set
the appropriate input values.

Note: 1. You can only attach one adjuster to each pin or wire.
2. Clicking any object in the schematic causes information on this object to be
displayed in the status bar.

Changing Adjuster or Probe Attributes

4
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If you right-click any type of adjuster or probe (probes are described in Inorease size
Section 9.3 on page 115), a popup menu will open that looks similar to that 'ge.:,ease s
at right:

Properties. ..

From this menu you may increase or decrease the size of the adjuster by
selecting Increase size or Decrease size.

9.2.4  Setting Fixed Input Values

To set a fixed analog or binary input value, you must attach a Numeric Adjuster to the
appropriate input pin or wire. Numeric Adjusters let you set the value input by the pin or wire
to which it is attached, as well as change the number base that the value is displayed in.

To attach a Numeric Adjuster to a pin or wire:

1 Select the pin or wire to which you want to attach the Numeric Adjuster by clicking
on it.
The pin or wire you choose should be an input pin or wire. For example, select the pins on
the pin-level drawing that you have attached to input symbols in your scheme (refer to
“Connecting Input/Output Symbols to Microcontroller Pins, Ports and Peripherals” on
page 46).

Note: A numeric adjuster has the same type as the pin or wire it is attached to.

10|
2 Click .

3 Click where you want the Numeric
Adjuster to appear.

The adjuster is now placed in your
scheme and connected to the pin or wire
you selected. In the example at right, we
see that the numeric adjuster has been
connected to the pin called “Setpoint”,
which is also the name of the input

Setpoint

symbol. Note that the numeric adjuster -

shows the name of the pin whose input L& <[>[>
the adjuster controls. e IEEFILE

OCMP1_B

CLEOUT

4 Set the value input to the pin or wire.
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If the pin or wire input is analog, you can change its value
by either:

e Clicking the displayed value in the Numeric Adjuster Change the value
and entering a new value in the Change numeric |m
value dialog box, shown at right.

« Clicking the <<, <, > or >> buttons on the Numeric ok | Ccancel |
Adjuster:
Numeric Adjuster Button Action
< Decreases the input value by the fast step increment value (see
below).

< Decreases the input value by the step increment (see below).
> Increases the input value by the step increment.
>> Increases the input value by the fast step increment value.

e If the pin or wire input is binary, you can change its value by clicking the displayed
value in the Numeric Adjuster icon. The value toggles between 0 and 1.

o Tip: You may also open the Change numeric value dialog Value
— — box to change the value of the numeric adjuster (as -
= shown above), by right-clicking the adjuster and Increaze size
) selecting Value from the popup menu at right. Decrease size
Properties. ..
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If you select the Properties option in the popup menu, a large dialog box will open, entitled
Change numeric adjuster. From this dialog box, you can several numeric adjuster options,
described in Table 2.

B Change numeric adjuster |

Riadix I Decimal j
Walue | ]
Step | 1
Step fast | 10
WV Extended
Cancel |
Table 2 Changing Numeric Adjuster Options
Option Action

Change the number base in which the value is set | Select the appropriate button in the Radix box.
and displayed.

Change the current value of the attached pin or wire. | Enter the new value in the Value field.

Change the increment value of the < and > buttons. | Enter the new value in the Step field.

Change the increment value of the << and >> Enter the new value in the Step fast field.
buttons
Hide or display the <, >, << and >> buttons. Click the Extended check box. When this box is

checked, the buttons are displayed.

g
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9.2.5 Setting Variable Input Values

To set variable analog or binary input values, attach a Time Table Adjuster to the appropriate
input pin or wire. The Time Table Adjuster lets you set an input value that changes at specified
time periods. Once you have placed a Time Table Adjuster, you can either import data from an
ASCII text file or enter the data directly into the Time Table Adjuster. The following diagram
shows the format of Time Table Adjuster-compatible ASCII files:

ASCII File Contents: Table Values:

5,100 -

25000.150 firne output

’ 1] 00:00: 00, 0000 1]

600000,75
1 0000 00, 0005 100
2 0000 07 5000 150
3 00:07 ;00,0000 Fis)

You can store decimal, binary, hexadecimal or octal information in Time Table Adjusters.
To attach a Time Table Adjuster to a pin or wire:

1 Select the pin or wire to which you want to connect the adjuster by clicking on it.

2 Click E

3 Click where you want the adjuster
to appear.

The adjuster is now placed in your
scheme and connected to the pin or wire
you selected. In the example at right, we
see that the time table adjuster has been
connected to the pin called “Setpoint”,
which is also the name of the input A
symbol. Note that the time table adjuster Heating|sON

shows the name of the pin whose input Temperature \cARY_B
the adjuster controls. —_— OCMP1_B

ICAPZ_B CLEQUT

4
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4 To set the table of values to be input to the pin or wire:
e Double-click the time table adjuster,

Increaze size

or, i
Decrease zize

* Right-click the time table adjuster, and select Properties in the

Properties. ..
popup menu.

The Change time table adjuster dialog box opens, showing a table with one row, and two
columns—the first for the time, and the second for the input value. From this dialog box,
you can either import them from an ASCII file or enter the table values directly (see Table
3 for instructions).

[ Change time table adjuster |

imne: output |
1] (0: 00 0. 0000 0.000
Impart.. | (] I Cancel
Table 3 Entering and Editing Time Table Values

To change the value of a table cell.

Double-click the entry you want to change, then edit its
value in the Change value dialog box.

To Insert a new table row of cells.

Press the Insert key on your keyboard, then enter the
new time and value.

Import values from an existing file.

Click Import, and choose the file you want to import.

Note: The smallest possible time interval between two entries in the table is 0.0001
seconds. However, make certain that the smallest possible interval that you
enter is superior to the value of the base clock timer tick (refer to page 95).

4
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A ‘ / Tip: Note, in the example shown below, that in addition to being able to view the
— — table of values at left, you can also see a graphical representation of the time-
s output values in the right-hand area of the dialog box. When you select one of
; the values in the table, the point in the graph corresponding to the value pair to
which the selected value belongs, will turn red.
B Change time table adjuster |
time oLtpLt |
1] (00 00 00, 0000 0
1 00: 00 00, 0000 0
2 00 0 Q0. 0000 o
3 0. 00020000 10
4 000004, 0000 0
5 (0C: 00: 06, 000 20 .
b (00 00: 08, 0000

Impart... | ] I Cancel

9.2.6  Setting Sinusoidal Input Signals

If you wish to the input signal to vary sinusoidally, you must attach a Sine Wave Adjuster to
the appropriate input pin or wire. Sine Wave Adjusters let you set the signal amplitude and
frequency that is input to the pin or wire.

Note: You can only attach Sine Wave Adjusters to wires or pins with analog input.

To attach a Sine Wave Adjuster to a pin or wire:

1 Select the pin or wire to which you want to connect the adjuster by clicking on it.

4
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2 Click

3 Click where you want the adjuster
to appear.

The adjuster is now placed in your
scheme and connected to the pin or wire
you selected. In the example at right, we
see that the sine wave adjuster has
been connected to the pin called
“Setpoint”, which is also the name of the
input symbol. Note that the sine wave
adjuster shows the name of the pin | IcAP1_B
whose input the adjuster controls. L BN

CLEOUT

Heatingls M

4 Set the signal amplitude and
frequency by:
« Double-clicking the adjuster,

or, Increaze size
* Right-clicking on the adjuster and selecting Properties Decrease size
from the popup menu (shown at right). Fropeties...
The Change sine wave adjuster dialog box opens:
B Change sine wave adjuster |

B ottom I Q
Taop I EE535

Frequency | 1.000000  Ha.

Cancel |

g
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5 Fillinthevalues that will define the amplitude and frequency of the sine wave input:

« To set the bottom range of the wave amplitude, edit the value in the Bottom field
« To set the top range of the wave amplitude, edit the value in the Top field.
» To set the wave frequency, edit the value in the Frequency field.

6 Click OK.

9.2.7 Setting Square Wave Input Signals

To set a square wave input signal, you must attach a Square Wave Adjuster to the
appropriate input pin or wire. Square Wave Adjusters let you set the signal amplitude, duty
cycle and frequency.

To attach a Square Wave Adjuster to a pin or wire:

1 Select the pin or wire to which you want to connect the adjuster by clicking on it.

2 Click

3 Click where you want the adjuster to
appear.

The adjuster is now placed in your
scheme and connected to the pin or wire
you selected. In the example at right, we
see that the square wave adjuster has
been connected to the pin called
“Setpoint”, which is also the name of the
input symbol. Note that the square wave
adjuster shows the name of the pin

PAG

—| eatingls QN PAT

whose input the adjuster controls.
4 Set the signal amplitude, duty cycle | Tempersture ICAR1_B
and frequency by: N Setpoint DCMF1_B
* Double-clicking the adjuster, CAP_B CLKouT
or, :
Increaze size
* Right-clicking on the adjuster and selecting Properties Decrease size
from the popup menu (shown at right). Fropetics..
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The Change square wave adjuster dialog box opens:

[ Change square wave adjuster |

Battom | i
Top | B8535
Frequency 1.000000  He.

Dty cycle I BO.000000 - %

Cancel |

5 To setthe bottom range of the wave amplitude, edit the value in the Bottom field

To set the top range of the wave amplitude, edit the value in the Top field.
To set the wave frequency, edit the value in the Frequency field.

To set the duty cycle, that is the percentage of time that the signal is at its top value, edit
the value in the Duty cycle field.

6 Click OK.

9.3 Monitoring Signals with Probes

When you simulate an application, you can monitor the signals it generates using probes. This
enables you to experiment with and fine-tune your application.

You connect probes to any wire, pin or symbol whose signals or states you want to monitor.
ST-Realizer lets you connect four types of probes:

* Numeric Probes, which let you view the current signal value of the pin or wire in the
Binary, Decimal, Hexadecimal and Octal number bases.

* Oscilloscope Probes, which let you view the signal value of the pin or wire as a graph.

e State Machine Probes, that let you view the value (i.e. current state) of the initial state
symbol in a state machine.

The following paragraphs describe how to use probes.
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9.3.8 Viewing Signal Values Numerically

To view signal values in numeric form, you must attach a Numeric Probe to the appropriate
wire or symbol. Numeric Probes let you view the current value of the wire or symbol’s signal,
in the Binary, Decimal, Hexadecimal or Octal number bases. While the simulation is running,
the value that Numeric Probe displays will vary with the changing signal in the wire or symbol.

To attach a Numeric Probe:

1 Select the pin or wire to which you want to connect the probe by clicking on it.

0]
2 Click

3 Click where you want the probe to appear.

The probe is now placed in your pin-level drawing or scheme and connected to the pin or
wire that you selected.

In the example below, we see that the numeric probe has been connected to the a wire in a
scheme. Because this wire is an input to a symbol and the symbol pin to which it is connected
is called “ARCP”, this is also the name of the signal that the numeric probe is measuring.
Because of this, the numeric probe also displays the signal name, “ARCP”.

o

- s 255 |
= |ﬁ
—1g a

Caontrolling the Fump Speed

ARCP

PumpEnabIe-:I>——En
FumpSpeedContral

To select the displayed number base: i .
INCrease szZe

1 Double-click the probe, or right-click the probe and select Decrease size
Properties from the popup menu (shown at right). Properties. .
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The Change numeric probe dialog box opens:

B Change numeric probe |

Fiadix Decimal j
Binar

Hexadecimal
Oetal

1] I Cancel

2 Selectthe appropriate number base from the drop-down list, and click OK.

9.3.9 Viewing Signal Values Graphically

To view variable values in graphic form, you must attach an Oscilloscope Probe to the
appropriate pin or wire. Oscilloscope Probes let you view the value of the pin or wire as a
graph. You can also adjust the top and bottom levels of the Y-axis of the displayed graph, and
the time scale within which the value is displayed.

To attach an Oscilloscope Probe:

1 Select the pin or wire to which you want to attach the probe by clicking on it

2 Click

3 Click where you want the probe to appear.

The probe is now placed in your pin-level drawing or scheme and connected to the pin or
wire that you selected.

g
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In the example at right, we see that the
oscilloscope probe has been connected
to the an output pin, called OCMP1_B,
in the pin-level drawing. Note that the
oscilloscope probe also shows the
name of the pin whose output signal the
probe is monitoring.

QOChP1_B

HeatinglsOM

Temperaturs

To change the Y-axis, time scale, and time mode of the displayed

graph:

1 Double-click the probe, or right-click the probe and select
Properties from the popup menu (shown at right).
The Change oscilloscope probe dialog box will open. From this dialog box, you can set
options that will control the way in which the signal is displayed. Table 4 explains the
various options available in the dialog box.

[ Change ozcilloscope probe |

Increaze size
Decrease zize

Properties. ..

-amiz OCKP1_B Channel 2
Top | 5.000 |

Battom | T |

Time

Begin at 00:00:00.0000 - hbk:mm: zz.ms
End at 00:00:00.0010  hbk:mm:zz.ms

Mode I Trigger - I
Trigaer on a IHising edge vI when the value equals | ]

Cancel |

[Eelete | Sinam

4
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Table 4

Adjusting the Oscilloscope Probe Output

To change the maximum displayed
Y-axis value:

Enter the new top Y-axis value in the Top field.

To change the minimum displayed
Y-axis value:

Enter the new bottom Y-axis value in the Bottom field.

To change the time at which the
signal display will start (i.e. the
beginning of the X-axis):

Enter the new time in the Begin at field.

To change the time at which the
signal display will end (i.e. the end
of the

X-axis):

Enter the new time in the End at field.

To set the display mode:

The Oscilloscope can display in three modes:

« Single scan mode - The signal is displayed from the
Begin at X-value until the End at X-value, and then the
display picture is frozen.

» Trigger mode - The signal is continuously displayed such
that each time a rising edge, falling edge or a specified
value is detected by the probe, the displayed signal
restarts at the graph’s origin.

* Wrap around mode - The signal is continuously
displayed such that once the X value (time) equals the
End at value (or multiple of), the displayed signal restarts
at the graph’s origin.

To add another signal to the second
channel:

Right-click on the
oscilloscope probe in the
simulation view. A popup
menu will appear as at right.
Select Add/Replace
channel 2, and select a
second signal (either a wire
or a pin) for the second
channel.

The oscilloscope probe will now display two signals—one
from each channel.

&dd/Replace channel 2

Increase zize
Decreaze zize

Irtarmatiorn. .
Froperties. ..

4
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9.3.10 Viewing State Machine States

You can view the states of a state machine by attaching a State Machine Probe to the initial
state machine symbol. You can choose to see either the current state only or the current state
and a set number of previous states.

To attach a State Machine Probe to a state machine:

1 Select the initial state symbol to which you want to attach the probe by clicking on
it.

Note: You may only attach State Machine probes to initial state symbols in scheme-
views of the simulation. State Machine probes cannot be connected to pins,
wires or any symbol other than stateinit.

2 Click %?

3 Click where you want the probe to appear.

The probe is now placed in the scheme and
connected to the state machine you selected. .
In the example shown at right, the state machine &

probe is connected to a stateinit symbol in a state SetupTime

machine diagram. The symbol name is called Init, |
hence the name of the probe is also Init. The value of |
the probe corresponds to the value of the state which
is currently active (in our example, the active state is
called HeatingOFF).

: : : . Heatin OFFJ
To enable/disable the state history list and set its [ g
length:
1 Double-click the probe, or right-click the probe Incraase sizs
and select Properties from the popup menu (shown at right). 'QE,:,EE,SE o
Properties. ..

4
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The Change state machine probe dialog box opens:

B Change state machine probe

[ Shaow a history list of 5 items

EET Carcel

...............................

To change the length of the history list, enter a new length in the Show a history list of
field.

2 Click OK.

9.4 Selecting Adjusters and Probes

Instead of using the buttons in the tool bar, you
may select any adjuster or probe via the Object
menu. Just click Adjuster, or Probe, and select =oECId Mumeric.

the appropriate object. Probe  »  Sinewave..

(W=l Simulate  Options  Windo

Time takle...

9.5 Running the Simulator

When you run the simulator, the adjusters you placed generate the input values, your
application performs its processing, and where appropriate, the results are displayed by the
probes you placed.

While the simulator is running, the simulation time is displayed in the status bar at the bottom
of the screen.

4
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9.5.11 Starting/Stopping the Simulation

You can initialize, start, or stop the simulation process and proceed to the recording or
displaying of information about this process:

If you have already run the simulator, and you want to initialize
it to its original state:

Click m

, Or:

In the Simulate menu;

ElgUEECE Ootions Winde

To initialize the simulator: click Initialize:
Initialise Ctrl+F11
Start F11
Eause =2
Becord Ctrl+F12
Information

To run the simulator: Click } , or:

In the Simulate menu; click Start.

To temporarily stop your Click ] | or:

simulation:
In the Simulate menu; click Pause.
1 Open a .log file (see “Recording and Reusing Adjuster and
Probe Values” on page 124)
2 Under the Simulate menu, click Record, or
To record simulation information: click &

3 The red circle changes to a red square:

To display information about the Under the Simulate menu, click Information.
current simulation session:

9.5.12 Setting Run Options
Before you run your simulation, you should consider which run options you want to set.
The run options are:

« Whether you want to run the simulation continuously, for a set number of loops, or for a
set time period.
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When continuous simulation is chosen, you stop the application when you want. Periodic
adjusters such as square wave adjusters and sine wave adjusters are particularly
adapted to this mode.

When a set number of loops is chosen, you can execute one loop at a time. Note that in
this case a loop time is the time needed to execute all the macro-instructions and not the
tick which is the time base used by ST-Realizer.

* Whether you want to use your PC's clock or the microcontroller clock for the simulation.
Note that if you use the PC's clock, the sampling time is the end of the execution loop. The
corresponding absolute time is recalculated using the PC's clock. This mode is much
faster to run since the number of sampled points is lower, however the lower sampling
frequency causes a loss of precision.

To set these options:
Options ATl

1 Onthe Options menu, click Simulate.

aimulate. ..

Ervironment...

The Simulating daughter dialog box opens:
B Simulate options |
;"é‘i;aaiaﬁ'ﬁgg[ Logging ]

Simulation mode Ipin el j
Running mode I Cortinuous j
Timing mode ITarget time j

¥ Enable accurate simulation
Enabling thiz option will result in a more accurate, but lower, pin level simulation

] Cancel

g
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Table 5 Changing the Simulating options

There are two simulation modes available:

* Pin level - This is the default setting. A pin-level drawing of
the simulation will be available, as well as all of the
application schemes.

* Functional - Only the scheme-views of the application will
be available.

To change the Simulation mode:

There are three running modes available:

« Continuous - The simulation will run continuously until you
stop or pause manually.

* Limited loops - You can enter the number of loops

To change the Running mode: (processing cycles) you wish the simulation to run for in the
Stop after field.

 Limited time - You can run the simulation for a specific
period of time by entering the amount of time in the Stop
after field.

There are two timing mode options:
» Use target time - This option uses the microcontroller clock

To change the Timing mode: to time the simulation.
» Use host time - This option uses the PC’s clock to time the
simulation.
Note: If you choose to use the microcontroller clock for the simulation, the simulation

time is controlled by the ST device, and a scaling effect takes place due to the
simulation process. This means that, for instance, the PC may need 10 seconds
to represent, say, 100 ms in the simulated application environment. This is the
most accurate way of simulating the ST device. If you choose to use your PC
clock for the simulation, a time of 10 seconds will take 10 seconds. This mode
is less accurate than the target time mode.

9.6 Recording and Reusing Adjuster and Probe Values

You can record the values generated by adjusters and read by probes while a simulation is
being run. ST-Realizer records this information in Log files. This information can be useful for
viewing the exact adjuster and probe values at any given time during the simulation. You can
view log file information by opening the log file in any word processor application.

4
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The format of log files is as follows:

These are the adjuster and probe names.

Time,Start,Voltage,Current,MaxCurrent,Charge time,Ready,BusyHigh,High,BusyLow,Low,Ready,Oscillator
5,1,9,10,100,0,Ready,0,0,0,0,0,0

9,1,9,10,100,0,High,0,1,0,1,0,0
15,1,9,10,100,0 ,Low,1,0,0,1,0,0

22.,1,9,10,100,3000,Low,0,1,1,0,0,0 These are the adjuster
and probe values that were
112 ,1,9,10,100,2999 ,Low,0,1,1,0,0,50 .
read each time a value
209,1,9,10,100,2998 ,Low,0,1,1,0,0,49 changed.

306,1,9,10,100,2997 ,Low,0,1,1,0,0,48

You can also reuse recorded adjuster values in subsequent simulations in order to recreate
identical conditions.

9.6.13 Recording Adjuster and Probe Values

1 Before running the simulation whose values you want to record, on the Options
menu click Simulate.

The Simulate Options dialog box opens.

2 Click the Logging tab.

4
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The Logging daughter dialog box opens.

B Simulate options I

Simulating | Lngging]
Enter a log file | Browse |

¥ Start logging with an empty file after an initialisation

Select a log file

[T Play back the log

Look i I 5 Heating

File name: Im_l,lnamel Open

Files of type: I Log files [* log) j Cancel

3 Type the name of the log file you want to create in the “start logging...” box, or
browse through the appropriate folder.

4 Click Open.
5 Run your simulation. The log file will be recorded while your simulation is running.
6 Once you have finished recording simulation information, close the log file by

clicking ™

9.6.14 Reusing Adjuster Values

Once you have recorded a log file, you can reuse the recorded adjuster values in subsequent
simulations:

In the Simulate Options dialog box:
1 Click the Logging tab.

The Logging daughter dialog box opens as shown on page 125.

4
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2 Typethe name of the log file you want to create in the “play back...” box, or browse
through the appropriate folder.

3 Click Open.

4 Run your simulation. The adjuster values recorded in the log file are input to your
simulation while it is running. Note that you can also manually change adjuster
values.

5 Once you have finished recording simulation information, close the log file by

clicking =™

4
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10 CREATING YOUR OWN SYMBOL

10.1 Overview

You create or edit your own symbols using ST-Symbol Editor. Creating a symbol involves the
following tasks:

e Creating a symbol shape.
« Placing pins that represent the variables that are input to and output from your symbol.
e Linking your symbol to the macro(s) it represents.

Once you've finished creating your symbol, you can create a customized library containing all
the symbols that you used in a project, including symbols that you created yourself.

The creation of new symbols falls into two categories:

e The creation of new subscheme symbols. These are the symbols that represent
subschemes in the root scheme. A number of subscheme symbols are included in the
main library, but you may find that you need to create your own because you require a
different number of input and output pins that available in those symbols provided.

* The creation of new user-defined symbols. This is a means by which you can design
your own symbol to perform a customized function. Note that creation of a new user-
defined symbol requires a sound understanding of how to program in assembler
code as it will be necessary to write the macros which define how your symbols
work.

The creation of both of these types of symbols is described in this chapter. In both cases, you
use the ST-Symbol Editor to create your symbol.

Note: The ST-Realizer online help system includes a tutorial which leads you through
the steps of creating an example symbol and its macros.

10.2 Running the ST Symbol Editor

To run ST-Symbol Editor from the ST-Realizer window:

1 Make sure you have a scheme loaded in the ST- IRl indow  Help
Realizer window B " =

Sirmulator F12
ovmbol Editor Cirl+F11

2 Onthe Tools menu, click Symbol Editor

or:

g
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Click the scheme area out of any symbol
with the right mouse button and select the
New 2>Symbol... menu sequence.

Attribute...

Wl=00
Leawe
The ST-Symbol Editor window opens. T
It automatically shows the symbol editor’s tool .
. Froperties...
bar and the Select the Symbol properties

dialog box:

You can now define either a new subscheme symbol or a new user-defined symbol.

10.3 Defining a New Subscheme Symbol

Subscheme symbols are, effectively, single-symbol representations of an entire subscheme,
that can be used to reference a subscheme from within another scheme. Some subscheme
symbols have already been defined in the ST-Realizer library, but you may find that you need
to create a subscheme with, say 3 inputs and only one output. We will use this example to help
explain how to easily create a new subscheme symbol.

1 Open the Symbol Editor.

[ Select the symbol properties |
Symbal name: |3333_1

—Select a symbaol;

* Sub scheme symbal
= User defined symbal

—Select a shape:

i+ Fectangle
™ Circle

MHumber of input ping: | 3
MHumber of output pins: | 1

< Bachk | Mest = Cancel

2 Givethe new subscheme symbol a name.

An “sssx_y” type name is recommended, to be consistent with standard subscheme
names that can be found in the main symbol library. An “sssx_y” subscheme has x
inputs and y outputs.
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3 Click the “Sub scheme symbol” radio button.
4 Select the shape you which to assign to the symbol.

The shape of the symbol can be either rectangular or circular.

Note: The shape of the symbol represents, but does not affect, the process that is
behind it. Symbol shapes should not cross the square box in the ST-Symbol
Editor window (this represents the physical limits of the symbol).

5 Specify the number of input and output pins.

A \ / Tip: All of the above options can be modified later, using the Symbol Editor.

R\l

6 Click the Next button.

A new dialog box opens where you specify labels for the subscheme input pins.

[ Select the input pin properties |

Fin 1: Label: IIn'I
Fin 2: Label: IIn2
Fin 3: Label: IIn3

¢ Back Mest =

Click Next when you've finished.

g
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A new dialog box opens where you specify labels for the subscheme output pins.

[ Select the output pin properties

Click Next when you've finished.
The Generate the symbol dialog box opens.

B Generate the symbol

Click Finish to generate the new symbol.

4
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The new subscheme symbol is automatically added to the local
symbol library for the project in which you are working. To save
_|n1 Ol.lﬂ | the symbol in a library accessible to all projects, follow the
instructions in Section 10.3.1.

"In2'5583 1 o
To place it in your scheme, click [l as explained on

—In3 .

page 39.

custom.sch In our example at left, the new subscheme symbol has 3 input

pins and one output pin. The associated subscheme is hamed

“custom.sch”, however, you may choose to leave this attribute field non-specific (by leaving
the “?” placed by default, for example).

10.3.1 Adding Your New Subscheme Symbol to a Library

In order to use your new subscheme symbol (or symbols, if you have created more than one)
in any ST-Realizer project, you must save it to a library file located in the <r oot
f ol der >\ Li b folder. To do this:

1 Open the project where you have created the new subscheme symbol(s). Open the
scheme where the new subscheme symbol is.

= £]
2 Open the local symbol library by clicking [ .

3 Create a new blank scheme in the project by selecting File2New 2>Scheme. Call it
any name you wish (for example, temporary.sch).

4 Using the local symbol library, select and place the new subscheme symbol(s) that
you wish to save to a library in the blank scheme.

5 Now you must edit the new subscheme symbol(s).

Right-click the new subscheme symbol and select Edit from the popup menu. The

symbol editor will open. Double click on the subscheme filename attribute at the

bottom of the symbol (i.e. in the above example, we gave the value “custom.sch” to

this attribute, but by default it is left as a “?").

At this point you have to make a choice, depending on how you wish the default

usage of the symbol to be:

* If you wish to leave the subscheme file generic, leave the “?” in the field. Every time
you use the symbol in the future, you will have to remember to fill in this attribute value,
specifying the filename of the subscheme (and it's path if it is not located in the project

folder). Alternatively, if you double-click the symbol (once placed in a project scheme),
you will be prompted to create a new subscheme.

g
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* If you always wish your new subscheme symbol to reference the same subscheme
file, enter the name of the subscheme file (for example, custom.sch) in this attribute
field with its correct path (i.e. the project folder in which the subscheme file will occur).

Note: Remember that if you enter a filename in this attribute field, the path by default

will be the path of the project in which you created/edited the subscheme
symbol.

To be able to access a particular subscheme from any project, we recommend that
you copy the subscheme file you have specified (for example, custom.sch) to the
<root folder>\Lib folder and, using the symbol editor, in the filename attribute
field enter path and filename of the subscheme as follows:

<root folder>\Lib\filenane.sch. For example, in order to use the
subscheme custom.sch in any project, we would place a copy of custom.sch in
<root folder>\Lib and using the symbol editor, enter

<root fol der>\Lib\custom sch in the subscheme filename attribute field.

Note: The exact <r oot f ol der > path depends on where you installed ST-Realizer

on your PC. By default, this path is C:\\Program Files\ST-Realizer\Lib\...

Exit the Symbol Editor, saving your changes.

Repeat the above steps for each new symbol you have included in the scheme.

6 While in the subscheme you created in Step 3 (i.e. temporary.sch), select
File>Save as.. from the main menu and save the file as a library file (.1ib
extension) in the library folder (<root fol der>\Lib). Give the new library a
suitable name—for example, my_synbol s. | i b. Your new subscheme symbols will
be stored in this library file, accessible to all projects.

A | / Tip: When you save a scheme as a library, you will copy all of the symbols in that

— — scheme to the library. Therefore, to save only new subscheme symbols you
- have created to a library, they need to be in a scheme by themselves.

7 Exit, without saving, the project in which you have created and modified you new

subscheme symbols. (If you save the project, all of the modifications you made to
your new subscheme symbols to apply to the project you performed them in.)

Now, each time you wish to use your subscheme symbol(s) in a new project, simply open the
library file you created and select and place the symbols as you would normally do from any
other symbol library.
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10.4 Defining a New User-Defined Symbol

You can use the symbol editor to create your own symbol, using the User-Defined symbol
option.

Note: Defining a new user-defined symbol will require programming ability in the
assembler language.

There are four steps in creating a new user-defined symbol:

* The definition of the graphic aspect of the symbol, including assigning the required
number of input and output pins, naming these pins and assigning pin data types and
attributes.

» Editing the new symbol to further refine its appearance.

e« The creation of an assembler macro header—essentially the declaration line of the
assembler code behind the symbol.

» Finally, writing the assembler macros that define the symbol’s function.

The above steps are general, and it is clear that detailed instruction on how to create a new
user-defined symbol will vary depending of the symbol function. It is not within the scope of
this document to give instruction on how to write assembler code, so in the steps that follow,
we will explain, using an example, how to define a new symbol.

The example we will show here is a stepper symbol—a symbol whose function will be to
increase an input value by a fixed increment upon detection of a second signal input signal.
The stepper symbol will output both the incremented value and its complement.

g
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10.4.1 Defining the New Symbol
1 Open the Symbol Editor.

= Select the symbol properties %] |

Symbaol name: |Stepper

—Select a symbaol;

™ Sub scheme symbal
% Jzer defined symbal

— Select a shape:

% Rectangle
™ Circle

Murber of input pins: I 2
Murnber of output ping: | 2

< Bask | M et = Cancel

2 Give the new symbol a name.

In our example, above, we have named our new symbol “Stepper”.
3 Click the “user-defined symbol” radio button.
4 Select the shape you which to assign to the symbol.

The shape of the symbol can be either rectangular or circular. For our example, we will
choose a rectangle shape.

Note: The shape of the symbol represents, but does not affect, the process that is
behind it. Symbol shapes should not cross the square box in the ST-Symbol
Editor window (this represents the physical limits of the symbol).

5 Specify the number of input and output pins.

For the stepper symbol, we require two inputs (one for the initial value to be incremented
and one for the clock that will control the frequency of the incremental steps), and two
outputs (one for the incremented value and the second for the complement of the
incremented value).
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N ‘ / Tip: All of the above options can be modified later, using the Symbol Editor.

Qi

6 Click the Next button.
7 A new dialog box opens for you to specify the input pin data types:

I Select the input pin properties

There are a number of data types to choose from: BIT, UBYTE, SBYTE, UINT, SINT,
LONG and WORD. In addition, you can specify a sub-type—either Input or Clock Input.
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Foraph1UansmHﬁngtMsvaMe Choose this data type:
range:

Oor1l Bit (BIT)
0to 255 Unsigned byte (UBYTE)
-128 to 127. Signed byte (SBYTE)
0 to 65535. Unsigned int (UINT)
-32768 to 32767. Signed int (SINT)
-2147483648 to 2147483647. Long (LONG)
Any values except BIT-type values Word (WORD)
Any No type

For a detailed description of data types and attributes, refer to Appendix A: “Variables and
Attributes” on page 167.

For our example, we will assign the following properties:
* Forinput pin 1, label = “Data” and type = WORD/Input.
* Forinput pin 2, label = “Clock” and type = BIT/Clock Input.

Click Next.

8 A dialog box opens for

you to Specify the [ Select the output pin properties |

output pin data types.

Choose data types for Pin 3: label:  [3 Twpe: Jgi7 = |Output =]
each of the output pins. Pin 4: label: NS Type: g7 > | [

In our example, the data
type we wish to assign
(Max1) doesn’t appear in
the  pull-down menu,
which only contains the
most common data types.

For the time being,
assign any data type,
for example:

» For output pin 3, < Back Mext > Cancel
label = “S” and
type = BIT/Output.

e For output pin 4, label = “NS” and type = BIT/Output.

We will modify the data types on page 142, once the symbol has been created. Click
Next.
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9 A new dialog box opens to prompt you for the code properties of the new symbol.

= Select the code properties |

ICODE macro name: |i5tepper

CODE macro name: IStepper
OCODE macro name: |

< Back | Hest = | Carcel

Use this dialog box to link your symbol to the macro(s) it represents.

You can link three macros to a symbol, each with a different execution time:

e Atinitialization.

* As part of the main loop.

* At the end of the main loop.

Macros that are linked to ST-Realizer symbols must have headings that are in a specific
format:

To link a macro that’s executed at initialization:

* In the ICODE macro name field, enter i<macroname> where <macroname> is the
name of the macro. For our example, the ICODE macro name is “iStepper”.

To link a macro that’s executed as part of the main loop:

* In the CODE macro name field, enter <macroname> where <macroname> is the
name of the macro. For our example, the CODE macro name is “Stepper”.

To link a macro that’s executed at the end of the main loop:

* In the OCODE macro name field, enter o<macroname> where <macroname> is the
name of the macro. For our example, we do not wish to generate an OCODE macro.

Note: Recall that names in ST-Realizer are case-sensitive.

Click Next to continue.
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10 The Generate the symbol dialog box opens. Click Finish to confirm.

B Generate the symbol % |

Creating uzer defined symbol Stepper
With & input pins
With & autput ping

Click Finizh to generate the zpmbol

< Back Finizh

The new symbol will appear in the scheme, similarly to our
example symbol shown at left. We can see our two 2 input
pins and two output pins.

The next step is to edit the symbol in order to give the pins
names that are more descriptive, to change the pin data
types if necessary, and to add some graphical detail to
better distinguish the symbol.

n
o

Data
~Clock NS

[N
[

10.4.2 Editing the New Symbol

Once you have generated the new symbol, it will appear as above in a symbol editor window
that is called by the name of the new symbol. In this environment, you can further edit the
visual appearance of the symbol, and refine its attributes.

4
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10.4.2.1 Accessing Editing options from the Symbol Editor window:

¢ In the scheme, right-click the symbol you wish to edit.

Hew b
The symbol editor popup menu will appear as at right,
allowing a number of options. Most of these options also HiE .
appear in a toolbar which floats in the symbol editor window. Edit design notes.
The figure below shows how you can use either the popup Create heading
menu or the toolbar to edit the symbol.
o edit d it Symbol editor bools
...to edit description, - — 5 Y
create heading... &R N ot

...to define a new attribute ... to define a new pin

Alnste. ..

: \ Bin...
Wi r
Rectangle...
Edit u:Ie!ign nates... Arc...
Create heading

...to draw a rectangle,
an ellipse...

10.4.2.2 Editing pin attributes:
1 Select the pin whose attributes you wish to modify.
2 Right-click the mouse with the pin selected.

A popup menu will appear as below.

Properties. ..

4
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3 Select Properties from the popup menu.

A Change properties dialog box, like the one shown below, will open.

[ Change properties Ed |
| nputAoutput IDUmUt vI

Type

Label |5

M urnber |3

Color - E dit |

ak I Cancel |

In our example, we will change the pin 4 (“S™) data type to MAX1 (this option takes the
data type of input pin 1. (The data types available in the cascading menu are the most
widely used, but they not the only data types available. For a complete list of data types,
refer to Appendix A: “Variables and Attributes” on page 167.)

Perform the same operation to the NS pin (pin 4), setting
the data type to Max1 as well. 1 Data S

[

When finished, your symbol should now look as pictured

at right. 2 Clock NS

10.4.2.3 Adding graphical detail to symbols

[

You can add simple graphics to symbols to help identify them. Basic drawing functions are
available from the popup menu or from the symbol editor toolbar (refer to page 141).

To draw an ellipse (or a circle):

1 Click |@| on the symbol editor toolbar, or select New 2Arc in the popup menu.

2 Click once where you want the centre of the ellipse to be.

3 Move the cursor in any direction. An ellipse shape appears that is based on the
relationship between where you clicked and the current cursor position.

4
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|, Tip: Note that the position of your cursor, in x and y coordinates, appears in the
— — status bar at the bottom left of the symbol editor window, whenever you are in
drawing mode.

Gl

4 Click when the ellipse is the size and shape you desire.

The ellipse is now drawn. The status bar displays the ellipse’s measurements.

To draw a rectangle:
1 Click ||:|| in the symbol editor toolbar, or select New=>Rectangle in the popup

menu.
2 Click where you wish to place the top left corner of the rectangle.

3 Move the cursor downwards and to the right. Click when the rectangle is the size
and shape you desire.

The rectangle is now drawn. The status bar displays the rectangle’s measurements.

To draw lines:

1 Click || in the main toolbar.

2 Click where you want the line to start.

3 Click where you want the line to end. You can continue drawing connected lines by
placing the cursor where you want the next line to end then clicking.

4 Right-click when you want to stop drawing connected lines.

Note: When you draw the cursor automatically snaps to an invisible grid. If you want
to change the spacing between the gridlines, on the Options-Environment
menu, click the Symbol tab, then specify the appropriate grid value.

Changing graphic properties:
1 Select the graphical object you wish to modify by clicking once on it.

2 Right-click the mouse. A popup menu appears with one options: Properties. Select
it.

4
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3 A dialog box entitled Change properties opens.

I Change properties 4 |

Width I a7 . i,
Height |1 0 . i,

Start at ||:|_|:| deqrees
End at ||:|_|:| deqrees

Line thickness W . i,
Colar - E.jitl

.......

] Cancel |

In this dialog box, you can change the dimensions of the graphic, the angle (if the graphic
is a line), the line thickness and color, and finally, you can choose to fill the graphic.

In our Stepper example, we are going to add a small

graphic to help identify the symbol: 1 '3
+ In the symbol editor window, select |@| from the —[Data o |
symbol editor toolbar, or select New 2Arc in the 2| > 4

e Using the ellipse drawing tool, draw the footsteps as
shown.

« Using Change properties dialog box, fill the four ellipses that make up the footsteps.
10.4.2.4 Symbol Information

L]
To change the text that describes the symbol (when you click the | 0 button) select Edit
design notes in the popup menu and enter the description you wish in the dialog box.

4
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10.4.3 Adding Pins to Your Symbol

The pins you place

on vyour symbol [RECEEENI |
represent the

variables that are Inputfoutput [l ]

input to and output Type nput

from the symbol Clock. input

you are defining. Label : y

To place a pin: Mumber [E

1 Click {Lﬁ in . -ﬂl
the symbol
editor toolbar,
or select
New-=Pin in

the popup Ok, I Cancel

menu.

The Create a pin dialog box opens.

2 The pin number is automatically generated and displayed in the Number field. This
is reflected in the structure of the arguments for the assembly macros. The pin
number sets the sequence of parameters.

3 Inthe Label field, enter a label for the pin. This corresponds to the variable name.

4 In the Input/output field, select the type of pin you want to place:

Pin Type Description

Input Normal input pin.

Clock input Input pin that can distinguish between a rising edge, a falling edge and a
plateau, by storing the previous input value and comparing it to the present
input value.

Output Normal output pin. There can only be one output pin on a net.

Passive output Passive output pin. An example of a passive output is a state. There can be
more than one passive output pin on a net.

g

145/209




Defining a New User-Defined Symbol Chapter 10

5 Inthe Type field, select the capacity of the pin you want to place:

For a pin transmitting

this value range: Choose this data type:

Oorl Bit (BIT)

0 to 255 Unsigned byte (UBYTE)
-128to0 127. Signed byte (SBYTE)

0 to 65535. Unsigned int (UINT)
-32768 to 32767. Signed int (SINT)
2147483648 to Long (LONG)
2147483647.

Any values except BIT- | Word (WORD)
type values

Any No type

6 If you want to change the pin color, click the Color box, then choose a new color
from the palette.

7 Click OK.

8 A rectangle now appears, representing the position of the pin. Note that it starts at
the left side of the symbol boundary.

If you want it to start at another side of the symbol boundary, click @ Each time
you click this button the pin moves anti-clockwise to the next boundary.

9 Move the cursor to the point of your symbol to which you want to connect the pin,
then click to place the pin.

10.4.4 Assigning Attributes to Your Symbol

Attributes allow you to attach extra characteristics to symbols. For example, attaching an
attribute of type DEVICE to a pin extends the macro that is linked with the symbol with
additional information. The available attribute types are listed in Appendix A: “Variables and
Attributes” on page 167.
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To assign an attribute:
1 Click @’ in the symbol editor toolbar, or select New 3Attribute popup menu.

The Create attribute dialog box opens.

B Create attribute Ei |

Calor Bl Edi | Tao
Size I 20 m.m. =T -

Slignment Walue

Harizankal | Center j Step Yalue LI

Wertical IEenter TI
Dhrection INDrmaI -.I

Visibilty kL _rl_l

[~ Tag v Walue
ak. I Cancel |

2 Inthe Tag field, select an attribute tag from the drop-down list.

For example, for our Stepper symbol, we’'d like to add some text. Select the TXT tag from
the cascading menu.

3 Inthe Value field, enter the tag value.
For our Stepper symbol, we'd like to enter the text “Step Value”.

4 If you want the tag or the value to be hidden, click the appropriate check box in the
Visibility box.

When the boxes are checked, the tag or values are visible. Hidden tags and values can
be made visible by choosing View 2Invisible attributes from the main menu.

For our Stepper symbol, we only wish to view the text, and therefore only check the Value
box.

5 To change the attribute color, click the Color field and choose a new color.
6 To change the attribute size, edit the value in the Size field.

7 If you want to change the vertical and horizontal alignment, select the Alignment
type from in the Vertical and Horizontal drop-down lists.
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8 Click OK when you have finished defining the attribute.

9 The cursor becomes a ghost box indicating the size of the attribute. Position the
cursor over the part of the symbol to which you want to attach the attribute and click
once. Click again to return to normal editing mode.

o Tip: Note that the attachment point—the item to which the attribute is attached—
— — appears as red spot in the symbol.

Rl

Our Stepper symbol should now appear as at right.

3

TData g Sr

2 o 4

—Clock NS—
Step Value

Our Stepper symbol still lacks an essential attribute: the value of the amount to increment
the data input signal - the Step Value. For the moment, we have only added text to the
symbol—this has no impact on the actual function of the symbol. To add provide a
numerical step value to the macro, we need create another attribute:

e Click @’ in the symbol editor toolbar, or select New >Attribute popup menu.

The Create attribute dialog box opens.

[ Create attribute E3 |

Color - Editl Tag
Size I 2.0 m.rm. I\-’.-’-‘-.LLIE VI

Aligrment Yalue

Horizontal I Center j 7 ;I
ertical I Center ™ I

Diirection I Maomal = I

YWizibility ] _.|_I

ak I Cancel |

r T a_r_i: v Walue

* Inthe Tag drop-down list, select Value.
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* Inthe Value field, type “?1". This is the default value for the attribute.

* Under Visibility, check the Value box only.
» Click OK when you have finished defining the attribute.

e The cursor becomes a ghost box indicating the

size of the attribute. Position the cursor just 1 S 3
beside the text “Step Value” and click once. Click — Dala  gqmp
again to return to normal editing mode. 2 o 4
i ‘Clock
Our Stepper symbol should now appear as at right. Step Value 71

10.4.5 Modifying Existing Attributes

You can change the properties of an attribute you have already created while still in the

symbol editor:

1 Select the attribute by clicking on it.

For example, in our Stepper example, we would like to remove the pin numbers. Select

the pin number “1” by clicking on it.

W

Rotate

Tag..
Walue, .
Fuaint of Effect

o

Step Value

g3

B

NS

?1

2 Right-click the mouse. A popup menu appears, as shown above. Select Properties.

4
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A Change properties dialog box appears.

[ Change properties Ed |

Cilor - Editl Tag
Size | 1.6 | m.m. |1¢ vI

Aligrment Yalue
Harizantal I Right j 1 ;I
Wertical I Battam ™ I

Diirection I Mamal = I

Visibilty & _>|_I
[ Tag v Walue
Cancel |

Under Visibility, uncheck the Value box. Click OK.

The pin number will disappear from the symbol.

In a similar manner, make all of the pin numbers —Data o®
disappear from the symbol. Our stepper symbol will now o
appear as at right. IClock

Step Value

NSH

1

NIV Tip: You can make attributes invisible, as

— — we just did for the pin numbers, but they are still present in the symbol. To view
invisible attributes, select View 2Invisible attributes from the main menu or

o\

from the popup menu.

Note: You may also change existing symbol attributes directly from the ST-Realizer
worksheet where your scheme has been loaded. See “Changing a Symbol’s

Attributes” on page 41.

Recall from page 135 that there are four steps to complete the creation of a new user-defined
symbol. We have now completed the first two steps in the creation of our Stepper symbol:

* The definition of the graphic aspect of the symbol, including assigning the required
number of input and output pins, naming these pins and assigning pin data types and

attributes.

» Editing the new symbol to further refine its appearance.
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The next step is to create a macro header for the symbol, and then write, in assembler, the
macros that will define how the symbol functions.

10.4.6 Creating the Macro Header

In the symbol editor popup menu, select Create

. Mew »
heading.

Rl=00 »

The macro header for the new symbol is copied to the
clipboard.

For our example symbol, Stepper, we generated two
macro headers—iStepper and Stepper. iStepper looks
like:

i st epper wobww macro Dat a, t Dat a, Cl ock, nCl ock, t Cl ock, pCl ock, pnCl ock, pt C ock, S,tS, NS, t NS, c5

Description: Initialize Wrd STEPPER

B R S R R
’

In the iStepper macro, the “wbbww” after the “istepper” is a listing of the inputs and outputs—
word (the Data input pin), clock input bit (the Clock input pin) and the two output pins (S and
NS) are both word types because they were programmed to take the maximum valued input
pin type (i.e. the word type). (See Naming Macro Instructions below for more information on
the abbreviations used for data types.)

Once the macro header has been copied to the clipboard, create a new ASCII text file (using
an ASCII text editor) and paste the macro header into the text file.

10.4.7 Creating the New User-Defined Symbol Macro

Once the macro header has been pasted into an ASCII text file, the next step is to write the
rest of the macro for the new symbol. Writing macros requires a knowledge of the assembler
programming language, and it is now within the scope of this document to instruct the user
how to write assembler code. We will simply give some general guidelines to follow, and show
how the assembler macro for the our example symbol, Stepper, was created.

General Rules

When you create your own macros for inclusion in ST-Realizer applications, you must follow
the rules described below.

« Symbols using multi-type pins require two macros: one for the BIT type and one for the
WORD type. Symbols only using BIT type pins require one macro call.

* The macro instructions are written in assembly language using any plain ASCII text editor.
Remember to save the ASCII file as a . mac file (for ST6) or as an . i nc file (for ST7). For
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example, we could save our Stepper symbol as st epper. i nc.

Naming Macro Instructions
The names of macro instructions are a concatenation of the following:

* The attribute value.

* The type of the input/output variable ranked by the pin number.
The type of the input output variable uses the following convention:
w for a WORD type
b for a BIT type
bb for a BIT clock input
ww for a WORD clock input

For example, a symbol that has two input pins, one which is BIT type and the other
WORD type, and one output pin of WORD type and with the attribute CODE=Stepper,
has the macro name: Stepperbww.

Parameters

The macro name is followed by the macro parameters. A parameter set is used for each
variable according to the signal type and function.

BIT type input and output pins have the parameters: variable name, bit number, variable type,
where bit number is the position of the bit within a byte.

WORD type input and output pins have the parameters: variable name, variable type.

BIT type clock input pins have three parameters for the current clock variable: variable, bit
number, variable type and three parameters for the previous clock variable: variable, bit
number, variable type.

WORD type clock input pins have two parameters for the current clock variable: variable
name, variable type and two parameters for the previous clock variable: variable name,
variable type, where current and previous refer to the loop.

The parameter sets are ranked by the pin number.

10.4.8 Writing the Assembly Macro

Macro headers are created as requested on page 139. For our Stepper symbol, we requested
an initialization macro header, called iStepper, and a main code macro header, simply called
Stepper. These macro headers enumerate the parameter list for each portion of the code:

» for the initialization portion of the code, the parameter list is: Data, tData, Clock, nClock,
tClock, pClock, pnClock, ptClock, S, tS, NS, tNS and c5.
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» for the main portion of the code, the parameter list is: Data, tData,Clock, nClock, tClock,
pClock, pnClock, ptClock, S, tS, NS, tNS and c5.

The final macro calls (i.e the contents of the ASCII file st epper . i nc) will look like this:

B R R R ]

; i st epper wobww macro Dat a, t Dat a, Cl ock, nCl ock, t Cl ock, pd ock, pnd ock, pt G ock, S,tS, NS, t NS, c5

; Description: Initialize Wrd STEPPER

B R TR
’

i st epwbbww macro Data, t Dat a, Cl ock, nd ock, t d ock, pCl ock, pnCl ock, pt Cl ock, S,tS, NS, t NS, c5
#if {tNS}
Id A #0FFH
#if {{tNS eq TUBYTE} or {tNS eq TSBYTE}}
Id NS, A
#endi f
#if {{tNS eq TUNT} or {tNS eq TSINT}}
Id NS, A
Id {NS+1}, A
#endi f
#if {tNS eq TLONG
Id NS, A
Id {NS+1}, A
Id {NS+2}, A
Id {NS+3}, A
#endi f
#endi f
mend

B R S R R R R

; st epper wobww macro Dat a, t Dat a, Cl ock, nCl ock, t d ock, pCl ock, pnCl ock, pt d ock, S, tS, NS, t NS, c5

; Descri ption: WORD st epper

B R R R TR
’

st epwbbww macr o Dat a, t Dat a, A ock, nCl ock, t Cl ock, pCl ock, pnCl ock, pt Cl ock, S, t S, NS, t NS, c5
| ocal [|abnr

;test rising edge on the d ock input
bittjf C ock, nCl ock, E& abnr
bittjt pd ock, pnCl ock, E& abnr

;addition of 2 bytes
#if {tS}
#i f {tData eq TCONST}
Id A #{l ow {Dat a}}
#endi f
#if {{tData eq TUBYTE} or {tData eq TSBYTE}}
Id A Data
#endi f
#if {{tData eq TU NT} or {tData eq TSI NT}}
Id A {Data+l1}
#endi f
#if {tData eq TLONG
Id A {Datat+3}
#endi f

;#if {tin2 eq TOONST}
add A #{low {c5}}
s #endi f
#endi f

#if {{tS eq TUBYTE} or {tS eq TSBYTE}}
Id S, A

#endi f

#if {{tS eq TUNT} or {tS eq TSINT}}
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Id {S+1}, A
#endi f
#if {tS eq TLONG
Id {S+3}, A
#endi f

#if {{tS eq TUNT} or {tS eq TSINT} or {tS eq TLONG}}
#i f {tData eq TCONST}
Id A #{low {{Data} shr 8}}
#endi f
#if {tData eq TUBYTE}
clr A
#endi f
#if {tData eq TSBYTE}
clr A
push CC
bittjf Data, 7, A& abnr
cpl A
A&l abnr :
pop CC
#endi f
#if {{tData eq TU NT} or {tData eq TSI NT}}
Id A Data
#endi f
#if {tData eq TLONG
Id A {Data+2}
#endi f

;#if {tin2 eq TCONST}
adc A #{low {{c5} shr 8}}
s #endi f
#endi f

#if {{tS eq TUNT} or {tS eq TSINT}}
Id S A

#endi f

#if {tS eq TLONG
Id {S+2},A

#endi f

#if {tS eq TLONG

#i f {tData eq TCONST}
Id A #{low {{Data} shr 16}}

#endi f

#if {{tData eq TUBYTE} or {tData eq TUI NT}}
clr A

#endi f

#if {{tData eq TSBYTE} or {tData eq TSI NT}}
clr A
push CC
bittjf Data, 7, D& abnr
cpl A

D&l abnr :

pop CC

#endi f

#if {tData eq TLONG
Id A {Data+l1}

#endi f

y#if {tin2 eq TCONST}
adc A #{low {{c5} shr 16}}
s #endi f

Id {S+1}, A

#i f {tData eq TCONST}
Id A #{l ow {{Data} shr 24}}

#endi f

#if {{tData eq TUBYTE} or {tData eq TUI NT}}
clr A
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#endi f

#if {{tData eq TSBYTE} or {tData eq TSI NT}}
clr A
push CC
bittjf Data, 7, G& abnr
cpl A

G&l abnr:

pop CC

#endi f

#if {tData eq TLONG
Id A Data

#endi f

;#if {tin2 eq TCONST}
adc A #{low {{c5} shr 24}}
s #endi f

Id S, A

#endi f

#i f {t NS}
copyww S, t S, NS, t NS
comwv NS, t NS

#endi f

E&l abnr
mend

10.4.9 Adding New User-Defined Symbols to a Library
You can save your new user-defined symbol to a library by following these steps:

1 In any ASCII text editor, open the library file to which you wish to save your new
symbol.
For example, if you wish to save your symbol to the main library, open
<root folder>\Lib\st72lib.mac (the ST6 main symbol library) or <root
folder>\Lib\st72lib.inc (theST7 main symbol library).
If you wish to save the symbol to a new library, create a new ASCII file in the
<root folder>\Lib folder and call it an appropriate name, such as
my_synbol s. mac (for ST6) or nmy_synbol s. i nc (for ST7).

2 Copy and paste the new symbol’s ASCIl macro (i.e. the contents of the ASCIl macro
file you created on page 151) either to your newly created library file, or to the end of
the main library file above.

3 Save the library file.

Note: It is always wise to save your new symbol macros and any modified or created
libraries to a back-up folder, or on a floppy disk. In the event that you need to
reinstall ST-Realizer, the root folder will be overwritten, and all of your
customized symbol libraries will be replaced by the ST-Realizer default libraries.

4 Next, save the symbol graphic by copying and pasting the new symbol graphic from
within the scheme where you created it to a new, blank scheme. From this new
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scheme containing the new symbol, select File=>Save as.. fil enane. i b where
fil enane is the name of the symbol (for example, stepper).

N Tip: When you save a scheme as a library, you will copy all of the symbols in that

_

— — scheme to the library. Therefore, to save only the new user-defined symbol to
the library, it needs to be in a scheme by itself.

R

Each time you wish to use the symbols that you have created, from within the project where
you are working, perform the following:

1 Select Project2Hardware settings.

2 In the Hardware settings dialog box, in the Include file field, ensure that the library
that you saved your symbol to appears in the list of files:
 <root folder>\Lib\st72lib.mac (for ST6) or <root fol der>\Lib\st72lib.inc
(for ST7) if you saved your symbol to a main library.

 <root folder>Lib\filename.mac (for ST6) or <root fol der>Lib\filenanme.inc
(for ST7) where fil enane isthe name of the new symbol library you created above.

4
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11 CUSTOMIZING ST-REALIZER

A number of ST-Realizer features can be customized to suit your way of working. These
include:

To customize these features, proceed as follows:

1

g

Automatic work saving
Screen preferences
Worksheet layout preferences
Printing options

Symbol layout preferences
Wire drawing options
Attribute display preferences

Toolbar contents

Select Options 2Environment from the main menu bar.

The Environment Options dialog box opens showing a number of tabs that direct you to

the following daughter dialog boxes:

Advanced
Attribute
Page
Print
Symbol
Toolbar
Wiring
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11.1 Automatically Saving Your Work and Setting Screen Preference

ST-Realizer can back up and save your work automatically. This option can be chosen in the
daughter dialog box accessed by clicking the Advanced tab:

[ Environment options |
Advanced T Attribute T Page T Print T Sumbol T Toolbar T Wfiring ]

¥ Make backup on zave

[V Auto backup every I 10 min.

Selectionbox calor - E dit I
Ghostbow colar - E dit I

OE. I Carcel I

1 Select the backup options that you wish.
To create a backup file every time you save your work:
* Check the Make backup on save check box by clicking it.

This creates a copy of the file before your latest changes are saved. If a backup file
already exists, the new backup file overwrites it.

To create a backup file at regular intervals:

* Check the Auto backup every check box by clicking it, and enter an interval (in
minutes) in the text box. If you want to change this, overtype the displayed value.

This causes a copy of the file to be saved periodically.
2 Set/Change the screen preferences.
To change the Ghost box or Selection box colors:

» Click the appropriate Edit button and select the new color from the displayed palette.
3 Click Ok when you have finished.

4
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11.2 Attribute Display Preferences
In this tab, you can change the default settings for the display of attributes on the worksheet.
1 Inthe Environment Options dialog box, click the Attribute tab.

The Attribute dialog box opens.

= Environment options |

&dvanced .ﬁ.ttrlbuter Fage T Fririt T Sumbiol T Toolbar T "wititig ]

Calor - EditI
Size | 20 mm.

Alignment

Harizontal IEenter vl
-

Wertical I Center I

ok Cancel I

2 To change the attribute label color, click the Edit button and select the new color
from the displayed palette.

3 To change the attribute label font Size, overtype the appropriate value in the text
box.

4 To change the attribute Alignment, select a new value from the appropriate drop-
down list.

5 Click OK when you have finished.

4
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11.3 Worksheet Layout Preferences

In this dialog box, you can change the size and orientation of your scheme worksheet. These
characteristics are visible on screen and when you print a scheme.

1 In the Environment Options dialog box, click the Page tab.
The Page dialog box opens.

B Environment options E |

Advanced T duttribute TF‘ager Print T Symbal T Toolbar T "iring ]

rientation I Landscape = I

Size 4 =

Gnd | 1.0 m.m.

s I Cancel I

2 To change the worksheet orientation, select the appropriate option in the
Orientation drop-down list.

3 To change the worksheet size, select a new size from the Size drop-down list.
4 To change the grid distance overtype the appropriate value in the Grid box.

5 Click OK when you have finished.

4
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11.4 Printing Options
In this dialog box, you can change the margins and the font of your printed scheme page.
These characteristics are visible on screen and when you print a scheme.
1 Inthe Environment Options dialog box, click the Print tab.
The Print dialog box opens.

= Environment options |
Advanced T Aittribute T Fage T Pririt T Symbol T Toalbar T adining ]

b arginz in m.m.

Left m
Right m
Top IT
B ottom m

Fontface: &nal pointsize: 8

Select fant. . |

ak. | Cancel I

2 To change the margins, overtype the values in the appropriate boxes.

3 To change the font, click the Select font... button, and select the new font from the
list.

4 Click OK when you have finished.

4
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11.5 Symbol Layout Preferences
In this dialog box, you can change the way symbols are displayed on the worksheet.
1 In the Environment Options dialog box, click the Symbol tab.

The Symbol dialog box opens.

= Environment options |

Advanced T Aktribte T Page T Frirt T Symbal r Toalbar T Wafiring ]

Shape color - Eu:IitI
Grid I 1.0 mm.

To eaze the creation of pour own zpmbols Realizer can create
the macro heading for o,

v Use the pin names in the macro heading

| OF. | Cancel |

2 To change the color of symbols, click the Edit button and select the new color from
the displayed palette.

3 To change the grid distance within symbols, overtype the appropriate value in the
Grid box.

Each symbol you create is normally linked to one or more macros. These macros have
headings with a specific format. For details, see “Naming Macro Instructions” on
page 152.

4 To allow pin names to be used in macro headings click the corresponding check
box.

5 Click OK when you have finished.

4
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11.6 Customizing Toolbars

Toolbar buttons provide you with quick access to frequently-used commands. Most of the ST-
Realizer commands have their own, predefined buttons. You can change the ST-Realizer

toolbars by:

« Adding or deleting toolbar buttons.

* Placing separators between toolbar buttons.

* Changing the order of toolbar buttons.

e Restoring the default toolbar.

Note:

The following paragraphs describe how to perform these tasks.

1 Inthe Environment Options dialog box, click the Toolbar tab.

Note that the changes you make to the toolbar are not implemented until you
open a scheme.

The Toolbar dialog box opens. The Available buttons box lists the toolbar buttons that
are available but are not currently being used. The Active buttons box lists the toolbar
buttons that are currently being used.

B Environment options |

Advanced T Attribute T Page T Print T Sumbal TTl:n:uII:uarT Wiring ]

Ayailable buttons:

Analpze Go
Simulate Go

[
[

Active buttons:

File Mew -
File Open

File 5ave

Separatar ---

Edit Cut

Edit Copy

Edit Pazte

Edit Delete

Separator -

Select & Wire Group
Separatar ---

Analyze Results LI

Previnnz Mezsane

Up | Dn:lwnl Separator |

Default | ok |

Cancel

4
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11.6.1 Adding and Deleting Toolbar Buttons

1 To add a button to the toolbar:

* In the Active buttons box, select the button to the left of which you wish to add the
new button.

* Inthe Available buttons box, click the name of the button you want to add, then

click .

2 To delete a button from the toolbar, click its name in the Active buttons box,

then click .

3 Click OK.

11.6.2 Placing Separators Between Toolbar Buttons

You can place separators between toolbar buttons, so that you can group the buttons as you
like. For example, you could group the edit functions: Cut, Copy and Paste buttons. Placing a
separator widens the space between two buttons.

To place a separator:

1 In the Active buttons box, click the button to the left of which you want to place a
separator.

2 Click the Separator button, then click OK.

11.6.3 Changing the Order of Toolbar Buttons
1 In the Active buttons box, click the button you want to move

2 Click Up to move the button one place to the left, or Down to move the button one
place to the right.

w

Repeat step 3 until the button is in the required position.

N

Click OK when you have finished ordering the buttons.

11.6.4 Restoring the Default Toolbar
1 Click Default.
2 Click OK.

4
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11.7 Wire Drawing Options

You can change wire characteristics and snapping distances.

1 In the Environment Options dialog box, click the Wiring tab.
The Wiring dialog box opens.

= Environment options |
Advanced T Attribute T Page T Frint T Symbol T T oolbar T Wiring ]

¥ Snap to object at I 1.0 m.hi.
IV &to wire

Stop auto wiring after | 10 zec.

Wwire calor - Edit |
Junction calar - E dit |

1]:8 I Cancel |

2 To change the snapping distance, click the corresponding check box and overtype
the appropriate value in the text box.

3 To enable the auto wiring and/or auto reroute features, click the appropriate check
box.

e With Auto wiring, ST-Realizer draws the wires by automatically choosing the shortest
path between the symbols to be connected, creating corners where required.

e With Auto reroute, ST-Realizer automatically reroutes wires when a symbol is moved.

4 To change the color of wires or junctions, click the appropriate Edit button and
select the new color from the displayed palette.

5 Click OK when you have finished.

g
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APPENDIX A: VARIABLES AND ATTRIBUTES

This appendix provides you with quick access to the type of information you’ll need when you
create ST-Realizer applications. This information includes:

* Alist of the type of variables you can define, and the rules that apply to variables.

« Alist of the attributes you can place on symbols and wires.

Al Variable Types and Rules

ST-Realizer lets you define the following data types:

Table A1 Data Types

Name Range Data type Nug;::sr of
BIT 0,1 Boolean Bit
UBYTE 0...255 Unsigned byte 1
SBYTE -128...+127 Signed byte 1
UINT 0...65535 Unsigned integer 2
SINT -32768...32767 Signed integer 2
LONG -2147483648.. .2147483647 Signed long 4
WORD Represents any type, except BIT Any, except Boolean 1 through 4

Most of the symbols included with ST-Realizer support multiple-type pins. This means that
any variable types can be assigned to these pins. For example, the AND2 symbol can be used
as an AND or either two BIT or two UINT variables.

ST-Realizer handles multiple type variables in two groups:
e The BIT variables.
* The UBYTE .. LONG (=WORD) variables.

You cannot mix these variable groups, for example, an AND2 symbol cannot be used to
perform an AND on a BIT and a UBYTE variable.

Note that the type WORD covers any data type other than BIT.

4

167/209




Variable Types and Rules Appendix A: Variables and Attributes

To define a variable type, you attach an attribute with the Tag TYPE and the name of the
variable type in the Value field.

Note: A LONG variable uses 4 bytes in RAM, while a UINT or SINT variable uses 2
bytes and an UBYTE uses 1 byte. To save RAM space, it is therefore
recommended that you use the LONG variable range only when needed.

Al.l1 Type Inheritance

Multiple-type pins support type inheritance: this means that the output pin type is the same as
the greatest of the input pin types.

The following picture shows how type is inherited by the AND2 symbol.

11 A D——I—
A

LEYTE
Mo &Z Becomes SEYTE

2 A D—4,7E

SEYTE
Mo

I3 A D——I—
A

SIMNT
Mo &Z Becomes SIMT

I4 A D——,iB

LIEYTE
Mo

Note that, if the expected result is outside the expected range, you must set the appropriate
type for the output pin by placing a TYPE= attribute on that pin. For example, if a multiplication
is performed between the values 124 and 245, which are both UBYTE type variables, the final
result will be 30380, which is a SINT type variable. Thus the SINT type must be attributed to
the output wire.

Note: Operations between BIT and WORD variables are not allowed.

4
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Al.2 Type Overruling

You can overrule type inheritance rules. By placing an attribute with the Tag TYPE on the
output wire, you can set the output of a symbol to a specific variable type.

This feature can be useful when you use the MUL symbol to multiply two values. When you
multiply two SINT variables an overflow may occur: 2000 * 1500 becomes -14656 instead of
the expected 3000000. By putting a TYPE=LONG attribute on the output wire of the MUL
symbol, this overflow is prevented (the value 3000000 can easily fit into a LONG variable). For
example:

IN1 A D
SINT

No X 7 TYPE=LONG

LA D_IB

SINT
No

Another example of type overruling is where the DIV symbol (divide) is used to divide two
SINT variables. This results in a value that fits onto an SBYTE variable. By using the TYPE=
attribute a smaller variable type can be defined, generating more efficient and faster code:

IN1 A

D TYPE=SBYTE
SINT A Q
No —_
.
1000 -

A2 Attribute Types

The following tables list the types of attribute that you can place on pins and symbols, and
describe the available values and meanings.
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A2.1 Pin Attributes

Tag Description

# Pin numbering: # = 0..x
Specifies the parameter sequence.

TYPE Specifies the variable type of a pin. The following table lists the available
values for TYPE tags and their ranges:
Value Range
EVENT 0,1
BIT 0,1
UBYTE 0..255
SBYTE -128 .. 127
UINT 0 .. 65535
SINT -32768 .. 32767
LONG -2147483648 .. 2147483647
WORD = any type except BIT
When one of these values is specified, the connecting wire must be of the
same type.
For input pins the attribute: TYPE = WORD is available. This allows type
UBYTE .. LONG to be connected to the pin.
For output pins a combination of input pins can be used to define the output
type:
MAX a,b,c,...: a,b,c,.. are pin numbers.
MIN a,b,c,...
The MAX value returns the largest of the input pin types and the MIN value
return the smallest.
For example, MAX1 will return the type of input pin 1. MAX12, will return the
largest of the input pin types of pins 1 and 2.
Non volatile allocation: ALLOCATION = "FIXED" . Allocates a non volatile
variable with the same variable type as the pin.
Local variables:
ALLOCATE =X
X’ extra variables are added, the variable type of the pin is used.
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A2.2 Symbol Attributes

Tag

Description

ALLOCATEBLOCK IN

Defines the memory space (RAM or EEPROM).

ALLOCATION

By adding the ALLOCATION = FIXED attribute to an output pin, ST-analyser
will allocate a non-volatile variable (usually a EEPROM variable) to it. This
variable is added to the macro parameter list after the list of parameters of that
particular pin. This enables you to make your own non-volatile symbol.

BLOCK SIZE IN UNITS

Defines the size of the block in units (variables).

CODE Defines a macro that is executed inside the main execution loop. Enter the
macro name in the Value field.

COMMENT The value of this attribute is used in the report file.

COUNT PIN See “DEVICE”

DEVICE DEVICE attributes apply to macros associated with some particular symbols.

They are automatically specified when you select the symbol. They extend the
macro definition with additional information added in the macro argument list
after the pin and value attribute parameters.

The available DEVICE values are:

DEVICE = INPUT, which extends the macro argument list with the input port
parameters. In this case the attribute NAME must be used to associate a
hardware port. Examples: input, inputlatch symbols.

DEVICE = INPUTREG, is used to enable a hardware connection to an Input
register.

DEVICE = INPUTALL, is used to enable a hardware connection to any
hardware resource.

DEVICE = OUTPUT, which extends the macro argument list with the output
port parameters. In this case the attribute NAME must be used to associate
a hardware port. Examples: output, outputlatch symbols.

DEVICE = OUTPUTREG, is used to enable a hardware connection to an
output register.

DEVICE = OUTPUTALL, is used to enable a hardware connection to any
hardware resource..
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Tag

Description

DEVICE (cont'd)

DEVICE = TIMER, which extends the macro argument list with a time value,
a time variable and a system tick variable. The time value is optional (attribute
“TIME = 2:00.00"). The type of the time variable is determined by the constant
time value or the attribute “TIMEPIN = x”, where x is an input pin number. The
TIMER attribute results in the following macro call extensions:

If the TIME = attribute exists:
time, Ttime,timer, Ttimer,tick, Ttick
If the TIMEPIN = attribute exists:
timer, Ttimer,tick, Ttick
Examples: timf, timv symbols.
DEVICE = MICROSEC, is used to create a micro second delay, using
timebase with the attribute TIMEBASE =X .

DEVICE = COUNTER, which extends the macro argument list with an
additional variable and its type. This variable is used as an internal variable
(the counter value). The type of the internal variable is defined by the
“COUNTPIN = x" attribute, where x = a pin number. Examples: countf,
countv symbols.

DEVICE = SHIFT, which extends the macro argument list with an additional
variable and its type. This variable is used as an internal variable (the shift
value). The type of the internal variable is defined by the “SHIFTPIN = x”
attribute, where x = a pin number. Example: shift symbol.

ICODE Defines a macro that is executed once, before the main program loop is
executed, to initialise the symbol’s properties. Enter the macro name
preceded by i in the Value field.

LABEL Used to link two wires by means of a name or to name an object.

NAME See “DEVICE”

OCODE Defines a macro that is executed at the end of the execution loop. Enter the
macro name preceded by o in the Value field.

SCHEME Subscheme attribute; specifies the name of the file (*.sch) associated with the
subscheme

SHIFT PIN See “DEVICE”

TABLE Extends the macro parameter list with a reference to a ROM table, the number
of records in the ROM table and the default value of the table:
table,nrOfrecs,defval
The tag TABLETYPE can also be used with the value INDEX or LOOKUP, to
generate an indexed table or a lookup table respectively.

The “TABLE =" attribute defines the filename of the table.
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Tag Description

TIME See “DEVICE”

TIME PIN See “DEVICE”

TXT Specifies ASCII data to be entered as plain text.

UNIT TYPE Type of a variable, from BIT through WORD, and also MIN and MAX.

VALUEXXXX The values of attributes with the tag: VALUE, are added after the pin
parameters.
VALUEX = x , is used to create a constant.

FAMILY FAMILY="ST623" , used to identify hardware specific symbols. This string is

compared with the device string when there is a partial compare the symbol is
excepted by the analyzer.
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APPENDIX B: SAMPLE APPLICATIONS

B1 Coded Lock Application

Applications generally include more and more security features. These aim to insure data
confidentiality, access control or identify users. Non-volatile memory is usually required to
store the identification or secret code. With the embedded EEPROM provided on the ST6 or
ST7 MCU, one-chip solutions can be developed with the associated cost and density
advantages.

The following example shows a coded lock system that was developed using ST-Realizer.

B1.1 Application Overview

This application manages a coded lock for a door. A secret code is loaded into the lock system
to allow the door to be unlocked only if that code is entered. When loaded, the secret code is
stored in the non-volatiie memory (EEPROM) embedded in the ST6 or ST7 MCU. This
ensures that the data is retained, even after a voltage cut-off, and insures security.

The application includes the following features:
» Secret code recording (3 digits).

» Recognition of entered access codes.

» Door lock control.

All the described functions of the system are managed in the final application under software
control by the MCU.

Only the core of the application, the secret code storage in EEPROM and the code
recognition, are described as a generic base for various applications. Any type of user
interface, such as keyboard, IR or RF could be used, while the output signal can activate any
kind of circuit. For this example, it is assumed that the user interface provides the following 4
inputs:

« Digit reception flag

e Digit value (0..9)

« Change secret code
* Lock the door

The digits used for the code are received serially, and are announced by the activation of a
flag.
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B1.2 Functional Description

Figure B1 below shows the application block diagram. Note that the application is restricted
to its core: operation sequencing, the secret code storage in the EEPROM and the code
recognition.

Figure B1 Coded Door Lock Block Diagram

Lock the door

Change secret code > Sequencing
3 - Control
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@
(2]
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Digit value
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Code locking
. Recognition —————p» - - - - System

B1.3 Sequencing Control

The most important feature of this application is the sequencing control of all its operations.
Two main items must be considered: the transition between the different working modes (Door
locked, Access code entry, Door unlocked and Secret code entry) and the management of the
serial flow of the numeric values received from the user interface.

The transition between the working modes is managed by a state machine, which manages
four states:

 Door locked
» Code recognition
¢ Door unlocked

e Secret code entry
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Figure B2 Sequencing Control State Machine
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Change Cade

The conditional occurrences are generated through either the user interface (Lock, Change
secret code), or some functional sub-blocks of the application (One digit received, Right code,
Wrong code, Last digit). For example, the occurrence of the condition One digit received in the
Door locked state initiates the process code recognition.

The management of the serial flow of the digits entered (0..9) is carried out using a received
digits counter (Figure B3). This stores the 1st, 2nd and 3rd digits received (in the case of a 3-
digit code), in associated memory locations. When the 3rd digit is received, the counter is
reset. In addition, the reception flags of the 1st digit and 3rd digit are used in the state-machine
to initiate the code recognition and conclude the Secret code entry respectively.

Figure B3 Management of Digit Reception
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B1.4 Secret Code Storage in the EEPROM

ST-Realizer enables the EEPROM non-volatile memory to be managed as a standard bi-
stable component: R/S Latch, D Latch, Shift Register or Counter.

Each EEPROM location is identified by a specific D Latch component providing the non-
volatility feature. This component, provided within the ST-Realizer library, has the advantage
of being multitype. This means the same symbol can be used whatever the input type: Bit,
Byte, Word, Integer or Signed variable.

The data input comes directly from the interface as the digit value, in one byte. The number of
D Latches must be equal to the number of digits used for the secret code, that is 3. There is a
specific clock for each of the 3 D Latches, controlled by the sequencing control module. Data
can be written (Clock activated) to a D Latch only if the active mode is Secret code entry, and
if the received bit corresponds to this location (Figure B4). The clock is generated through an
AND function between the Secret code entry mode and the ranking of the received digit. This
ranking is issued by the counter used for serial flow reception.

Figure B4 Digit Storage in EEPROM

Digit Value To 2nd and 3rd EEPROM storage
Secret Code. N P MQ B
Entry a k.
1st_Digit &: c o
EEPROM

B1.5 Access Code Entry and Recognition

The digits are received serially, as in the Secret code entry mode, and stored in Volatile
Memory locations (RAM). The RAM locations are described with standard D Latch symbols.
The input/output of this component are exactly the same as for the non-volatile components
allowing a clear analogy between the functional description of the two modules. The data input
channel is the same while the clocks are logically validated, except if the Secret code entry
mode is activated (Figure B5).

Figure B5 Digit Management for Code Recognition

Digit Value To 2nd and 3rd digit stage
Secret Code., ) 0 MQ B
Entry &: < ap o o-a-c|Digit Recognition
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Code recognition is performed by a one-to-one comparison between the values stored in
EEPROM and RAM.
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B2 Analog Multiple Key Decoder

One of the main uses of the ST on-chip Analog to Digital Converter (ADC) is to decode keys
through one 1/O port pin. The keys are connected to the converter input using a resistive
voltage divider. This method is useful, since it only requires one 1/O pin, whereas a traditional
matrix keyboard requires a high number of I/O pins.

B2.1 Application Overview

The basic circuit of the decoder consists of a pull-up resistor connected to the ADC input, with
the first key directly switching to ground. The following keys are then connected in sequence
to the ADC input through serial resistors. The combination of the pull-up resistor, the serial
resistors and the pressed key form a resistive voltage divider (Figure B6).

Figure B6 Analog Keyboard Resistor Key Matrix

sV

ST6 H
] 7

11 1T

When a key is pressed, the voltage at the ADC input is given by the activated voltage divider,
generating a different voltage at the ADC input for each key that is pressed. If the top key is
pressed, the voltage measured is zero while the default voltage at the ADC input (if no key is
pressed) is Vdd.

L
b

ADC IN[

This analog voltage is converted by the ADC and the digital output value is used to determine
which switch is closed. If more than one key is pressed at the same time, the key detected is
the key in the chain closest to the ADC input. This allows the keys in the keyboard to be
prioritized (Figure B7).
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Figure B7 Multiple Key Press
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Depending on the identified key, a direct signal activation can be achieved or a selective jump
in the program flow can be performed.

B2.2 The Keyboard

The serial resistors are selected in order to give an equal distribution of voltage between Vdd
(No key pressed) and Vss (Last key pressed) for each switch combination, in order to give the
best noise margin between keys. For n keys, the resistor values should be selected so that the
voltage for the second key from top is Vdd/n, for the 3rd 2Vdd/n, for the 4th 3vdd/n and for the
nth (n-1)vdd/n.

The maximum number of keys is limited by the precision of the resistors that provide a voltage
value for each key pressed, within a margin of error either side of the theoretical value.

For a 10-key system, the values (in Ohms) given in Table B2 are used for the resistor network.
Taking into account +/- 2% resistors, the voltage values and conversion results given in Table
B3 can be obtained. Vmin is obtained when the serial resistors are at their minimum value and
the pull-up resistor Rp is at its maximum value. Vmax is obtained when the serial resistors are
at their maximum value while the pull-up resistor Rp is at its minimum value.

Table B2 Used Resistors
Rp R1 R2 R3 R4 R5 R6 R7 RS R9
10000 | 1100 1300 1800 2400 3300 5100 8200 16000 | 51000

Table B3 Voltage at the ADC input and 8-bit conversion result (5V supply)

Active key vmin Vmax Conversion
result
KeyO 0.00 0.00 0-0
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Keyl 0.48 0.51 24-26
Key2 0.94 1.00 48-51
Key3 1.44 1.52 73-78
Key4 1.94 2.04 99-104
Key5 2.44 254 124-129
Key6 2.95 3.05 151-156
Key7 3.45 3.54 179-180
Key8 3.95 4.02 202-205
Key9 4.48 4.52 229-230

The condition no key pressed corresponds to a result of 255.

B2.3 Software Generation

The functional description of the application includes:

* The analog input through an ADC to read the value issued by the voltage dividers.

» Key recognition.

« Transfer of the result to other functional blocks, or conditional jumps in a state machine.

The recognition of the pressed key is achieved by comparing the digitized analog value with
the range limits defined in Table B3. However, these ranges [0-0], [24-26] up to [229,230] are
not contiguous, thus two comparisons (upper limit and lower limit) are required to check that a
value is within a range. This means that more ROM and RAM is used with an higher execution
time. Thus some extended ranges with common limits are defined as shown in Table B4.

Table B4 Recognition ranges

Key pressed Recognition ranges
KeyO 0-12
Keyl 12-37
Key2 37-62
Key3 62-88
Key4 88-114
Key5 114-140
Key6 140-165
Key7 165-190
Key8 190-217
Key9 217-244
None 244-255
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A range limit value is never reached (see Table B3), therefore no ambiguous situation can
occur.

The key pressed can then be recognized with numeric comparators and some logical gates,
as shown in the Figure B8. The output signals generated Key 0,.., Key 9, None are logical
signals, and can therefore be used both as input signals to other functions or as conditions in
a state machine.

Figure B8 Key Recognition by Analog Value Evaluation
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B2.4 Possible Improvements

The inputs A and C of the comparators are interpreted as variables to which fixed values are
assigned: the range limits. Even though this does not have any importance for the application
process itself, it must be taken into account in some cases. Some RAM locations, usually
dedicated to variable storage, are used to store these constant values. This reduces the RAM
space available for the surrounding application (Data processing, I/O control etc.).

This can be improved by creating a specific comparison symbol where the reference values
are defined as constant. Thus the limit values are stored in the ROM and not in the RAM
space.

While doing this, it is also possible to fine tune the symbol function for the application. The new
symbol is defined as follows:

The variable input value is compared to 2 reference values Bot, Top attached to the symbol
instance, providing 3 output:

e Input> Top
e Bot <= Input <= Top
e Input < Bot

Only 5 comparators and one RAM location are used by the digitized representation of the
voltage value, instead of 11 in the previous case (input value plus 10 border values).
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The symbol customisation feature provided by the ST-Realizer environment thus enables a
more simple graphical description to be created (only 5 comparators) while optimizing the
memory requirements (Figure B9).

Figure B9 System Optimization Using Customized Components
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B3 Clock Design

MCU solutions are often used as clocks owing to the onboard timer and all the task
management possibilities offered by the MCU embedded resources. This approach enables
single-chip solutions to be developed that are extremely useful in applications such as small
home appliances.

The following paragraphs show an example clock design, that includes an alarm feature, that
was developed using ST-Realizer.

B3.1 Application Overview

The clock system provides the following features:
» Current time counting

» Alarm triggering at a defined time

e Current time setup

e Alarm time setup

The time values are represented in the HH:MM format, but the described concept can easily
be extended to representation in seconds. By using this HH:MM format, the time value is
represented by a pair of integer variables ranging between [0 to 59] for the minutes and [0 to
23] for the hours.

The user interface consists of 4 keys: TIME SETUP, ALARM SETUP, HOURS and MINUTES.
With these 4 keys, both the current time and the alarm time can be adjusted:

* When the key TIME SETUP is activated, the Hours (Resp. Minutes) variable of the current
time is increased each time the key HOURS (Resp. MINUTES) is activated.

e When key ALARM SETUP is activated, the Hours (Resp. Minutes) variable of the Alarm
time is increased each time the key HOURS (Resp. MINUTES) is activated.

All time variables are reset to 00 when they reach the maximum value (23 for the hours and 59
for the minutes).

B3.2 Current Time Counting

The system uses a timebase generated by the clock of the embedded timer on the ST6 or ST7
MCU. This timebase can be configured (the default value is 10 ms). It is used to trigger three
chained modulo-n counters (Unit Counter):

* One for seconds (n = 60).
* One for minutes (n = 60).

* One for hours (n = 24).

4

184/209




Appendix B: Sample Applications Clock Design

When any of these Unit Counters reach their maximum value, a clock is issued to increment
the Unit counter of the next stage.

B3.3 Current Time Setup

The current time value is modified by incrementation of the counters used for the current time
counting. This is achieved by duplicating the clock input of the appropriate counter in the
current time counting block. In practice, two different additional clocks are needed, one for
minute incrementation and one for hour incrementation. Each of these additional clocks is
controlled by the combination of the keys: TIME SETUP, HOURS and MINUTES.

B3.4 Alarm Time Setup

This process is similar to current time setup. Two counters are used, one for minutes, and for
hours. The contents of these counters can only be modified by pressing the keys ALARM
SETUP, HOURS and MINUTES once.

B3.5 Alarm triggering

An alarm process is launched when the current time is equal to the predefined alarm time. The
occurrence is enabled by a double comparison: Hours equal, Minutes equal

Figure B10 Application Block Diagram
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B3.6 Timebase

The timebase is described using the Oscillator component of the ST-Realizer library. Any
“real-time” value can be defined for the period. For this application, the 1Hz timebase is
defined as an oscillating square wave with half a period (level High duration) of 00:00:00.50 in
the HH:MM:SS.xx format (Figure B11).
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ST-Realizer uses the embedded Timer of the ST6 or ST7 MCU as the timebase, and
generates by software any periodic variable.

Figure B11 Timebase Description

1 Hz Timebase

00:00:00.50

B3.7 Current Time Counting

Each of the 3 chained Modulo-N counters presents:

« An input clock issued from the previous stage (timebase for the 1st stage).

« An output clock to activate the following stage.

« A byte-wise output with the current counted value (Second, Minute or Hour).

* An optional clock for the incremental set-up process.

Any content change can only be performed during an input clock transition from 0 to 1. Thus
the reset phase when the counter reaches its maximum value has to be anticipated. For
example, the Hours Modulo-24 counter is reset if the two following conditions occur: contents
equal 23 and input clock transition. In parallel, the resulting Reset signal is issued as output
clock to increment the next stage as shown in Figure B12 in the case of a Modulo 5 counter.

Figure B12 Clock synchronism principle
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|

Each Modulo-N block is based on a Counter component provided within the ST-Realizer
standard library. This symbol presents the advantage of generating a numeric variable as
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output. This means that any numeric or arithmetic operation can be directly performed on that
variable without modifying its binary representation. The detection of the maximum value is

achieved with a comparator symbol.

The comparator output is entered into the feedback loop at the falling edge of the input clock.
This avoids any parasitic Reset during the High level of the input clock, when the comparator
output switches to High level. In parallel, the counter incrementation is prevented by forcing

the Up input of the counter to Low level.

Finally, each Unit Counter is represented in the ST-Realizer environment as shown in the

Figure B13.
Figure B13 Unit Counter Description
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Figure B14 Current Time Counter Waveforms
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B3.8 Current Time Setup

The incrementation clock (Up input of the symbol) is duplicated through an OR gate with an
external clock, Setup signal, for Hour or Minute setup. Any activation on this clock increments

the content of the counter by 1 (Figure B15).

(572
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Figure B15 Current Time Setup with a Duplicated Clock
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B3.9 Alarm Time Setup

As for the Current Time setup, the Alarm Time setup is achieved by incrementation of two
Modulo-N counters, one for minutes and one for hours. Each of them has its own input clock,
controlled by the combination of the keys ALARM SETUP, HOURS and MINUTES.

A feedback loop is still needed to reset the counter when the maximum value is reached, but
its implementation can be more simple than in the Current Time counting blocks. A precise
synchronism is not mandatory, and a basic solution can be used (Figure B16).

Figure B16 Alarm Time Setup
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B4 Fast Counter Application

B4.1 The Application

The following description of an application is added to this appendix to illustrate the new
features that come with ST-Realizer Il. The application is a pulse counting device used to
measure the frequency of a digital signal. It uses the interrupt sensitive inputs of an ST6260
microcontroller. It will filter the measured frequency so that a readable value is obtained. It
converts these values into viewable data and then drives a 4-digit 7-segment LED-display.
Figure B17 shows the basic block diagram symbols that represent the subschemes. The next
diagrams show the 4 sub schemes in detail. Parts of these sub schemes are used in the first
part of this application note. Please note that they are all made using ST-Realizer Il. In Section
B4.2, the Realizer Report File (FASTCNT. RPF) is shown. It informs the designer what
resources are used in which way. In addition, the code generated by Realizer is shown, with
some comments added for your convenience.

Figure B17 Overview of the Fast Counter Application
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The s%lbscheme shown in Figure B18 calculates the moving average over 4 samples every 3
seconds.

Figure B18 Fast Counter: Input section

Input section: Measuring the frequency
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Figure B19 Fast Counter: Filter and Limit section

Frocessing section: Filter and limit the measured value
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Execution conditions;
Feriodic 3 Sec.

The subscheme shown in Figure B19 counts under interrupt. The counter value is latched

every second. The edge detection symbol is needed to de-assert the Clr input during the high-
time of the oscillator.

The subscheme shown in Figure B20 converts the integer value into 4 bytes that carry the
data for the 7-segment displays. It is executed only when the input changes.

Figure B20 Fast Counter: Conversion section

Convert section: Creating the information for each digit.
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Execution conditions:
Upon sub scheme input change

The subscheme shown in Figure B21 takes care of the multiplexing of 4 7-segment displays.
It runs under interrupt control, every 10 milliseconds.
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Figure B21 Fast Counter: Display section
Display section: Driving the display in multiplexed mode.
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B4.2 Fast Counter Report File

Here is the Report File generated for the sample application discussed in this section.

ST6260 Realizing Unit (V4.00) (c) 1990-99 Actum Sol utions

Report file of pr oerct C.\ Program Fi | es\ ST-
Real i zer\ Exanpl es\ Fast cnt\ Fast Cnt . r pf

Schenme Version : 1.04
Report timestanp : Tue May 18 14:06:28 1999
Analyze results : No errors

C.\ Program Fi |l es\ ST- Real i zer\ Exanpl es\ Fast cnt\ Fastcnt. sch

Schene: C:\Program Fil es\ ST- Real i zer\ Exanpl es\ Fast cnt\ Lat ch. sch
Event: Periodic 3 Sec.

Schene: C:\Program Fil es\ ST- Real i zer\ Exanpl es\ Fast cnt\ | nput. sch
Event: Count=PB.2 interrupt

Schenme: C:\Program Fil es\ ST- Real i zer\ Exanpl es\ Fastcnt\ convert. sch
Event: Upon sub schene input change

Schenme: C:\Program Fil es\ ST- Real i zer\ Exanpl es\ Fast cnt\ di spl ay. sch
Event: Tinmed interrupt 0.03 Sec.

ST6260 (DI L20) connecti on overvi ew.

Pi n Name Alternative name Type 1/0 Description
1 PB.O Digit 0 (Isd) (BIT OQutput ), 20 mA sink open drain output
2 PB.1 Digit 1 (BIT Qutput ), 20 mA sink open drain output
3: TEST ( ), Test/ program
4: PB.2 Count (BIT Input ), i nterrupt
5. PB.3 (BIT Input ), Not connect ed
6: PB.6 Digit 2 (BIT Qutput ), 20 mA sink open drain output
7 PB.7 Digit 3 (nsd) (BIT OQutput ), 20 mA sink open drain output
8 PA.0 a-segnent (BIT Qutput ), 5 mA sink open drain output
9: Vvdd ( ), Power supply
10: Vss ( ), Power supply
11: PA. 1 b-segnent (BIT CQutput), 5 mA sink open drain output
12: PA. 2 c-segnent (BIT CQutput), 5 mA sink open drain output
13: PA. 3 d-segnent (BIT CQutput), 5 mA sink open drain output
14: OSCin ( ), Gscill ator
15: OSCout ( ), Gscil | ator
16: RESET (BIT Input ), Active | ow
17: NM (BIT Input ), Non Maskabl e Interrupt
18: PC. 4 f-segnent (BIT OQutput), 5 mA sink open drain output
19: PC. 3 g-segment (BIT CQutput), 5 mA sink open drain output
20: PC. 2 e-segnent (BIT CQutput), 5 mA sink open drain output
192/209 I’I




Appendix B: Sample Applications

Fast Counter Application

Har dwar e connecti ons:

Synbol i ¢ nane H W name
Digit 0 (Isd) PB. 0
Digit 1 PB. 1
Digit 2 PB. 6
Digit 3 (nsd) PB. 7
a- segnent PA. O
b- segnent PA. 1
c- segnent PA. 2
d- segnent PA. 3
e- segnent PC. 2
f - segment PC. 4
g- seghent PC. 3

Vari abl e overvi ew

Tot al used
Tot al used
Tot al used
Tot al used
Tot al used
Tot al used
Tot al used

bits

events

unsi gned bytes
signed bytes

unsi gned i ntegers :

si gned integers
| ongs

Mermory overvi ew

Tot al used
Tot al used

Not e: The pins that are not connected are defined as digita

The tinmer pin is configured as an output.

g

RAM
ROM

Descri ption

20 mA sink open
20 mA sink open
20 mA sink open
20 mA sink open

5 mA sink open
5 mA sink open
5 mA sink open
5 mA sink open
5 mA sink open
5 mA sink open
5 mA sink open
23

5

20

0

19

0

0

73 byte (000H >03FH, 085H >08CH)

drain
drain
drain
drain

dr ai
dr ai
dr ai
dr ai
dr ai
dr ai
dr ai

5 5 535 35 S

out put
out put
out put
out put
out put
out put
out put
out put
out put
out put
out put

1714 byte (0080H >0732H) of OF9DH

input with pull-up
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B4.3 Generated Code

Code generated for the sample application discussed in this section.

; ST Realizer (Beta 3) (V4.00) : generated ST6260 Code

; File C.\ Program Fi | es\ ST- Real i zer\ Exanpl es\ Fast cnt\ Fastcnt. asm
; Scheme Version : 1.04
; Date : Tue May 18 14:06: 27 1999

; Used variables : 52
; Used functions : 100

. VERS " ST6260"
. ROVBI ZE 4
.DP_ON

.LIST O

. I NPUT "Fastcnt.inc"

.INPUT "C:\Program Fi | es\ ST- Real i zer\ | i b\ ST6260. i nc"
.I'NPUT "C:\Program Fi | es\ ST- Real i zer\|i b\st62lib. nmac"
.INPUT "C:\Program Fi | es\ ST- Real i zer\ | i b\ st 62xx. mac"
.INPUT "C:\Program Fi | es\ ST- Real i zer\ | i b\ st 62eepr. mac"
.LIST 1

. ORG 00080H
RROMST:
.ASCl Z "Fastcnt™
.ASCl z "1.04"
Reset :
LDl 1 OR, I OR_MASK
LDl HWDR, OFFH

LDl DRBR, 010H
LDl EECTL, O0O0H

Perlnit:
: initialize PORTB events

; Enabl e i nterrupt on PORTB. 2

Portlnit:
LDl DDRA, OOFH
;LD ORA, 000H

LDl DRA, OOFH
LDl BUDRA, OOFH
LDl DDRB, 0C3H
LDl ORB, 004H
LDl DRB, 0C3H
LDl BUDRB, 0C3H
LDl DDRC, 01CH
; LDl ORC, 000H
LDl DRC, 01CH

4
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LDl BUDRC, 01CH

Rtcinit:
LDl PSC, 015H
LDl TCR, OCFH
LDl TSCR, 06DH
CLR TI CK
LDl 1 OR (I OR_MASK | 010H)
RETI

Ram ni t:

LDl A0

LDl X, O00H

LDl Y, 62
Ram ni t 1:

LD (X), A

I NC X

DEC Y

JRNZ Ramlinit1l

iconstw vin7, 2,4
iconstb v2n4,5,1,0
i dl tchwbww v2n10, 4,v2n11,2,1,y2n9,4,0,0
i constw v3n20, 2, 10
i constw v3n19, 2,100
i constw v3nl8, 4, 1000
JP ElI S03011

| S03011:

. BYTE O000H

.BYTE O7EH

.BYTE O0O01H

. BYTE 030H

. BYTE 0O02H

.BYTE 06DH

. BYTE O003H

.BYTE O079H

.BYTE 004H

. BYTE 033H

.BYTE O005H

.BYTE O05BH

. BYTE 006H

.BYTE O01FH

El S03011:

Real Mai n:
Rt c:
LDl 1 OR, | OR_MASK
LD A TICK
CLR TI CK
LDl 1OR (I OR_MASK | 010H)
LD RTICK, A
RTI MEND:

LD A, RTI CK
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JRNZ | RTC0003

JP RTCSKI P
| RTCO003:
; Decrenent 16 bit tiners

JRS 7, 037H, RTCO003

sub2ww 037H, 4, RTI CK, 2, 037H, 4
RTC0003:
RTCSKI P:
RI NPEND:
; noved to TIMERL interrupt: CALL SUB0002
LDl 1OR, | OR_MASK
copyww y2n9, 4,vOn5, 4
LDl 1OR, (I OR_MASK | 010H)

; nmoved to PORTB interrupt: CALL SUB0002
; check for tinme-out

JRR 7, ATO0001, _UNI 0000

LDl AT00001+0, 1

LDl ATO0001+1, 43

CALL SUB0001
__UNI 0000:

;I nput change detection on vOn7
LD A vOn7+0
CP A, pvOn7+0
JRZ _UNI 0001
JP EXEC0003

_UNI 0001:

LD A vOn7+1
CP A, pvOn7+1
JRZ _UNI 0002
JP EXEC0003

_UNI 0002:

JP NOEX0003

EXEC0003:

CALL SUB0003

NOEX0003:

; Disable interrupts for parameter passing
LDl | OR, | OR_MASK
copyww vOnll, 2, x4n5, 2
copyww vOn8, 2, x4n2, 2
copyww vOnlo0, 2, x4n4, 2
copyww vOn9, 2, x4n3, 2

; Enable interrupts

LD IOR (I OR_MASK | 010H)
; noved to TIMERL interrupt: CALL SUB0004
ROUTPEND:
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copyww vOn7, 4, pvOn7, 4
LDl 1OR, | OR_MASK

LD A BUDRA

LD DRA A

LD A, BUDRB

LD DRB, A

LD A BUDRC

LD DRC, A

LDl 1OR (I OR_MASK | 010H)
LDI HWDR, OFFH

JP Real Mai n

SUB00O01:

| oopdel ww vOn5, 4, svin2, 4,v1no, 4
| oopdel ww v1n0, 4, pv1n0, 4,vinl, 4
| oopdel ww v1ni, 4, pvinl, 4,v1n5, 4

add2wwww vOn5, 4, vin0, 4, vin3, 4
add2ww v1n3, 4,vinl, 4,v1n4, 4
add2ww v1n4, 4, v1n5, 4, vlnG, 4

di vwww v1né6, 4, vin7, 2,v1n9, 4,0,0

[imfwwv ving, 4,vOn7, 4,0, 9999
copyww vOn5, 4, svin2, 4
copyww v1n0, 4, pvin0O, 4
copyww vinl, 4, pvini, 4

ret

SUB0002:

interrupt driven sub routine

oscfb v2nl3, 0, 1, 49, 100, T02006, 2
edgebbb v2n13,0, 1, pv2n13,1,1,v2n11, 2,1
| oopdel bbb v2n11, 2, 1, pv2nll, 3,1,v2n3,4,1

v2n12

eventb v2nl12,6,1
countfbbbbbbbmb

0,0,0, 0 CT82000 4

dl t chwbww v2n10, 4, v2n11l, 2,1,y2n9,4,0,0

copybb v2n13,0, 1, pv2nl13,1,1
copybb v2nl1, 2, 1, pv2nll, 3,1
copybb v2n4,5,1,pv2n4,0,1

ret ;

SUB0003:

end of

di vwww vOn7, 4, v3nls8, 4, v3nl6, 2, v3nlo0, 4
di vwww v3nil0, 4, v3nl9, 2, v3n27, 2,v3nl2, 2
di vwww v3nl2, 2, v3n20, 2, v3n26, 2, v3n2l, 2
i ndt abwmv v3n21, 2, vOnl1l, 2, S03011, 14,0

i ndt abwwv v3n26, 2, vOn10, 2, S03011, 14,0

i ndt abwwv v3n27, 2, vOn9, 2, S03011, 14,0

i ndt abwwv v3nl6, 2, vOn8, 2, S03011, 14,0

ret

SUB0004:

interrupt driven sub routine

interrupt driven sub routine

stat eoutb v4n22,1,1,st0,2,2
stat eoutb v4n21,2,1,st0,2,3

or 2bbb v4n21, 2,1,v4n22,1,1,v4nl, 3,1

st at eoutb v4nl19,4,1,st0,2,1

(572

v2nl2,7,1,v2n4,5,1, pv2n4,0,1,v2n3, 4,1,v2n4, 5, 1, pv2n4, 0, 1, v2nlo0, 4,
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or 2bbb v4n19, 4,1, v4n21,2,1,v4n0,5,1
mux2bbwwww v4n0, 5, 1, v4nl, 3, 1, x4n2, 2, x4n3, 2, x4n4, 2, x4n5, 2, v4n6, 2
bunpackwbbbbbbbb

v4ne, 2, 0,0, 0,v4n43, 6, 1,v4n4d7,7,1,v4n42,0,1,v4ndl, 1, 1,v4nd4, 2, 1,v4n45, 3, 1, v4n

46, 4,1
di goutb v4n46, 4, 1, BUDRC, 3, 1
di goutb v4n45, 3, 1, BUDRC, 4, 1
di goutb v4n44, 2,1, BUDRC, 2, 1
di goutb v4n42, 0, 1, BUDRA, 2,1
di goutb v4n47,7,1, BUDRA 1, 1
di goutb v4n43, 6, 1, BUDRA, 0, 1
di goutb v4n4l, 1,1, BUDRA 3,1
stateoutb v4nl2,5,1,st0,2,0
di goutb v4ni2,5, 1, BUDRB, 0, 1
stateoutb v4nl13,6,1,st0,2,1
di goutb v4n13, 6,1, BUDRB, 1, 1
stateoutb v4nl4,7,1,st0,2,2
di goutb v4ni4, 7,1, BUDRB, 6, 1
stateoutb v4nl5,0,1,st0,2,3
di goutb v4ni5, 0, 1, BUDRB, 7, 1
statemnit st0,2,0
statemnit st0,2,1
statemnit st0,2,2
statemnit st0,2,3
statemnit st0,2,-1
stateinit st0,2,0
state st0,2,0,1
stateend st0, 2,0
stateinit st0,2,1
state st0,2,1,2
stateend stO0, 2,1
stateinit st0,2,2
state st0,2,2,3
stateend stO0, 2,2
stateinit st0,2,3
state st0,2,3,0
stateend stO0, 2,3
statenend stO, 2,4
LD A, BUDRA
LD DRA, A
LD A, BUDRB
LD DRB, A
LD A, BUDRC
LD DRC, A
ret ; end of interrupt driven sub routine

.l FC NDF Rtci nt
Rt ci nt :
LDl TSCR, 000H
LDl PSC, 015H
LDl TCR, OCFH
LDl TSCR, 06DH
I NC TI CK

; Create nornmal stack push
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LD STACKA, A
LD A X

LD STACKX, A
LD A'Y

LD STACKY, A
LD AV

LD STACKV, A
LD AW

LD STACKW A
LD A REQD
LD STACKO, A

;  Decrenent interrupt tiners
JRS 7, T02006, TML_0004
decw T02006, 2
JRR 7, T02006, TML_0004
CALL SUB0002
TML_0004:

; Decrenent prioritized tiners
decw AT00004, 2
JRR 7, ATO0004, TML_0005
CALL SUB0004
copyww 2, TCONST, AT00004, 2
TML_0005:

; Create normal stack pop
LD A, STACKO
LD REQO, A
LD A, STACKW
LD WA
LD A, STACKV
LD V, A
LD A, STACKY
LD Y
LD A
LD X A
A
|

; PORTA, PORTB interrupt service routine
. 1| FC NDF PORTAI nt
PORTAI nt :

; Create nornmal stack push
LD STACKA, A
LD A X
LD STACKX, A
LD A'Y
LD STACKY, A
LD AV
LD STACKV, A
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LD AW

LD STACKW A

LD A REQD

LD STACKO, A

SET 6,v2nl2

CALL SUB0002
RES 6, v2nl12

; Create normal stack pop
LD A, STACKO
LD REQD, A
LD A, STACKW
LD WA
LD A, STACKV
LD V, A
LD A, STACKY
LD Y
LD A, STACKX
X
A

RROVEND:

. ORG OFFEH
JP Reset

. ORG OF9EH
JP Reset

. ORG OFFOH
JP Rtcint

. ORG OFFCH
NOP
RETI

. ORG OFF6H
JP PORTAI nt

. ORG OFF4H
NOP
RETI

. ORG OFF2H
NOP
RETI

4
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